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25.0x. 

June 1999
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the NT5D03 Call Processor card.
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December 1995
Standard, release 15.0x. This document is reissued to include information on 
the NT9D19 Call Processor Card and upgrade procedure. Changes to 
technical content are noted by revision bars in the margins.

July 1995
Standard, release 14.0x. This document is reissued to support Option 81C and 
X11 Release 21.0x. Updates are noted with revision bars in the margins. 

December 1994
Standard, release 13.0x. This document is reissued for technical content.

December 1994
Standard, release 12.0x. This document is reissued to include information on 
the Small systems Multi-Disk Unit (SMDU). Changes to technical content 
are noted by revision bars in the margins.

April 1, 1994
Standard, release 11.0x. This document is issued to include changes for 
Option 61C, and to include information from Product Bulletin 93054 (May 
1993). Revisions are noted with change bars in the margin.

October 31, 1993
Standard, release 10.0x. This document is updated to include information for 
Voice Mailbox Administration and the 12-Mbyte memory card. Changes are 
noted with revision bars in the margins.

August 1, 1993
Standard, release 9.0x. This document is updated to include information for 
X11 Release 19.0x. Changes are noted with revision bars in the margins.

April 1, 1993
Standard, release 8.0x. This document is reissued to include updates for X11 
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December 31, 1992
Standard, release 6.0x. This document was reissued to include updates for 
X11 Release 18.0x. This release includes information from Product Bulletins 
90046 (September 1991) and 91060 (November 1991).

Release 7.0x was omitted.
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About this document
This document applies to Meridian 1 Internet Enabled systems.

This document is a global document. Contact your system supplier or your 
Nortel Networks representative to verify that the hardware and software 
described is supported in your area.

Who should use this document
This document is intended for individuals responsible for software 
conversion and memory upgrades.

How this document is organized
Use this document to convert Release 19.0x or later software to Release 25.xx 

on Options 51C, 61C, 81, 81C, and 81C Call Processor Pentium II® (CP PII). 
For software conversion procedures to Release 19.xx, refer to the 
553-2001-320 Software Conversion Procedures NTP for software 
Release 24.

This document is for software conversion and memory upgrades only. The 
procedures in this document are not for any other purpose.

Specific machine types, as they are supported by software releases, are shown 
in Table 3 on page 22.

CAUTION
Loss of Data

Do not convert a system unless you are thoroughly 
familiar with it and with conversion procedures. You 
must read through the procedure before starting.
Software Conversion Procedures
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Note: Converting software on single CPU systems disrupts call 
processing and allows service only to those telephones connected to 
Power Failure Transfer Units (PFTUs). Established calls may not be 
affected.

Follow Pre-conversion and Post-conversion procedures for every system 
conversion.

Throughout this document the term Media refers to tape, disk, or CD-ROM, 
whichever applies to your system.

The term Source refers to the software that you are currently running. Target 
refers to the new software that you are converting to.

CAUTION WITH ESDS DEVICES

To avoid damaging equipment from electrostatic 
discharge, wear a properly connected anti-static 
wrist strap when working on Meridian 1 equipment.

CAUTION
Loss of Data

Read “Conversion notes” on page 11 before 
performing any operations.

It contains information crucial to the conversion 
process.
553-2001-320 Standard 23.00 January 2002
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Conversion notes
Contents

The following are the topics in this section:

Conversion media. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Software packaging. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

General conversion information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

DN Expansion. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Upgrading from disk drives to CD-ROM. .  . . . . . . . . . . . . . . . . . . . . . 15

Integrated Services Digital Network (ISDN). . . . . . . . . . . . . . . . . . . . . 16
ISDN Calling Line ID (CLID) enhancements. .. . . . . . . . . . . . . . . . 16
Converting ISDN systems. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
D-channel monitor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Incremental Software Management. . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Patches. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Software patches . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Loadware patches using DPSDL . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Release 25.0x. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Software release supported by machine type. . . . . . . . . . . . . . . . . . . . . 22

Reference list
The following are the references in this section:

• Capacity Engineering (553-3001-149)

• Features and Services (553-3001-306)

• ISDN Basic Rate Interface: Product Description (553-3901-100)
Software Conversion Procedures
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Conversion procedures vary with the system type and Source release of 
software. 

Table 1 on page 12 shows the software releases supported by Automatic 
Inline Conversion.

Table 1
Automatic Inline Conversion

From (minimum)
Source release/issue

Directly to Target release

10.xx 14, 15

11.xx 12, 13, 14, 15

12.xx 13, 14, 15

13.xx 14, 15

14.xx 15

15.xx 16, 17, 18

16.xx 17, 18

17.xx 18, 19

18.xx 19

19.xx 20, 21, 22, 23, 24, 25

20.xx 20, 21, 22, 23, 24, 25

X81 Phase 7 A, B, or C 20, 21, 23, 24, 25

X81 Phase 8, A0, A1& A2 20, 21, 23, 24, 25

X81 Phase 8, B0, B1& B2 20, 21, 23, 24, 25

21.xx 22, 23, 24, 25

22.xx 23, 24, 25

23.xx 24, 25

24.xx 25
553-2001-320 Standard 23.00 January 2002
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It may be more time- and cost-effective to simply load new software and 
reenter system data, rather than going through all the procedures that a 
conversion requires. To determine the best option and how to take advantage 
of Target software features and services, consult your Nortel Networks 
representative. 

The media received contains the conversion program (LD 66) for converting 
your current data to the format required for the next release. Check the labels 
on the media for accuracy. The conversion label contains the following 
information:

Conversion media
For software Release 24 and later systems, the following media is required for 
new software installations:

• CD-ROM— A generic CD-ROM that contains all software generics. 

• Security device — Provides a unique program for each system. The 
device does not contain feature or software release specific information. 

• Install diskette — Activates the Software Installation Tool. The Software 
Installation Kit contains three Install diskettes to support each Call 
Processor card. Use the Install diskette that corresponds with your CP 
card type.

• Keycode diskette — Consists of “keycodes” that contain software 
feature data. The keycodes must validate against the security device. 

CAUTION
Loss of Data

Always load LD 43 from the Source (current) media. 
That is, the media containing the software currently 
running your system.

X mmm Z nnn where

X = Machine type number (see Table 3 on page 22)

mmm = Source software release and minimum issue

Z = Conversion tape vintage

nnn = Target software release and minimum issue
Software Conversion Procedures
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• 2 MB customer database diskettes —A blank DOS formatted disk for 
archiving the customer database.

• Database transfer utility diskette — Supports the transfer of 4 MB 
databases to 2 MB. 

The keycode contains the software Release information. For new features or 
Incremental Software Management (ISM) limits, a new keycode is required 
(a new CD-ROM, security device, or install diskette is not required).

Software packaging
Remember to check your system packages prior to conversion. Be sure Target 
software contains all the packages required to support system operation.

General conversion information
This document supports conversions for STE, NT, RT, XT, 21E, 51, 51C, 61, 
61C, 71, 81, 81C, and 81C CP PII systems only.

Note: Conversion from X37 to the latest software release is not 
supported.

Be sure your system has enough memory to complete the conversion. If not, 
go to “Increasing NT9D19, NT5D10 CP and NT5D03 CP memory” on 
page 151 before you begin. Refer to Capacity Engineering (553-3001-149) 
for details concerning system capacity requirements.

To monitor the CPUs during parallel reload procedures, install a temporary 
Serial Data Interface (SDI) card, and connect a local TTY (or modem for 
remote TTY access). Refer to the parallel reload procedures for more 
information.

In systems equipped with superloops, calls will drop during initialization 
when Peripheral Software Download (PSDL) occurs. The Superloop 
Network (NT8D04) and Controller (NT8D01) cards download peripheral 
software prior to initialization completion. This may extend the duration of 
the system initialization when completing a conversion.

When a software upgrade is performed to add new feature packages, a sysload 
or parallel reload is required to enable the new software.
553-2001-320 Standard 23.00 January 2002



 Conversion notes Page 15 of 304
If a Force Download occurs during a parallel reload, initialization can take up 
to 15 minutes. Calls in process will be interrupted.

When QPC742D FDI Cards are used, install disks in both disk drives before 
powering up the system. This is not required with later vintages of the FDI 
card.

If you have Auxiliary Processors working with your system, be sure they are 
powered up after you complete your conversion.

DN Expansion 
Software conversion is designed to convert data blocks with the smaller DN 
fields on the Source disk to data blocks with expanded DN fields, irrespective 
of the DN Expansion package on the Target disk/system.

CDR Expansion is not required to enable DN expansion. However, in order 
for Call Detail Records to accurately reflect system activity, CDR Expansion 
must be enabled as well as DN Expansion. If DN Expansion is equipped and 
CDR Expansion is not, system operation is not affected, but CDR records will 
be inaccurate.

Upgrading from disk drives to CD-ROM
Upgrading a drive unit to CD-ROM requires the existing 4 MB database to be 
converted to 2 MB. The database is converted to 2 MB is using one of the 
following methods:

• using the Database Transfer utility (for systems equipped with 
IOP/CMDU or separate IOP and CMDU cards only)

CAUTION

Loss of Data

Do not attempt backward data dumping between 
software versions, upissues, or releases. It will 
corrupt your data.
Software Conversion Procedures
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• sending the database to Nortel Networks for conversion

• using the “Copy Database from Redundant Disk” command in the 
Meridian 1 Software Installation Tool (for redundant systems equipped 
with IOP/CMDU or separate IOP and CMDU cards)

Integrated Services Digital Network (ISDN)
Any ISDN site upgrading to software Release 15 or higher must be 
configured with the QPC757 vintage C, D-channel Handler (DCHI) card.

When performing a parallel reload, ISDN Primary Rate Interface (PRI) calls 
are dropped during initialization of Target software.

Software Release 18 and later support the NT6D80 Multi-purpose Serial Data 
Link (MSDL) card for D-channel interfaces.

Software Release 18 and later do not support even numbered port 
assignments on the NT6D11 International ISDN D-channel card. The even 
port assignments must be updated to odd port assignments in LD 17 prior to 
converting. If not done, the D-channel will not be reestablished after service 
change. Only QPC757 D-channel mode is supported.

Options 51C, 61C, and 81 require clock controller QPC471 vintage H or later, 
or QPC775 vintage C or later. 

Option 81C requires clock controller QPC471 vintage H or later, or QPC775 
vintage E or later. 

ISDN Calling Line ID (CLID) enhancements
The Calling Line ID Enhancements feature delivers enhanced functionality 
pertaining to the construction and generation of Calling Line ID, and allows 
more program flexibility for Meridian 1 sets pertaining to CLID.

Prior to software Release 22.0x, CLID supported a single Listed Directory 
Number (LDN), a single Home NXX, and single Home Location Code. The 
Calling Line ID was built from key 0 of a set, or the LDN.
553-2001-320 Standard 23.00 January 2002
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The CLID enhancement parameters have been enhanced to include multiple 
NXXs, multiple Home Locations Codes (HLOCs), multiple Numbering Plan 
Areas (NPAs), multiple Local Steering Codes (LSCs), and multiple Listed 
Directory Numbers (LDNs). The calling Line ID enhancement now allows 
more flexible CLID generation than prior releases.

With the CLID Enhancement feature, the system now supports:

• A new table driven feature with up to 4000 entries.

• Any entry number can be programmed against any DN on a per DN 
basis.

• Existing LDN can be used on a per DN key, per set basis.

• The existing Individual Directory Number (IDN) key of an ACD set can 
be sent as the CLID.

• The active DN key determines the CLID that is sent for conference and 
transfer.

• Supports the flexibility of 2-3 or 5-7 digits DNs.

During conversion, two CLID entries (0 and 1) are created in the customer 
data block. The entries are configured with ISDN CLID information from the 
existing customer data block, such as HNPA, HNXX, HLOC, etc. Entry 0 is 
used for the keys/sets that have a DID number. Entry 1 is used for the 
keys/sets that do not have a DID number. 

Refer to Features and Services (553-3001-306) for more information on the 
CLID Enhancement feature.

Converting ISDN systems
New software may contain changes to the ISDN D-channel parameters that 
are downloaded to the DCHI or MSDL card. The system software 
automatically downloads the new parameters upon SYSLOAD if a parallel 
reload is not performed.

Ensure that the Release ID in the D-channel parameters (LD 17) at the far end 
is changed to the lowest release in you site configuration.
Software Conversion Procedures
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When a DCHI port is configured as a TTY port, INI messages may be 
truncated when printed after sysload. System performance is not affected, but 
you should view your history file for the entire message.

D-channel monitor
When the D-channel monitor is software-enabled and deactivated with a 
maintenance telephone, a data dump and sysload reactivate the monitor. To 
avoid this situation, software-disable the D-channel monitor prior to 
datadump and sysload.

Incremental Software Management
Incremental Software Management (ISM) defines the maximum number of 
Terminal Numbers, Automatic Call Distribution (ACD) Directory Numbers, 
ACD positions (agents and supervisors), and AST sets allowed in a system. 
Before upgrading to software Release 15.55 or higher, read the ISM section 
in Features and Services (553-3001-306).

Software Release 19.0x and later include Meridian Packet Handlers (MPH) 
as part of ISM tracking.

Note: DSL, LTID, and MPH are part of ISDN Basic Rate Interface 
(BRI). Refer to ISDN Basic Rate Interface: Product Description 
(553-3901-100) for more details.

Patches
Software patches

For Options 51C, 61C, 81, 81C, and 81C CP PII systems. Software patches 
are deleted when converting to a new software release, or when performing a 
software upissue. Software patches are not deleted when the same software 
release is reinstalled in the system.

CAUTION
Loss of Data

With Incremental Software Management (ISM) in 
software Release 15.55 and higher, if SYS message 
4327, 4328, 4329, or 4330 appears at sysload. 
Reload Source system disks. Order ISM disks with 
sufficient system parameters configured.
553-2001-320 Standard 23.00 January 2002
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If a software patch is included in your software, a plus sign (+) will appear 
next to the software issue number in LD 22.

Loadware patches using DPSDL
For Options 51C, 61C, 81, 81C, and 81C CP PII systems. Loadware patches 
are deleted when converting to a new software release, or when performing a 
software upissue. Loadware patches are also deleted when the same software 
release is reinstalled in the system.

If there are one or more loadware patches fully installed in your software, a 
plus sign (+) will print next to the PSWV version and the modified loadware 
issue number in LD 22.

Loadware patches are only fully installed once the psdl.rec successfully 
rebuilds and the system initializes (INI) and reboots.

Release 25.0x
Release 25 supports Automatic Inline Conversion from Release 19, 20, 21, 
22, 23, 24, X81 Phase 7 and X81 Phase 8 in system Options 51C, 61C, 81, 
81C, and 81C CP PII. Software installation and conversion is supported on 
CD-ROM using an IODU/C or MMDU drive. 

Release 25 introduces Fiber Network Fabric. Fiber Network allows the 
expansion of Meridian 1 Option 81C and 81C CP PII systems from five to 
eight Network groups. The Intergroup cards and module in current 
Meridian 1 systems are replaced by a Dual Ring fiber optic network. This 
Fiber Network provides complete non-blocking communication between the 
network groups, which eliminates the incidence of busy signals for calls 
switched between groups. 

With release 25, Option 51C, 61C, 81, and 81C systems can use any of the 
following processors available:

• 68060E NT5D03 CP card

• 68060 NT5D10 CP card

• 68040 NT9D19 CP card 
Software Conversion Procedures
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With release 25, Option 81C CP PII systems can use any of the following 
processors:

• A0810496 CP PII card

• NT4N64 CP PII card 
553-2001-320 Standard 23.00 January 2002
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Important - Release 25 introduces new Flash and DRAM memory 
requirements. Call Processor cards that meet the “total” memory requirement, 
may not meet the individual Flash and DRAM memory requirement. Refer to 
Table 2 on page 21 for the Release 25 flash and DRAM memory 
requirements. 

Table 2
Release 25 memory requirements 

Minimum memory requirement

System type
Flash 
memory 
requirement

DRAM 
memory 
requirement

Total memory 
requirement

Option 51C/61C 32 Mbyte 48 Mbyte 80 Mbyte

Option 81/81C

• Option 81/81c systems operating 
on Call Processor 68060 or 
68060E with five or fewer 
network groups (including Fiber 
Network Fabric systems)

• any Option 81/81C systems 
operating on Call Processor 
68040

32 Mbyte 64 Mbyte 96 Mbyte

Option 81/81C

• Option 81/81c systems operating 
on Call Processor 68060 or 
68060E with six or more network 
groups

32 Mbyte 80 Mbyte 112 Mbyte

Option 81C CP PII

• Option 81C CP PII systems with 
six or more network groups 
recommended using the NT4N64 
processor.

256 Mbyte

Note:  CP PII systems are shipped in a 128 Mbyte ( A0810496) or 256 Mbyte (NT4N64) configuration. This 
memory cannot be upgraded in the field.
Software Conversion Procedures
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Software release supported by machine type
Table 3 on page 22 shows the software release associated with each system 
and its available release levels. The last two digits in the “software system 
number” column indicate the software generic; the first one or two digits 
indicate the system type. For example, the system number for system Option 
81C is 1911.

Table 3
Software generic by machine type (Part 1 of 3)

System type
Software system 

number

Lowest 
supported 

release

Highest 
supported 

release

STE 1511 18 21

NT 1111 8 21

XT 1211 8 21

RT 1311 12 21

Option 21E 1511 18 21

Option 51 1111 15 21

Option 51C equipped with 
NT6D66 CP card 

1711 20 23

Option 51C equipped with 
NT9D19 CP Card

2211 22 25

Option 51C equipped with 
NT5D10 CP card

2411 23 25

Option 51C equipped with 
NT5D03 CP card

2811 23.5X 25

Option 61 1111 15 21

Option 61C equipped with 
NT6D66 CP card 

1811 19 24

Option 61C equipped with 
NT9D19 CP card

2311 22 25
553-2001-320 Standard 23.00 January 2002



 Conversion notes Page 23 of 304
Option 61C equipped with 
NT5D10 CP card

2511 23 25

Option 61C equipped with 
NT5D03 CP card

2911 23.5X 25

Option 81 equipped with 
NT6D66 CP card*

1611 18 24

Option 81 equipped with 
NT9D19 CP card*

1911 21 25

Table 3
Software generic by machine type (Part 2 of 3)

System type Software system 
number

Lowest 
supported 

release

Highest 
supported 

release
Software Conversion Procedures
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Option 71 1211 15 21

Option 81 equipped with 
NT5D10 CP card*

2611 23 25

Option 81 equipped with 
NT5D03 CP card*

3011 23.5X 25

Option 81C equipped NT6D66 
CP card**

1611 21 24

Option 81C equipped with 
NT9D19 CP card**

1911 21 25

Option 81C equipped with 
NT5D10 CP card**

2611 23 25

Option 81C equipped with 
NT5D03 CP card**

3011 23.5X 25

Option 81C CP PII equipped 
with A0810496 CP PII card***

3311 25.xx 25.40

Option 81C CP PII equipped 
with NT4N64 CP PII card***

3311 25.xx 25.40

Note 1: *Option 81 systems require software option 298.

Note 2: **Option 81C systems require software option 299.

Note 3: *** Option 81C CP PII systems require software option 368.

Table 3
Software generic by machine type (Part 3 of 3)

System type Software system 
number

Lowest 
supported 

release

Highest 
supported 

release
553-2001-320 Standard 23.00 January 2002
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Preconversion procedure

Contents
The following are the topics in this section:

Preconversion steps. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Reference list
The following are the references in this section:

• Maintenance (553-3001-511)

Read the Conversion notes section in this document before beginning your 
conversion procedures. The conversion procedure used depends on the 
release of the Source and Target software. Make sure you have all the 
necessary hardware and software. Save a copy of your data dumped Source 
software until you are sure that all site data converted successfully.

Use this procedure to begin all software conversions. When you complete this 
procedure, refer to “IODU/C software conversion” on page 31, or 
appropriate. After you have completed your conversion, perform the 
post-conversion steps in “Postconversion procedure” on page 251.

The following items should be available before proceeding:

• the Controlled Release Bulletin for the new software

• the appropriate software and conversion media

• the CD-ROM, and diskettes (as required)

• a temporary SDI card and a local TTY or remote TTY modem required 
to perform parallel reload in dual CPU systems

• new memory, if required
Software Conversion Procedures



Page 26 of 304  Preconversion procedure
Preconversion steps
1 Perform an overall system check. Make sure the system is performing 

normal call processing.

2 Get software information from LD 22.

Patches do not need to be removed prior to conversion. When data 
dumping (EDD), an EHM500 message is printed, rather than a list of 
patch numbers.

If a patch is included in your software and you are running on Release 
19 or higher, a plus sign (+) will appear next to the software issue 
number in LD 22.

3 Load the configuration record (LD 17) to find the storage currently 
available in the Protected and Unprotected Data Store (PDATA and 
UDATA). Check the General Release Bulletin to see if additional 
memory is required for the new software or for any option packages 
being added.

4 Print system data listed in Table 4 on page 29. Verify all information is 
correct. Make corrections if necessary.

5 If additional memory is required for the conversion, change the MSPT, 
MEM, or MTYP prompts in the configuration record (LD 17). See 
“Increasing NT9D19, NT5D10 CP and NT5D03 CP memory” on 
page 151.

6 Perform a template audit. The template audit reviews the templates in 
your system and cleans up any duplicate or corrupted templates. The 
following is an example of the information generated by the system 
during the audit. This may take an extended period of time on large 
systems. It is recommended that it be run during a low traffic period.

LD 22
REQ ISS

**** to exit overlay

CAUTION
Loss of Data

Do not abort this overlay until the audit is complete. 
If the overlay is interrupted, data will be corrupted.
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7

8 To ensure backup, perform a data dump to the Source system media 
currently in the drive. If the data dump is not successful, do not 
proceed with the conversion. The data dump problem must be 
corrected. Contact your Nortel Networks technical support.

9 If parallel reload is to be used during the conversion, go to or “IODU/C 
software conversion” on page 31. Be sure to perform the correct 
parallel reload procedure for your system.

Note: To monitor the CPUs during parallel reload procedures, install 
a temporary Serial Data Interface (SDI) card, and connect a local TTY 
(or modem for remote TTY access). Refer to the parallel reload 
procedures for more information.

LD 01 The audit begins as soon as LD 01 is entered.

TEMPLATE AUDIT
STARTING PBX TEMPLATE SCAN
TEMPLATE 0001 USER COUNT LOW CHECKSUM OK
TEMPLATE 0002 USER COUNT HIGH CHECKSUM OK
TEMPLATE 0003 NO USERS FOUND

STARTING SL1 TEMPLATE SCAN
TEMPLATE 0001 USER COUNT OK CHECKSUM OK
•
•
TEMPLATE 0120 USER COUNT OK CHECKSUM OK
TEMPLATE AUDIT COMPLETE

LD 43
EDD DATADUMP COMPLETE (or DATABASE BACKUP 

COMPLETE) is printed when the data dump has been 
successfully completed. Investigate any EDD messages. 
Refer to Maintenance (553-3001-511).
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If parallel reload is not required (single CPU system) then perform one or more 
of the following conversion procedures. Remember to perform the 
post-conversion steps (“Postconversion procedure” on page 251) to complete 
the conversion.

• “cPCI® MMDU software conversion” on page 107

• “Increasing NT9D19, NT5D10 CP and NT5D03 CP memory” 
on page 151
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Items marked with asterisks (*) are required printout for conversion. Other 
items are recommended for a total system status.

Table 4 
Print site data (Part 1 of 2)

Site data Print command

Terminal blocks for all TNs LD 20

REQ
TYPE
CUST

PRT
TNB
<cr>

Directory Numbers LD 20 (LD 22 prior to Release 16)

REQ
TYPE
CUST

PRT
DNB
<cr>

Attendant Console data block for all customers LD 20 LD 20

REQ
TYPE
CUST

PRT
ATT, 2250
<cr>

*Customer data block for all customers LD 21 LD 21

REQ
TYPE
CUST

PRT
CDB
<cr>

Route data block for all customers LD 21

REQ
TYPE
CUST
ROUT
ACOD

PRT
RDB
Customer number
<cr>
<cr>

*Configuration Record LD 22

REQ
TYPE

PRT
CFN
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*Software packages LD 22

REQ
TYPE

PRT
PKG

*Software issue, ROM and tape ID LD 22

REQ
REQ
REQ

ISS
ROM
TID

* Peripheral software versions LD 22

REQ
TYPE 

PRT
PSWV

ACD data block for all customers LD 23

REQ
TYPE
CUST
ACDN

PRT
ACD
Customer Number
ACD DN (or <CR>)

Superloop card IDs and software version
(peripheral controller, superloop network and 
controller cards)

LD 32

. IDC loop

Multi-purpose ISDN Signaling Processor 
(MISP) card

LD 27

REQ
TYPE
LOOP
APPL
PH

PRT
MISP
loop number (0-158)
<cr>
<cr>

DTI/PRI data block for all customers LD 73

REQ
TYPE

PRT
DDB

Note: Items marked with asterisks (*) are required printout for conversion. Other items are recommended 
for a total system status.

Table 4 
Print site data (Part 2 of 2)

Site data Print command
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IODU/C software conversion

Contents
The following are the topics in this section:

Parallel reload the 61C/81/81C . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Verify memory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Perform a data dump . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
STAT the hardware . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Split the Cores . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Install software on Core/Net 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Check for peripheral software download . . . . . . . . . . . . . . . . . . . . . 40
Switch call processing to Core/Net 1 . . . . . . . . . . . . . . . . . . . . . . . . 40
Test Core/Net 1 . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Install software on Core/Net 0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Exiting split mode . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
Test Core/Net 1 and Core/Net 0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Synchronize the hard disks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Backing out of the parallel reload on Options 61C, 81, 81C . . . . . . 46

Option 51C software conversion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Verify memory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Perform a data dump . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
STAT the hardware . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Install software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Check for Peripheral Software Download . . . . . . . . . . . . . . . . . . . . 52
Test call processing . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
Complete the upgrade . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Adding features and ISM limits . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Feature operation . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
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Feature and ISM parameter upgrade using a keycode diskette . . . . 54
Feature and ISM parameter upgrade using HyperTerminal® . . . . . 62
Feature and ISM parameter upgrade enter manually . . . . . . . . . . . . 69
Reverting to the previous keycode with the KRVR command . .  . . 75

Use the procedures in this section if your system is equipped with NT5D61 
Input Output Disk Unit with CD-ROM (IODU/C) card(s). If your system is 
not equipped with the IODU/C card, do not use these procedures. 

The procedures in this section describe how to:

• convert one software release to a later release

• perform a software upissue within in the same software release

• add new features

• modify Incremental Software Management (ISM) limits

To better understand the process, read through the entire procedure before 
you begin.

Parallel reload the 61C/81/81C
Note: This procedure does not include instructions for installing new 
IODU/C cards. To use this procedure, your system must already be 
equipped with IODU/C cards. 

Use the parallel reload procedures to convert from one software release to a 
later release or to upissue software within the same software release. These 
parallel reload procedures are for software conversions only. Do not use this 
procedure for any other purpose. Parallel reloads can be done from either 
CPU. For the purposes of this document, we begin with CPU 0. 

CAUTION WITH ESDS DEVICES

To avoid damaging equipment from electrostatic 
discharge, wear a properly connected anti-static 
wrist strap when working on or near Meridian 1 
equipment.
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Table 5 on page 33 summarizes the required steps to perform this procedure.

Verify memory
Determine whether your system requires additional memory. Refer to 
“Increasing NT9D19, NT5D10 CP and NT5D03 CP memory” on page 151 
for memory requirements and upgrade procedures.

Table 5
Options 61C, 81, 81C parallel reload summary

Step Page

1. Verify memory page 33

2. Perform a data dump page 34

3. STAT the hardware page 34

4. Split the Cores page 35

5. Install software on Core/Net 1 page 35

6. Check for peripheral software download page 40

7. Switch call processing from Core/Net 0 to 
Core/Net 1

page 40

8. Test Core/Net 1 page 41

9. Install software on Core/Net 0 page 41

10. Exit split mode page 43

11. Test Core/Net 0 and 1 page 44

12. Synchronize the hard disks page 45

13. Perform a data dump page 46
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Perform a data dump

1 Load the Equipment Data Dump Program (LD 43). At the prompt, enter

2 When “EDD000” appears on the terminal, enter

3 When “DATABASE BACKUP COMPLETE” or “DATADUMP 
COMPLETE” appears on the terminal, enter

STAT the hardware

1 Load LD 137 and get status of the hard disks. 

Note: Be sure the hard disks are synchronized. If not, synchronize 
before proceeding.

2 Load LD 135 and get status of the CPs, CNIs and memories.

LD 43 to load the program

EDD to begin the data dump

CAUTION

Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support organization. A data 
dump problem must be corrected before proceeding.

**** to exit the program

LD 137
STAT Get the status of the hard disks

SYNC Synchronize hard disks if necessary. 
Synchronization may take up to 50 minutes

TEST CMDU Performs hard and floppy disk test.

**** exit program

LD 135
STAT CPU Get the status of both CPs and memory

STAT CNI Get the status of all configured CNIs
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3 Test the standby (inactive) CP. Then switch CPs, and test again.

Note: Testing the CPs can take up to 20 minutes for each test. When 
the test is complete, the memories are automatically synchronized.

Split the Cores

1 Be sure CP 0 is active and CP1 is standby. You may need to switch 
CPs again:

a. Verify that IODU/C 0 is active. You may need to switch IODU/Cs.

2 Connect a terminal to the CPSI port in Core/Net 1 to J25 of the I/O 
panel at the back of the Core/Net. Be sure it is configured as follows. 
The recommended baud rate is 9600, to be the same as the CPSI port.

7 data bits, 1 stop bit, Space parity, Full duplex, XON protocol

3 Place CP 0 in Maintenance by setting the MAINT/NORM switch to 
MAINT.

4 In Core/Net 1, disable the CNI cards by setting the ENB/DIS faceplate 
switches to DIS.

Install software on Core/Net 1

1 Place the CP Install disk that corresponds with the installed CP card 
type into the IODU/C in Core/Net 1.

2 Install the CD-ROM into the CD drive:

TEST CPU Test standby (inactive) CP

Wait until the terminal returns a complete test message. The message 
“HWI533 or HWI534” does not mean the test has completed!

SCPU Switch CPs

TEST CPU Test the standby (inactive) CP

STAT CPU
**** exit program

LD 137
STAT Get the status of IODU/C

SWAP Switch IODU/Cs if necessary

**** exit program
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a. press the button on the CD-ROM drive to open the CD-ROM disk
holder

b. place the CD-ROM disk into the holder with the disk label showing

c. use the four tabs to secure the CD-ROM drive

d. press the button again to close the CD-ROM disk holder (don’t
push the holder in by hand)

3 In Core/Net 1, perform the following three steps in uninterrupted 
sequence:

a. press and hold the MAN RST button on the CP card

b. set the MAINT/NORM switch on the CP card to MAINT

c. release the MAN RST button

A sysload will begin (cold start). Wait for the Main Menu to appear on the 
terminal before proceeding.

Note 1: If the CD-ROM is not in the CD drive of the IODU/C, the 
installation procedure will not continue. Please insert the CD-ROM into 
the drive to continue.

Note 2: If a problem is detected during the system verification, Install 
stops, prints an error message, and aborts the installation. If the 
verification is not successful, do not continue; contact your technical 
support organization.

4 Press <CR> to continue.

5 Log into the system and enter the time and date, when prompted.

6 Initiate the database installation by selecting the following command 
from the menu:

7 Remove the CP Install Program diskette and insert the Keycode 
diskette, when prompted.

<u> to Install menu

<a> to continue with keycode validation

<y> to confirm that the keycode matches the CD-ROM release
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8 When the Install Menu is displayed, select the following options

Pre-release 3 language groups

9 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 
sets. 

The languages contained in each selection are outlined as follows: 

• 1 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Brazilian Portuguese, Finnish, Japanese 
Katakana. 

• * 2 - English, French, German, Spanish, Swedish, Norwegian, 
Danish, Finnish, Italian, Brazilian Portuguese. 

• * 3 - English, French, German, Dutch, Polish, Czech, 
Hungarian, Russian, Latvian, Turkish. 

• * 4 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

• * 5 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Portuguese, Finnish, Japanese Katakana. 

• * 6 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

<b> to install software, database, CP-BOOT ROM, and 
IOP-ROM

<a> to verify that the CD-ROM is now in drive

The Installation Status Summary screen appears that lists the 
options to be installed.

<y> Yes, start Installation

<a> Continue with Upgrade

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)
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Release 3 language groups

10 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 
sets.

The languages contained in each selection are outlined as follows:

• 1 – Global 10 Languages (Release 3) English, French, 
German, Spanish, Swedish, Italian, Norwegian, Brazilian 
Portuguese, Finnish, Japanese Katakana.

• 2 – Western Europe 10 Languages (Release 3) English, 
French, German, Spanish, Swedish, Italian, Norwegian, 
Brazilian Portuguese, Finnish, Danish.

• 3 – Eastern Europe 10 Languages (Release 3) English, 
French, German, Dutch, Polish, Czech, Hungarian, Russian, 
Latvian, Turkish.

• 4 – North Americia six Languages (Release 3) English, French, 
German, Spanish, Brazilian Portuguese, Japanese Katakana.

• 5 – Spare Group A.

• 6 – Spare Group B.

11 Continue with ROM and IOP-ROM upgrade when prompted.

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)
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12 Select a database to install.

If the system fails to load, or system messages indicate data corruption, 
back out of the parallel reload process by performing the steps in 
“Backing out of the parallel reload on Options 61C, 81, 81C” on page 46.

When the installation is complete, the Installation Status 
Summary table appears. Press <CR> to continue.

When the Install Menu appears, select:

<d> To install Database only

When the database installation screen appears, insert the first 
2 MB database diskettes in the IODU/C.

<a> to install the customer database

<y> to start installation

Follow the instructions to install the database and update the 
ROM. 

The Installation Status Summary screen appears. Verify that CD 
to disk, disk to ROM, Database, CP-BOOTROM, and IOP-ROM 
were installed. 

<cr> press return to continue

<q> to quit (remove any diskettes from the floppy drive)

<y> Yes, to confirm quit

<a> to reboot the system

The system will automatically perform a sysload during which 
several messages will appear on the system terminal. Wait for 
“DONE” and then “INI” messages to be displayed before 
continuing.
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Check for peripheral software download

1 Load LD 22 and print Target peripheral software version. The Source 
peripheral software version was printed during the pre-conversion 
procedure. If there is a difference between the Source and Target 
peripheral software version, a forced download will occur during 
initialization when coming out of parallel reload. System initialization 
will take longer and established calls on IPE will be dropped.

Switch call processing to Core/Net 1

Perform the next four steps in succession. Call processing will be switched 
from Core/Net 0 to Core/Net 1.

1 In Core/Net 0, set the DIS/ENB faceplate switch on the IODU/C card 
to DIS.

2 In Core/Net 0, disable the CNI cards by setting the ENB/DIS faceplate 
switches to DIS.

3 In Core/Net 1, enable the CNI cards by setting the ENB/DIS faceplate 
to ENB.

4 In Core/Net 1, press the MAN INT button.

Note: Call processing is now switched from Core/Net 0 to Core/Net 1.

LD 22
REQ PRT

TYPE PSWV

**** exit program

CAUTION

Service Interruption

Call Processing will be interrupted! Perform these 
next steps carefully. This is the point at which your 
service is interrupted. Calls in process will be 
interrupted, especially if Peripheral Software 
Download takes place. Some calls may be dropped.
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Test Core/Net 1

1 Test Call Processing. This includes, but is not limited to the following:

• Check for dial tone.

• Make internal, external, and network calls.

• Check attendant console activity.

• Check DID trunks.

• Check any auxiliary processors.

Note: From this point forward you will be upgrading Core/Net 0 with 
new software.

Install software on Core/Net 0

1 Move the CPSI port cable from J25 on Core/Net 1 to J25 on 
Core/Net 0.

2 Set the IODU/C faceplate switch to ENB.

3 Insert the CP Install diskette into Core/Net 0.

4 Press the MAN RST button on the CP card in Core/Net 0 to reboot the 
system and start the Software Installation Tool. (The terminal displays 
SYSLOAD messages during file loading. When SYSLOAD is 
completed, the NT logo appears.)

5 When the NT logo appears, press <CR> to continue.

6 When the Main Menu appears, select the following options in 
sequence:

7 Remove the CP Install Program diskette and insert the Keycode 
diskette. Select the following when prompted:

<u> to Install menu

<a> to continue with keycode validation 

<y> to confirm that the keycode matches the CD-ROM 
release
Software Conversion Procedures



Page 42 of 304  IODU/C software conversion
8 When the Install Menu appears, select the following options in 
sequence to copy the software form Core/Net 1 to Core/Net 0, install 
CP-software, ROMs, and transfer the database to the redundant disk:

<o> to copy system software from the other core

<a> to copy /p partition from Core1 to Core 0

<a> to continue with upgrade

When the software has copied successfully, you must install 
CP-software from the hard disk to Flash EEPROM, and install 
CP-BOOT ROM.

<CR> press <CR> when you are ready to continue

<y> to start installation

<a> to continue with ROM upgrade

<y> to start installation

<a> to continue with ROM upgrade.

When the installation is complete, the Installation Status 
Summary screen appears.

<CR> to return to the Install Menu

When the Install Menu appears, install IOP-ROM:

<f> to install IOP-ROM only

When the Installation Status Summary screen appears:

<y> to start installation

<y> to continue installing IOP-ROM

<a> to continue with ROM upgrade

When the installation is complete, the Installation Status 
Summary screen appears.

<CR> to return to the Install Menu

When the Install Menu appears, install the database:

<d> to install database only

<d> to copy database from the redundant disk

When the Installation Status Summary screen appears:

<y> to start installation

<a> to continue transferring the database from the 
redundant disk

When the Installation Status Summary screen appears, press:

<CR> to return to the Install Menu
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Exiting split mode

1 Connect CPSI port or maintenance SDI port

2 Enable the CNI cards by setting the ENB/DIS faceplate switch to ENB 
in Core/Net 0.

3 Perform the following in uninterrupted sequence:

• Press and release the MAN RST button in Core/Net 0.

• When SYS700 messages appears on LCD display on 
Core/Net 0, set the MAINT/NORM switch to NORM in Core/Net 
0.

In 60 seconds, the LCD will display and confirm your processes with:

An HWI534 message indicates the start of memory synchronization. In 10 
minutes, an HWI533 message on Core/Net 1 CSPI or SDI terminal indicates 
the memory synchronization is complete.

4 In Core/Net 1, set the MAINT/NORM switch on the CP card to NORM.

When the Install Menu appears, remove any diskettes in the 
floppy before rebooting the system:

<q> to quit

<y> to confirm quit

<a> to reboot the system

Wait for “DONE” and then “INI” messages to be displayed 
before continuing.

RUNNING ROM OS
ENTERING CP VOTE
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Test Core/Net 1 and Core/Net 0

1 Perform a redundancy sanity test using the following sequence:

2 Switch Cores and test the other side (Core/Net 0)

Note: Testing the CP and CNI cards and synchronizing memory can 
take up to 20 minutes for each test. When the CP test is complete, the 
CP the memory is automatically synchronized.

3 Clear the display and minor alarms on both Cores.

4 Get the status of the Cores, CNIs, and memory.

Note: You may need to execute the STAT CNI command twice before 
receiving a response from the system.

LD 135
STAT CNI Get status of CNI cards

STAT CPU Get status of CPU and memory

TEST CPU Test the inactive Core/Net

TEST CNI c s Test each inactive CNI card

SCPU Switch cores

TEST CPU Test the inactive Core/Net

TEST CNI c s Test each inactive CNI card

CDSP Clear the displays on the Cores

CMAJ Clear major alarms

CMIN ALL Clear minor alarms

STAT CPU Get the status of both Cores

STAT CNI Get the status of all configured 
CNIs and memory

**** exit program
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Synchronize the hard disks

1 Load LD 137 and synchronize the hard disks. Synchronization may 
take up to 50 minutes. To be sure that the contents of IODU/C 1 are 
copied to IODU/C 0, verify that IODU/C 0 is disabled.

2 Get the status of the CMDU's and be sure CMDU 0 is active. Switch if 
necessary.

LD 137
STAT Get the status of the IODU/C and redundancy

SYNC Enter "Yes" to synchronize disks. Wait until the 
memory synchronization successfully completes 
before continuing.

TEST CMDU Performs hard and floppy disk test.

STAT Get the status of IODU/C and redundancy

SWAP Switch CMDU if necessary

STAT CMDU Get the status of the IODU/Cs. Be sure the same 
IODU/C and CPU are active.

**** exit program
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Perform a data dump

Load the Equipment Data Dump Program (LD 43). At the prompt, enter

1 When “EDD000” appears on the terminal, enter

2 When “DATABASE BACKUP COMPLETE” or “DATADUMP 
COMPLETE” appears on the terminal, enter

Backing out of the parallel reload on Options 61C, 81, 81C

1 Place the original Install disk 1 into the IODU/C in Core/Net 1.

2 In Core/Net 1, press the MAN RST button.

3 Select <u> to initiate the Install Tool.

4 Remove the CP Install diskette and insert the source keycode diskette.

5 Select <a> to continue with keycode validation.

6 When the install screen appears, select the following options in 
sequence, and insert the source database diskette when you are 
prompted to do so.

LD 43 to load the program

EDD to begin the data dump

CAUTION

Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support organization. A data 
dump problem must be corrected before proceeding.

**** to exit the program

<b> to install software, database, CP-BOOT ROM, and 
IOP-ROM

<a> to start installation

<a> continue with upgrade
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7 When the database installation screen appears, select the following:

8 When the ROM installation screen appears, select the following:

9 Following the database installation, upgrade the ROMs:

10 Remove the disk from the IODU/C in Core/Net 1.

11 From the main menu, select the following options to quit and reload the 
system:

12 Remove any diskettes from the floppy drive, and type

13 In Core/Net 1, perform the following steps:

• enable the CNI cards by setting the ENB/DIS faceplate 
switches to ENB

• press and release the MAN RST button on the CP card

— When SYS700 messages appear on the CP 1 LCD display

• set CP 1 MAINT/NORM switch to NORM. 

Within 60 seconds, the LCD will display the following messages, confirming 
the process.

<c> to transfer the previous system database (DBMT) 
(choose this option if the database was converted on-site)

or
<a> to install customer database (choose this option if the 

database was sent to Nortel Networks for conversion)

<a> to continue with the database install

<y> to delete the hardware infrastructure database files from 
the hard disk

<a> to continue with the ROM upgrade

<a> to continue with ROM upgrade (CP-BOOT)

<y> to start installation

<a> to continue with ROM upgrade (IOP-ROM)

<q> to quit

<y> to confirm quit

<a> to reboot the system
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RUNNING ROM OS
ENTERING CP VOTE 

An “HWI534” message from the CPSI or SDI port indicates the start of memory 
synchronization. Within 10 minutes, an “HWI533” message on Core/Net 0 
CPSI or SDI TTY indicates the memory synchronization is complete. Wait until 
the memory synchronization is complete before continuing.

14 In Core/Net 0, set the MAINT/NORM switch on the CP card to NORM.

15 Perform a redundancy sanity test.

Note: Testing the CPs can take up to 20 minutes for each test. When 
the test is complete, the memories are automatically synchronized.

16 Load LD 137 and synchronize hard disks. Synchronization may take 
up to 50 minutes. To be sure the contents of CMDU 0 are copied to 
CMDU 1, use the STAT command to verify that CMDU 1 is disabled.

You are now out of the parallel reload process, and have returned to the 
Source software.

Option 51C software conversion
Use this procedure to convert from one software release to another on Option 
51C systems only.

Verify memory

Determine whether your system requires additional memory. Refer to 
“Increasing NT9D19, NT5D10 CP and NT5D03 CP memory” on page 151 for 
memory requirements and upgrade procedures.

LD 135
TEST CPU Test the standby (inactive) Core/Net.
SCPU Switch the Cores.
CDSP Clear display.
TEST CPU Test the standby (inactive) Core/Net.
SCPU Switch the Cores.

LD 137
STAT CMDU Get the status of both CMDUs.
SYNC Synchronize disks.
TEST CMDU Performs hard and floppy disk test.
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Perform a data dump

1 Load the Equipment Data Dump Program (LD 43). At the prompt, enter

2 When “EDD000” appears on the terminal, enter

3 When “DATABASE BACKUP COMPLETE” or “DATADUMP 
COMPLETE” appears on the terminal, enter

STAT the hardware

1 Load LD 137 and get status of the hard disk.

2 Load LD 135 and get status of the CP, CNI and memory.

Install software

1 Select the CP Install diskette which matches the Call Processor (CP) 
type on your system.

2 Insert the CP Install diskette into the floppy drive of the IODU/C.

3 Press MAN RST on the CP card.

LD 43 to load the program

EDD to begin the data dump

CAUTION

Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support organization. A data 
dump problem must be corrected before proceeding.

**** to exit the program

LD 137
STAT Get the status of the hard disks

LD 135
STAT CPU Get the status of the CP and 

memory

STAT CNI Get the status of the CNI
Software Conversion Procedures



Page 50 of 304  IODU/C software conversion
The system will be booted from the floppy and the Install tool will be 
automatically invoked. The following screen appears

4 Press <CR> to continue.

5 Log into the system and enter the time and date, when prompted.

6 Initiate the database installation by selecting the following command 
from the menu:

7 Remove the CP Install Program diskette and insert the Keycode 
diskette, when prompted.

8 When the Install Menu is displayed, select the following options in 

sequence when you are prompted to do so

<u> to Install menu

<a> to continue with keycode validation

<y> to confirm that the keycode matches the CD-ROM release

<b> to install software, database, CP-BOOT ROM, and 
IOP-ROM

<a> to verify that the CD-ROM is now in drive

The Installation Status Summary screen appears that lists the 
options to be installed.

<y> Yes, start Installation

<a> Continue with Upgrade

When the ROM installation screen appears, select the following 
prompts in sequence:

<a> Continue with ROM Upgrade

The following message appears:

Software Release XXXX was installed successfully. All files were 
copied from CDROM to the hard disk.

Please press <CR> to when ready...

<a> Continue with ROM upgrade

<a> Yes, start Installation

<a> Continue with ROM upgrade

When the Installation Status Summary screen appears, press 
<CR> when ready...

When the INSTALL MENU appears:

<d> To install Database only
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When the database installation screen appears, insert the first 
2 MB database diskettes in the IODU/C.

<a> to install the customer database

<y> to start installation

<a> to continue the database installation

<y> to load the database

<a> to continue with ROM upgrade

<cr> Are you sure you want to continue with IOP ROM

<a> to install the IOP-ROM from hard disk

<y> Yes, start installation

<a> to continue with ROM upgrade

The Installation Status Summary screen appears. Verify that CD 
to disk, disk to ROM, Database, CP-BOOTROM, and IOP-ROM 
were installed. 

<cr> press return to continue

<q> to quit (remove any diskettes from the floppy drive)

<y> Yes, to confirm quit

<a> to reboot the system

The system will automatically perform a sysload during which 
several messages will appear on the system terminal. Wait for 
“DONE” and then “INI” messages to be displayed before 
continuing.
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Check for Peripheral Software Download

1 Load LD 22 and print Target peripheral software version. The Source 
peripheral software version was printed during the pre-conversion 
procedure. If there is a difference between the Source and Target 
peripheral software version, a forced download will occur during 
initialization when coming out of parallel reload. System initialization 
will take longer and established calls on IPE will be dropped.

Test call processing

1 Test Call Processing. This includes, but is not limited to the following:

• Check for dial tone.

• Make internal, external, and network calls.

• Check attendant console activity.

• Check DID trunks.

• Check any auxiliary processors.

Complete the upgrade

1 Perform a redundancy sanity test using the following sequence:

2 Clear the display and minor alarms..

The software conversion is complete.

LD 22
REQ PRT

TYPE PSWV

LD 135
STAT CNI Get status of CNI card

STAT CPU Get status of CPU and memory

CDSP Clear the displays on the Cores

CMAJ Clear major alarms

CMIN ALL Clear minor alarms

**** exit program
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Adding features and ISM limits
Adding new features and/or modifying Incremental Software Management 
(ISM) limits requires the installation of a new keycode. Keycodes are 
delivered via diskette or electronic file transfer and installed using the 
keycode management commands in LD 143 or the Meridian 1 Software 
Installation Tool.

The procedures below outline the steps to install a new keycode that can be 
activated "instantly" or that requires a sysload (Cold Restart).  More 
information on the "Instant ISM" feature can be found in the X11 Features 
and Services guide.

This section describes how to install a keycode using the commands listed 
below:

Feature operation
Feature operation is further broken down into four options:

• upgrade feature and ISM parameter using a keycode diskette

• upgrade feature and ISM parameter using HyperTerminal

LD 143 commands

Keycode delivery Keycode Installation command

Diskette Use the KNEW F0 or KNEW F1 
command in LD 143

Electronic file on a PC Use the KUPL command in LD 143, 
followed by the KNEW HD command 
(see note)

Faxed to the customer site 
(paper-based keycode)

Use the KMAN command in LD 143,  
followed by the KNEW HD command

Note: If the keycode is downloaded from the Keycode Distributor Server (KDS), 
use the KUPL command to install the keycode. Refer to the  Distributor Keycode 
Application section in this document for more information about KDS.
Software Conversion Procedures



Page 54 of 304  IODU/C software conversion
• upgrade feature and ISM parameter entered manually

• Revert to the previous keycode with the KRVR command

For the following procedures, Core 0 is initially active and Core 1 is initially 
inactive.

Feature and ISM parameter upgrade using a keycode diskette
Leave the system in full redundant mode (hard-disk and CPU redundancy).

1 Log in on a system terminal and load overlay 143.

>LD 143
CCBR000
.

2 Insert the new keycode diskette into the floppy drive on the active  
IODU/C card.

3 Print the pending keycode contents.

KSHO F1 (or 
F0)

print the contents of the candidate keycode in the 
floppy drive on the active Core. Where: 

F1 = Core 1 

F0 = Core 0
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4 Enter the KDIF command and select keycode comparison options.

Note: Ensure that the new keycode does not lower ISM limits or 
reduce features compared with the existing keycode. If you have 
determined that the keycode lowers ISM limits or reduces features, do 
not continue with the KNEW command, but contact your Nortel 
Networks order management representative.

. KDIF
Please use: KDIF <param1> <param2>
with the following parameters:

NEW accepted new keycode

REC currently used keycode

OLD previously used keycode

F0 candidate keycode on diskette in /f0 floppy drive

F1 candidate keycode on diskette in /f1 floppy drive

HD candidate keycode which was uploaded to hard disk
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Enter the keycode comparison option. The new keycode option is shown in 
bold.

Note: In the following example, the (REC) currently used keycode will 
be compared with the new keycode disk in floppy drive F0. The limits 
shown are for example purposes only.

.KDIF REC F0
Validating Keycode File /p/install/keycode.rec ... OK

Validating Keycode File /f0/keycode.kcd ... OK

Note: ( ) indicates that information is not available

......

Common packages for both keycodes:
0-2 4-5 7-25 28-29 32-55 58-65
......

System parameters 1st keycode: 2nd keycode:

System Serial Number : 46XX 46XX

Software Version : 3311 3311

System Type : Option 61C Option 61C

Call Processor : CP68040 CP68040

Release : 25 25

Issue : XX XX

NTI Order Number : 

NT SDID - 1 : 

NT SDID - 2 : 

Date and Time of Manufacture : 

ISM Limits 1st keycode: 2nd keycode:

Loop Limit : 32 32

Sys TNs Limit : 0 200

ACD Agt Limit : 10 10

ACD DNs Limit : 10 10

AST Limit : 10 10
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Additional packages in the 2nd keycode:
<    30-31 
.

5 Select the new keycode for activation using the KNEW command.

. KNEW F0

The uploaded keycode is validated against the security device.

If the following system message is given:

CCBR020 New Keycode accepted and activated successfully. 
Sysload is NOT needed!

This implies that the new keycode is eligible for instant activation and 
no  further user action is required, proceed to step 6 and 7.

Otherwise, if the keycode is not eligible for instant activation, a Sysload 
is needed to activate the new keycode and the following system 
message is given:

CCBR009 New Keycode accepted. New ISM limits and feature 
packages will be activated during the next sysload (Cold Restart).

Skip to step 8.

6 Load Overlay 22 and confirm that the new ISM parameters have been 
updated.

>LD 22
REQ SLT
....

If ISM limits are correct then the keycode installation is complete.

See "Reverting to the previous keycode with the KRVR command" on 
page...(NTP group to fill in) if ISM limits are not increased or problems 
exist.

7 Once you have confirmed that the keycode changes taken affect as 
expected, perform a data dump in LD 43.

8 Do these steps for keycodes that are not eligible for Instant ISM.

a. Place the system in split mode. This puts a redundant
(shadowed) system into single (non-shadowed) mode.
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b. Be sure CP 0 is active and CP1 is standby. You may need to

switch CPs:

c. Verify that IODU/C 0 is active. You may need to switch IODU/Cs.

d. In Core 0, set the CP card MAINT/NORM switch to MAINT.

e. In Core 1, disable the CNI cards by setting the ENB/DIS faceplate
switches to DIS.

f. In Core/Net 1, perform the following three steps in uninterrupted
sequence:

• press and hold the MAN RST button on the CP card 

• set the MAINT/NORM switch on the CP card to MAINT 

• release the MAN RST button

A sysload will begin (cold start).

9 In the inactive core (Core 1), load Overlay 22 and confirm that the new 
ISM parameters have been updated.

>LD 22
REQ SLT
....

LD 135

STAT CPU

SCPU to switch CPUs if necessary

**** exit program

LD 137

STAT Get the status of IODU/C 

SWAP Switch IODU/Cs if necessary 

**** exit program
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10 Switch call processing from the active core (Core 0) to the inactive core 
(Core 1).

a. In Core 0, access LD 137 to software disable the IODU/C card.

>LD 137
.DIS CMDU 0

b. In Core 0, set the DIS/ENB faceplate switch on the IODU/C card
to DIS.

c. In Core 0, disable the CNI cards by setting the ENB/DIS faceplate
switches to DIS. Call Processing will be interrupted.

d. In Core 1, enable the CNI cards by setting the ENB/DIS faceplate
to ENB.

e. In Core 1, press the MAN INT button. Call processing will be
switched from Core 0 to Core 1 when the warm restart is
completed.

The previously inactive core (Core 1) with the new keycode now becomes 
active.

11 In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to 
ENB.

12 In order to activate the new keycode on the new inactive core, a 
sysload (Cold Restart) is required.

Press the MAN RST button on Core/Net 0.

13 In Core 0, load Overlay 22 and confirm that the new ISM parameters 
have been updated.

>LD 22
REQ SLT
....

CAUTION
Service Interruption

Call Processing will be interrupted! Perform these 
next steps carefully and quickly. This is the point at 
which your service is interrupted. Calls in process 
will be interrupted, especially if Peripheral Software 
Download takes place. Some calls may be dropped.
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14 Return the system to redundant mode, synchronizing the memory and 
hard drive of the inactive core with the active core.

a. Enable the CNI cards by setting the ENB/DIS faceplate switch to
ENB in Core/Net 0.

b. Perform the following in uninterrupted sequence:

• Press and release the MAN RST button in Core/Net 0.

• When SYS700 messages appears on LCD display on 
Core/Net 0, set the MAINT/NORM switch to NORM in Core/Net 
0. 

In 60 seconds, the LCD will display and confirm your processes with: 

RUNNING ROM OS 

ENTERING CP VOTE

An HWI534 message indicates the start of memory synchronization. In 
10 minutes, an HWI533 message on Core/Net 1 CSPI or SDI terminal 
indicates the memory synchronization is complete. 

c. In Core/Net 1, set the MAINT/NORM switch on the CP card to
NORM.

15 Test Core/Net 1 and Core/Net 0

a. Perform a redundancy sanity test using the following sequence:

LD 135

STAT CNI Get status of CNI cards

STAT CPU Get status of CPU and memory

TEST CPU Test the inactive Core/Net

TEST CNI c s Test each inactive CNI card
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b. Switch Cores and test the other side (Core/Net 0)

Note: Note: Testing the CP and CNI cards and synchronizing 
memory can take up to 20 minutes for each test. When the CP test is 
complete, the CP the memory is automatically synchronized. 

c. Clear the display and minor alarms on both Cores.

d. Get the status of the Cores, CNIs, and memory.

Note: Note: You may need to execute the STAT CNI command twice 
before receiving a response from the system. 

****                      exit program

16 Synchronize the hard disks.

SCPU Switch cores

TEST CPU Test the inactive Core/Net

TEST CNI c s Test each inactive CNI card

CDSP Clear the displays on the Cores

CMAJ Clear major alarms

CMIN ALL Clear minor alarms

STAT CPU Get the status of both Cores

STAT CNI Get the status of all configured 
CNIs and memory
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a. Load LD 137 and synchronize the hard disks. Synchronization
may take up to 50 minutes. To be sure that the contents of
IODU/C 1 hard disk are copied to IODU/C 0 hard disk, verify that
IODU/C 0 is disabled.

b. Get the status of the CMDU’s and be sure CMDU 0 is active.

Switch if necessary.

17 Perform a data dump in LD 43.

Feature and ISM parameter upgrade using HyperTerminal®

Leave the system in full redundant mode (hard-disk and CPU redundancy).

1 On a PC, access the Meridian 1 system (via a modem) with 
HyperTerminal®:
Click the Start button | Programs | Accessories | HyperTerminal.

2 Double-click the HyperTerminal client to the Meridian 1 system.

3 Log into the Meridian 1 system.

4 Load the Keycode Management Program (LD 143).

LD 137

STAT Get the status of the IODU/C and redundancy

SYNC Enter "Yes" to synchronize disks. Wait until 
the memory synchronization successfully 
completes before continuing

TEST CMDU Performs hard and floppy disk test.

STAT Get the status of the IODU/C and redundancy

SWAP Switch CMDU if necessary

STAT CMDU Get the status of the IODU/Cs. Be sure the 
same IODU/C and CPU are active.

**** exit program

LD 143 to load program

KUPL to upload keycodes to the hard disk on the target 
system
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5 Click the Transfer menu in HyperTerminal and select Send Text File.

6 From the Files of type pull-down menu, select All Files (*.*).

7 Locate and select the keycode file on the PC. Use the Look in 
pull-down menu to select the drive on which the keycode is located.

8 Click Open.

The keycode will be displayed after the KUPL prompt.

Example:

KUPL 0001PBX 0101 
9FPAMSRHNN17KRUQAFFSPREQEVMTHIDHRKDJHRKEJR56

9 Press the Enter key.

The Keycode is checked for CRC errors and is uploaded to the hard 
disk.

Enter the following command: 

Ensure that the new keycode does not lower ISM limits or reduce 
features compared with the existing keycode. If you have determined 
that the keycode lowers ISM limits or reduces features, do not continue 
with the KNEW command, but contact your Nortel Networks order 
management representative.

KDIF REC HD to compare the existing keycode with the new 
keycode on the hard disk
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10 Select the new keycode for activation using the KNEW command.

KNEW HD

The uploaded keycode is validated against the security device.

If the following system message is given:

CCBR020 New Keycode accepted and activated successfully. 
Sysload is NOT needed!

This implies that the new keycode is eligible for instant activation and 
no  further user action is required, proceed to step 11 and 12.

Otherwise, if the keycode is not eligible for instant activation, a Sysload 
is needed to activate the new keycode and the following system 
message is given:

CCBR009 New Keycode accepted. New ISM limits and feature 
packages will be activated during the next sysload (Cold Restart).

Skip to step 13.

11 Load Overlay 22 and confirm that the new ISM parameters have been 
updated.

>LD 22
REQ SLT
....

If ISM limits are correct then the keycode installation is complete.

See "Reverting to the previous keycode with the KRVR command" on 
page...(NTP group to fill in) if ISM limits are not increased or problems 
exist.

12 Once you have confirmed that the keycode changes taken affect as 
expected, perform a data dump in LD 43.

13 Do these steps for keycodes that are not eligible for Instant ISM.

Place the system in split mode.  This puts a redundant (shadowed) 
system into single (non-shadowed) mode. 
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a. Be sure CP 0 is active and CP1 is standby. You may need to

switch CPs:

b. Verify that IODU/C 0 is active. You may need to switch IODU/Cs.

c. In Core 0, set the CP card MAINT/NORM switch to MAINT.

d. In Core 1, disable the CNI cards by setting the ENB/DIS faceplate
switches to DIS.

e. In Core/Net 1, perform the following three steps in uninterrupted
sequence:

• press and hold the MAN RST button on the CP card 

• set the MAINT/NORM switch on the CP card to MAINT 

• release the MAN RST button 

A sysload will begin (cold start).

14 In the inactive core (Core 1), load Overlay 22 and confirm that the new 
ISM parameters have been updated.

>LD 22
REQ SLT
....

LD 135

STAT CPU

SCPU to switch CPUs if necessary

**** exit program

LD 137

STAT Get the status of IODU/C 

SWAP Switch IODU/Cs if necessary 

**** exit program
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15 Switch call processing from the active core (Core 0) to the inactive core 
(Core 1).

a. In Core 0, access LD 137 to software disable the IODU/C card.

>LD 137
.DIS CMDU 0

b. In Core 0, set the DIS/ENB faceplate switch on the IODU/C card
to DIS.

c. In Core 0, disable the CNI cards by setting the ENB/DIS faceplate
switches to DIS. Call Processing will be interrupted.

d. In Core 1, enable the CNI cards by setting the ENB/DIS faceplate
to ENB.

e. In Core 1, press the MAN INT button. Call processing will be
switched from Core 0 to Core 1 when the warm restart is
completed.

The previously inactive core (Core 1) with the new keycode now 
becomes active.

16 In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to 
ENB.

17 In order to activate the new keycode on the new inactive core, a 
sysload (Cold Restart) is required.

Press the MAN RST button on Core/Net 0.

18 In Core 0, load Overlay 22 and confirm that the new ISM parameters 
have been updated.

>LD 22
REQ SLT
....

CAUTION
Service Interruption

Call Processing will be interrupted! Perform these 
next steps carefully and quickly. This is the point at 
which your service is interrupted. Calls in process 
will be interrupted, especially if Peripheral Software 
Download takes place. Some calls may be dropped.
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19 Return the system to redundant mode, synchronizing the memory and 
hard drive of the inactive core with the active core.

a. Enable the CNI cards by setting the ENB/DIS faceplate switch to
ENB in Core/Net 0.

b. Perform the following in uninterrupted sequence:

• Press and release the MAN RST button in Core/Net 0.

• When SYS700 messages appears on LCD display on 
Core/Net 0, set the MAINT/NORM switch to NORM in 
Core/Net 0. 

In 60 seconds, the LCD will display and confirm your processes with: 

RUNNING ROM OS 

ENTERING CP VOTE

An HWI534 message indicates the start of memory synchronization. In 
10 minutes, an HWI533 message on Core/Net 1 CSPI or SDI terminal 
indicates the memory synchronization is complete. 

c. In Core/Net 1, set the MAINT/NORM switch on the CP card to
NORM.

20 Test Core/Net 1 and Core/Net 0

a. Perform a redundancy sanity test using the following sequence:

LD 135

STAT CNI Get status of CNI cards

STAT CPU Get status of CPU and memory

TEST CPU Test the inactive Core/Net

TEST CNI c s Test each inactive CNI card
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b. Switch Cores and test the other side (Core/Net 0)

Note: Testing the CP and CNI cards and synchronizing memory can 
take up to 20 minutes for each test. When the CP test is complete, the 
CP the memory is automatically synchronized.

c. Clear the display and minor alarms on both Cores.

d. Get the status of the Cores, CNIs, and memory.

Note: You may need to execute the STAT CNI command twice before 
receiving a response from the system. 

****                      exit program

21 Synchronize the hard disks.

SCPU Switch cores

TEST CPU Test the inactive Core/Net

TEST CNI c s Test each inactive CNI card

CDSP Clear the displays on the Cores

CMAJ Clear major alarms

CMIN ALL Clear minor alarms

STAT CPU Get the status of both Cores

STAT CNI Get the status of all configured 
CNIs and memory
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a. Load LD 137 and synchronize the hard disks. Synchronization
may take up to 50 minutes. To be sure that the contents of
IODU/C 1 hard disk are copied to IODU/C 0 hard disk, verify that
IODU/C 0 is disabled.

b. Get the status of the CMDU’s and be sure CMDU 0 is active.

Switch if necessary.

22 Perform a data dump in LD 43.

Feature and ISM parameter upgrade enter manually

Before beginning this procedure, you must have a copy of the keycode. The 
keycode can reside on paper or as an electronic file. To enter the keycode 
manually, you will type the keycode in LD 143 as 21 lines, 16 characters per 
line. 

1 Log into the system. 

2 Load the Keycode Management Program (LD 143). 

LD 137

STAT Get the status of the IODU/C and redundancy

SYNC Enter "Yes" to synchronize disks. Wait until 
the memory synchronization successfully 
completes before continuing

TEST CMDU Performs hard and floppy disk test.

STAT Get the status of the IODU/C and redundancy

SWAP Switch CMDU if necessary

STAT CMDU Get the status of the IODU/Cs. Be sure the 
same IODU/C and CPU are active.

**** exit program

LD 143 to load program

KMAN manually enter the keycode to the target system
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3 Type keycode file, 21 lines of 16 characters each. Press return to go 
to the next line. 

Note: When entering the keycode, do not enter the header 
information that proceeds the keycode. 

4 Type "end" at line 22 to end the process. 

5 Press enter. The new keycode file will be saved on the hard disk. 

Enter the following command: 

Ensure that the new keycode does not lower ISM limits or reduce 
features compared with the existing keycode. If you have determined 
that the keycode lowers ISM limits or reduces features, do not continue 
with the KNEW command, but contact your Nortel Networks order 
management representative.

6 Select the new keycode for activation using the KNEW command.

KNEW HD

The uploaded keycode is validated against the security device.

If the following system message is given:

CCBR020 New Keycode accepted and activated successfully. 
Sysload is NOT needed!

This implies that the new keycode is eligible for instant activation and 
no  further user action is required, proceed to step 7 and 8.

Otherwise, if the keycode is not eligible for instant activation, a Sysload 
is needed to activate the new keycode and the following system 
message is given:

CCBR009 New Keycode accepted. New ISM limits and feature 
packages will be activated during the next sysload (Cold Restart).

Skip to step 9.

KDIF REC HD to compare the existing keycode with the new 
keycode on the hard disk
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7 Load Overlay 22 and confirm that the new ISM parameters have been 
updated.

>LD 22
REQ SLT
....

If ISM limits are correct then the keycode installation is complete.

See "Reverting to the previous keycode with the KRVR command" on 
page...(NTP group to fill in) if ISM limits are not increased or problems 
exist.

8 Once you have confirmed that the keycode changes taken affect as 
expected, perform a data dump in LD 43.

9 Do these steps for keycodes that are not eligible for Instant ISM.

Place the system in split mode.  This puts a redundant (shadowed) 
system into single (non-shadowed) mode.

a. Be sure CP 0 is active and CP1 is standby. You may need to

switch CPs:

b. Verify that IODU/C 0 is active. You may need to switch IODU/Cs.

c. In Core 0, set the CP card MAINT/NORM switch to MAINT.

d. In Core 1, disable the CNI cards by setting the ENB/DIS faceplate
switches to DIS.

LD 135

STAT CPU

SCPU to switch CPUs if necessary

**** exit program

LD 137

STAT Get the status of IODU/C

SWAP Switch IODU/Cs if necessary

**** exit program
Software Conversion Procedures



Page 72 of 304  IODU/C software conversion
e. In Core/Net 1, perform the following three steps in uninterrupted
sequence:

• press and hold the MAN RST button on the CP card 

• set the MAINT/NORM switch on the CP card to MAINT 

• release the MAN RST button 

A sysload will begin (cold start).

10 In the inactive core (Core 1), load Overlay 22 and confirm that the new 
ISM parameters have been updated.

>LD 22
REQ SLT
....

11 Switch call processing from the active core (Core 0) to the inactive core 
(Core 1).

a. In Core 0, access LD 137 to software disable the IODU/C card.

>LD 137
.DIS CMDU 0

b. In Core 0, set the DIS/ENB faceplate switch on the IODU/C card
to DIS.

c. In Core 0, disable the CNI cards by setting the ENB/DIS faceplate
switches to DIS. Call Processing will be interrupted.

d. In Core 1, enable the CNI cards by setting the ENB/DIS faceplate
to ENB.

e. In Core 1, press the MAN INT button. Call processing will be
switched from Core 0 to Core 1 when the warm restart is
completed.

CAUTION
Service Interruption

Call Processing will be interrupted! Perform these 
next steps carefully and quickly. This is the point at 
which your service is interrupted. Calls in process 
will be interrupted, especially if Peripheral Software 
Download takes place. Some calls may be dropped.
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The previously inactive core (Core 1) with the new keycode now becomes 
active.

12 In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to 
ENB.

13 In order to activate the new keycode on the new inactive core, a 
sysload (Cold Restart) is required.

Press the MAN RST button on Core/Net 0.

14 In Core 0, load Overlay 22 and confirm that the new ISM parameters 
have been updated.

>LD 22
REQ SLT
....

15 Return the system to redundant mode, synchronizing the memory and 
hard drive of the inactive core with the active core.

a. Enable the CNI cards by setting the ENB/DIS faceplate switch to
ENB in Core/Net 0.

b. Perform the following in uninterrupted sequence:

• Press and release the MAN RST button in Core/Net 0.

• When SYS700 messages appears on LCD display on 
Core/Net 0, set the MAINT/NORM switch to NORM in Core/Net 
0. 

In 60 seconds, the LCD will display and confirm your processes with: 

RUNNING ROM OS 

ENTERING CP VOTE

An HWI534 message indicates the start of memory synchronization. In 
10 minutes, an HWI533 message on Core/Net 1 CSPI or SDI terminal 
indicates the memory synchronization is complete. 

c. In Core/Net 1, set the MAINT/NORM switch on the CP card to
NORM.

16 Test Core/Net 1 and Core/Net 0
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a. Perform a redundancy sanity test using the following sequence:

b. Switch Cores and test the other side (Core/Net 0)

Note: Testing the CP and CNI cards and synchronizing memory can 
take up to 20 minutes for each test. When the CP test is complete, the 
CP the memory is automatically synchronized.

c. Clear the display and minor alarms on both Cores.

d. Get the status of the Cores, CNIs, and memory.

Note: Note: You may need to execute the STAT CNI command twice 
before receiving a response from the system.

****                      exit program

17 Synchronize the hard disks.

LD 135

STAT CNI Get status of CNI cards

STAT CPU Get status of CPU and memory

TEST CPU Test the inactive Core/Net

TEST CNI c s Test each inactive CNI card

SCPU Switch cores

TEST CPU Test the inactive Core/Net

TEST CNI c s Test each inactive CNI card

CDSP Clear the displays on the Cores

CMAJ Clear major alarms

CMIN ALL Clear minor alarms

STAT CPU Get the status of both Cores

STAT CNI Get the status of all configured 
CNIs and memory
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a. Load LD 137 and synchronize the hard disks. Synchronization
may take up to 50 minutes. To be sure that the contents of
IODU/C 1 hard disk are copied to IODU/C 0 hard disk, verify that
IODU/C 0 is disabled.

b. Get the status of the CMDU’s and be sure CMDU 0 is active.

Switch if necessary.

18 Perform a data dump in LD 43.

Reverting to the previous keycode with the KRVR command
Note: The terms “old” and “new” keycode as discussed here refer to 
the most recent previous KNEW command. The “old” keycode is the 
former keycode, prior to the KNEW command. The “new” keycode is 
the keycode that was activated by the KNEW command.

LD 137

STAT Get the status of the IODU/C and redundancy

SYNC Enter "Yes" to synchronize disks. Wait until 
the memory synchronization successfully 
completes before continuing

TEST CMDU Performs hard and floppy disk test.

STAT Get the status of the IODU/C and redundancy

SWAP Switch CMDU if necessary

STAT CMDU Get the status of the IODU/Cs. Be sure the 
same IODU/C and CPU are active.

**** exit program
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To revert to the old keycode:

• In overlay 143, enter the KRVR command.

The old keycode is eligible for instant activation with the KRVR 
command if the only difference between the old keycode and the new 
keycode is that some or all of the ISM parameters in the old keycode 
are higher.

If the keycode is eligible for instant activation, it will be activated 
without further user action, and the following system message is given:

CCBR020 New Keycode accepted and activated successfully. 
Sysload is NOT needed!

Otherwise, if the keycode is not eligible for instant activation, a Sysload 
is needed to activate the new keycode and the following system 
message is given:

CCBR009 New Keycode accepted. New ISM limits and feature 
packages will be activated during the next sysload (Cold Restart).

Follow below procedures to sysload the system if the keycodes are not 
eligible for Instant ISM and CCR009 message is displayed:

1 Place the system in split mode.  This puts a redundant (shadowed) 
system into single (non-shadowed) mode. 

a. Be sure CP 0 is active and CP1 is standby. You may need to

switch CPs:

b. Verify that IODU/C 0 is active. You may need to switch IODU/Cs.

LD 135

STAT CPU

SCPU to switch CPUs if necessary

**** exit program

LD 137

STAT Get the status of IODU/C 

SWAP Switch IODU/Cs if necessary 

**** exit program
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c. In Core 0, set the CP card MAINT/NORM switch to MAINT.

d. In Core 1, disable the CNI cards by setting the ENB/DIS faceplate
switches to DIS.

e. In Core/Net 1, perform the following three steps in uninterrupted
sequence:

• press and hold the MAN RST button on the CP card 

• set the MAINT/NORM switch on the CP card to MAINT 

• release the MAN RST button A sysload will begin (cold start).

2 In the inactive core (Core 1), load Overlay 22 and confirm that the new 
ISM parameters have been updated.

>LD 22
REQ SLT
....

3 Switch call processing from the active core (Core 0) to the inactive core 
(Core 1).

a. In Core 0, access LD 137 to software disable the IODU/C card.

>LD 137
.DIS CMDU 0

b. In Core 0, set the DIS/ENB faceplate switch on the IODU/C card
to DIS.

c. In Core 0, disable the CNI cards by setting the ENB/DIS faceplate
switches to DIS. Call Processing will be interrupted.

d. In Core 1, enable the CNI cards by setting the ENB/DIS faceplate
to ENB.

CAUTION
Service Interruption

Call Processing will be interrupted! Perform these 
next steps carefully and quickly. This is the point at 
which your service is interrupted. Calls in process 
will be interrupted, especially if Peripheral Software 
Download takes place. Some calls may be dropped.
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e. In Core 1, press the MAN INT button. Call processing will be
switched from Core 0 to Core 1 when the warm restart is
completed.

The previously inactive core (Core 1) with the new keycode now becomes 
active.

4 In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to 
ENB.

5 In order to activate the new keycode on the new inactive core, a 
sysload (Cold Restart) is required.

6 Press the MAN RST button on Core/Net 0.

7 In Core 0, load Overlay 22 and confirm that the new ISM parameters 
have been updated.

>LD 22
REQ SLT
....

8 Return the system to redundant mode, synchronizing the memory and 
hard drive of the inactive core with the active core.

a. Enable the CNI cards by setting the ENB/DIS faceplate switch to
ENB in Core/Net 0.

b. Perform the following in uninterrupted sequence:

• Press and release the MAN RST button in Core/Net 0.

• When SYS700 messages appears on LCD display on 
Core/Net 0, set the MAINT/NORM switch to NORM in Core/Net 
0. 

In 60 seconds, the LCD will display and confirm your processes with: 

RUNNING ROM OS 

ENTERING CP VOTE

An HWI534 message indicates the start of memory synchronization. In 
10 minutes, an HWI533 message on Core/Net 1 CSPI or SDI terminal 
indicates the memory synchronization is complete. 

c. In Core/Net 1, set the MAINT/NORM switch on the CP card to
NORM.

9 Test Core/Net 1 and Core/Net 0
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a. Perform a redundancy sanity test using the following sequence:

b. Switch Cores and test the other side (Core/Net 0)

Note: Note: Testing the CP and CNI cards and synchronizing 
memory can take up to 20 minutes for each test. When the CP test is 
complete, the CP the memory is automatically synchronized. 

c Clear the display and minor alarms on both Cores. 

d. Get the status of the Cores, CNIs, and memory.

Note: Note: You may need to execute the STAT CNI command twice 
before receiving a response from the system. 

        ****                      exit program

10 Synchronize the hard disks.

LD 135

STAT CNI Get status of CNI cards

STAT CPU Get status of CPU and memory

TEST CPU Test the inactive Core/Net

TEST CNI c s Test each inactive CNI card

SCPU Switch cores

TEST CPU Test the inactive Core/Net

TEST CNI c s Test each inactive CNI card

CDSP Clear the displays on the Cores

CMAJ Clear major alarms

CMIN ALL Clear minor alarms

STAT CPU Get the status of both Cores

STAT CNI Get the status of all configured 
CNIs and memory
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a. Load LD 137 and synchronize the hard disks. Synchronization
may take up to 50 minutes. To be sure that the contents of
IODU/C 1 hard disk are copied to IODU/C 0 hard disk, verify that
IODU/C 0 is disabled.

b. Get the status of the CMDU’s and be sure CMDU 0 is active.

Switch if necessary.

LD 137

STAT Get the status of the IODU/C and redundancy

SYNC Enter "Yes" to synchronize disks. Wait until 
the memory synchronization successfully 
completes before continuing

TEST CMDU Performs hard and floppy disk test.

STAT Get the status of the IODU/C and redundancy

SWAP Switch CMDU if necessary

STAT CMDU Get the status of the IODU/Cs. Be sure the 
same IODU/C and CPU are active.

**** exit program
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Reference list
The following are the references in this section:

• Software Conversion Procedures (553-2001-320)

• Administration (553-3001-311)

• Hardware Replacement (553-3001-520)

This chapter details the screen displays and options of the CD-ROM Software 
Installation Tool (hereafter referred to as “Software Installation Tool”) that is 
compatible on Options 51C, 61C, 81, and 81C systems equipped with the 
NT5D61 Input/Output Disk Unit with CD-ROM (IODU/C).

 This tool is based on the existing Software Installation Tool, but has notable 
differences in menus as well as new functionality to support installation of 
software from CD-ROM, copying of system software from Core to Core, 
copying of database from Core to Core, and Keycode installation.

The IODU/C card no longer uses a Security Cartridge, but instead uses both 
a Security Device and an electronic keycode file. This keycode file is stored 
on a 2MB diskette and must be inserted into the IODU/C floppy drive and 
authenticated each time the Software Installation Tool is loaded and the 
Install Menu is accessed.

On systems equipped with an IODU/C, the database is stored on 2MB 
diskettes, not 4MB diskettes. A Database Transfer Utility diskette, specific to 
Call Processor type, is available to convert a 4MB database to a 2MB 
database. Refer to Software Conversion Procedures (553-2001-320) and 
Hardware Replacement (553-3001-520) for procedures on upgrading from 
systems equipped with IOP and CMDU or IOP/CMDU cards to IODU/C.
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The Tools Menu has new options for finding the CD-ROM status (option 
<g>), printing the Keycode (option <h>), printing information about the 
Security Device (option <i>), checking the customer-specific CD-ROM data 
(<j>), manually creating a Keycode diskette (<k>), and archiving the 
database (<s>).

Do not turn off the system during the installation process. If you need to quit 
the installation process, do so from within the Software Installation Tool 
before powering off the system.

Read the entire procedure before attempting to perform an installation.

Before the Software Installation Tool is activated, verify that the system is in 
split mode (not applicable for Option 51C) and that a terminal is connected to 
CPSI port J25 on the I/O panel (in the inactive Core for dual CPU systems). 
Option 51C systems will be taken out of service.

To activate the Software Installation Tool, insert the Install diskette specific 
to your Call Processor type and the CD-ROM containing system software (if 
you will be installing that component). Press the MAN RST button on the CP 
card in the same Core.

The IODU/C Software Installation Tool requires the following items:

• 2MB diskettes (used to store, backup, and restore the database)

• an Install diskette specific to the system’s Call Processor card

• a Keycode diskette

• a CD-ROM containing system software
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Note: If you will be installing system software from CD-ROM (options 
<a>, <b>, or <c> from the Install Menu), then insert the CD into the 
CD-ROM drive before loading the Software Installation Tool.

Pay close attention to the menus when they appear; they display the options 
available at any given stage.

Status Summary Charts
Status Summary Charts are displayed for the purpose of informing the user 
about what items will be installed or have been installed. This example is 
shown when option <b> (all components) is chosen from the Install Menu.

CAUTION
Loss of Data

The screens shown in this procedure are examples. 
They are not intended to exactly represent the 
displays that will appear for your system, nor do the 
choices entered represent those you should 
necessarily choose. Be sure to watch the terminal 
display, and follow the on-screen instructions.
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Note: Your screen may differ from this example.

The possible values and meanings for each column are defined below.

— Choice

• yes indicates the item will be installed

• no indicates the item was not selected, and will not be updated.

— Status

• quit indicates the quit option was used, and the process was exited.

• ok indicates the choice was installed successfully.

• error indicates the installation was not successful. A system message is 
given when the Software Installation Tool encounters a problem. Follow 
the actions required by the message.

INSTALLATION STATUS SUMMARY

553-7731

Option Choice Status Comment

SW: CD to disk

SW: disk to ROM

Database

CP-BOOTROM

IOP-ROM

yes

yes

yes

yes

yes

from xxxx to xxxx

Please enter:
<y> - Yes, start Installation.
<n> - No, stop Installation. Return to the Main Menu.

Enter Choice> y

<CR> ->
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• ignore applies to the CP ROM and IOP-ROM upgrade only. This 
appears when the process was exited when asked to replace a release and 
issue with the same release and issue.

• blank indicates the status is not yet determined if Choice = Yes. If 
Choice = No, the field remains blank.

— Comment

• from rel <number> to rel <number> gives the Source and Target 
release and issue numbers.

Messages
When the Software Installation Tool encounters a problem, a system message 
appears on the terminal display. These messages fall into two categories: 
warning and non-warning.

Warning messages are not critical errors. The Software Installation Tool 
proceeds with the installation following the appearance of this message. 
Refer to Administration (553-3001-311) for details regarding these messages.

Non-warning messages appear when a critical problem is encountered. The 
Software Installation Tool stops the process, and an action is recommended. 
When the action is complete, the Software Installation Tool can be restarted. 
In some cases, the tool allows you to restart by pressing the carriage return 
<CR>.
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Introductory Screen
The first screen that appears after loading the NT5D61 Software Installation 
Tool is the Nortel Networks Logo Screen shown below. 

Nortel Meridian - 1   Software/Database/PEROM CDROM INSTALL Tool  (x11)

                                             * *
                                          * * * 
* * * *              * *              * * * *
* * * *         * * * * *         * * * * * * * * * *
* * * *      * * * * * * *     * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * *
* * * *            * * * *          * * * *
* * * *            * * * *          * * * *
* * * *            * * * *          * * * *
* * * *            * * * *          * * * * 
* * * *            * * * * * * * * * * * * * * * * *
* * * *              * * * * * *          * * * * * *
* * * *                 * * *                 * * *

Nortel — Meridian 1
Install Tool (x11)

Copyright 1992 - 1997 Nortel, Inc.

Please press <CR> when ready . . . 553-7728

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  
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The Main menu screen is displayed after the user presses <CR> from the NT 
Logo Screen. From this screen, the user may select option <u> to go to the 
Install Menu, or <t> to go to the Tools Menu. Alternately, option <q> to quit 
is available at this screen.

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

M A I N   M E N U

The Software Installation Tool will install or upgrade Meridian-1
System Software, Database and the PE-ROM (both CP and IOP ROM). 
You will be prompted throughout the installation and given the 
opportunity to quit at any time.

Please enter:

<u> - To Install menu.

<t> - To Tools menu.

<q> - Quit.

Enter choice > u

<CR>-->

553-7780

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  ——  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —
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Install Menu
Note: A Keycode diskette is required before accessing the Install Menu.

Before the Install Menu screen is displayed, two intermediary screens shown 
below prompts the user to insert their Keycode diskette for validation against 
the Security Device. 

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

Please insert the diskette with the keycode file into the floppy
drive.

Please enter:

<a> - Continue with the keycode validation

      (the keycode diskette is in the floppy drive).

<q> - Quit.

Enter Choice > a

<CR>-->

553-7729

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  — 
—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)
—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —
—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —

Please confirm that this keycode matches the CDROM Release

Please enter:

<y> - Yes, the keycode matches. Go on to Install Menu.

<n> - No, the keycode does not match. Try another keycode diskette.

Enter Choice > y

<CR>-->

553-8365
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Following successful Keycode validation, the Install Menu screen is 
displayed, as shown below.

Note: If the Software Installation Tool is loaded on a Core equipped 
with an NT5D61BA IODU/C (which lacks a CD-ROM drive), options 
<a>, <b>, and <c> will not appear.

Each option from the Install Menu is described in the following pages.

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

I N S T A L L   M E N U

The Software Installation Tool will install or upgrade Meridian-1
System Software, Database and the PE-ROM (both CP and IOP ROM). 
You will beprompted throughout the installation and given the 
opportunity to quit at any time.

Please enter:

<a> - To install Software, CP-BOOTROM, IOP-ROM.

<b> - To install Software, Database, CP-BOOTROM, IOP-ROM.

<c> - To install Software only.

<d> - To install Database only.

<e> - To install CP-BOOTROM only.

<f> - To install IOP-ROM only.

<g> - To reinstall CP-Software.

<o> - To copy System Software from the other Core.

<t> - To go to the Tools menu.

<k> - To install Keycode only.

           For Feature Expansion, use OVL143.

<q> - Quit.

Enter Choice > 

<CR>-->

553-7789

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  ——  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —
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Installing Software, CP-BOOTROM, and IOP-ROM

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

This option is selected for the sequential installation of software, 
CP-BOOTROM, and IOP-ROM. This option differs from option <b> in that 
the database is not installed. Use option <a> when going to a later software 
release or for a software upissue.

Installing Software, Database, CP-BOOT ROM, and IOP-ROM 

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

This option is selected when you wish to sequentially install all components 
- software, database, CP-BOOTROM, and IOP-ROM.

Option <b> is used during the upgrade procedures from NT5D20 
IOP/CMDU, NT6D63 IOP and NT6D64 CMDU, NT9D33 SMDU, NTND16 
FDU, NT8D69 MDU, and NTND16 MDU cards to NT5D61 IODU/C cards.

Installing Software only

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

This option is selected when you wish to install system software from the 
CD-ROM to the hard drive. When selecting option <c>, IOP-ROM and 
CP-BOOTROM are not installed.
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Installing Database only

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

The Database Menu of the Software Installation Tool is accessed by the <d> 
option on the Install Menu. The following options are available for installing 
a database:

• Option <a> is to install the backup customer database from one or more 
2MB diskettes. 

• Option <b> allows installation from the CD-ROM containing the default 
database. This option is used on new systems which have no existing 
database.

• Option <d> copies the existing database from the redundant Core. This 
option is used when the database has already been installed on one Core. 
This option is used when upgrading from IOP/CMDU to IODU/C cards.

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

You will now perform the database installation.

Note: If you are installing the Database from a floppy disk,
         please insert the correct disk now.

Please enter:

<a> - Install CUSTOMER Database

    (the customer database diskette must be in the Core 1 disk drive).

<b> - Install DEFAULT Database

     (the installation CDROM must be in the Core 1 disk drive).

<d> - Copy Database from the redundant disk.

<e> - Check the Database that exists on the hard disk.

<q> - Quit.

Enter Choice > a

<CR>-->

553-7779

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  ——  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —
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• Option <e> displays the version and issue of the current database 
residing on the Core. If database files are missing, error messages will be 
printed.

Installing CP-BOOT ROM

Note: Installation of CP-BOOTROM is available on systems with 
NT9D19, NT5D10, and NT5D03 Call Processor cards only. For systems 
with the NT6D66 Call Processor card, CP-ROM is installed instead of 
CP-BOOTROM. See page 93 for installing CP-ROM on a system 
equipped with an NT6D66.

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

Option <e> is for installing new CP-BOOTROM. This option is used to 
install CP-BOOTROM while on Core 0 in a software upgrade, when software 
has already been installed using options <a> or <b> on Core 1, and software 
has already been copied onto Core 0 using option <o>. 

The next screen displayed after selecting option <e> will show the version of 
CP-BOOTROM being replaced and version being installed, and the card slot 
where the CP-BOOTROM is being installed. The user is prompted to select 
<a> to continue with the CP-BOOTROM upgrade.

Installing CP-ROM

Note: Installation of CP-ROM is available on systems with NT6D66 
Call Processor cards only. For systems with the NT9D19, NT5D10, or 
NT5D03 Call Processor cards, CP-BOOTROM is installed instead of 
CP-BOOTROM. See page 93 for installing CP-ROM on a system 
equipped with an NT6D66.

CAUTION
Loss of Data

Before upgrading the system database, be sure a 
backup of the previous (source) database is on hand. 
Should any problems arise, it may be necessary to 
return to the previous database.
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Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

Option <e> is for installing new CP-ROM. This option is used to install 
CP-ROM while on Core 0 in a software upgrade, when software has already 
been installed using options <a> or <b> on Core 1, and software has already 
been copied onto Core 0 using option <o>. 

The next screen displayed after selecting option <e> will prompt the user to 
choose whether to install the CP-ROM from the hard disk (option <a>), or 
from CD-ROM (option <b>). If software has just been installed successfully, 
then option <a> should be used. However, if software was not installed, select 
option <b> to install from CD-ROM.

Installing IOP-ROM 

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

Option <f> is for installing new IOP-ROM. This option is used to install 
IOP-ROM while on Core 0 in a software upgrade, when software has already 
been installed using options <a> or <b> on Core 1, and software has already 
been copied onto Core 0 using option <o>, and CP-BOOTROM has been 
installed using option <e>. 

The next screen displayed after selecting option <f> will prompt the user to 
choose whether to install the IOP-ROM from the hard disk (option <a>), or 
from CD-ROM (option <b>). If software has just been installed successfully, 
then option <a> should be used. However, if software was not installed, select 
option <b> to install from CD-ROM.

The next screen displayed after selecting option <f> will show the version of 
IOP-ROM being replaced and version being installed, and the card slot where 
the IOP-ROM is being installed. The user is prompted to select <a> to 
continue with the IOP-ROM upgrade.
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Reinstalling CP-Software

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

This option is used if a flash programming error occurs during software 
installation through options <a>, <b>, or <c>. Option <g>, which assumes 
that software files have already been installed on the hard disk, copies these 
files from the hard disk to the Flash EEPROM.

To copy system software from the other Core

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

Option <o> is used during a software upgrade when software has already 
been installed on Core 1, and the Software Installation Tool has been loaded 
on Core 0. 

Note: This option does not perform the installation of CP-BOOTROM 
(option <e>) or IOP-ROM (option <f>).

To go to the Tools Menu
Option <t> displays the Tools Menu and its options, which are described 
beginning on page 97.

To Install Keycode only
Option <k> is used when you wish to replace an existing Keycode.

To quit

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

Throughout the installation process, the option to quit is always available. 
Quitting with the Software Installation Tool quit commands is preferable to 
pressing the MAN RST button on the CP card, since quitting from the tool 
will erase unneeded temporary files. 
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When you are done using the NT5D61 Software Install Tool remove the 
diskette from the IODU/C and select option <q> to quit from the Installation 
menu. The terminal displays a confirmation to quit. Pressing <y> confirms 
the quit. 

The final screen displayed before quitting reminds the user that the Install 
diskette should be removed from the IODU/C floppy drive before pressing 
<a> to reboot the system. 

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)
—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —

You selected to Quit. Please confirm.

Please enter:

<y> - Yes, Quit.

<n> - No, DO NOT Quit.

Enter choice > y

<CR>-->

553-7751

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

You have selected to Quit the Software Installation Tool
You may reboot the system or return to the Main Menu.
Before rebooting the system, remove Install diskette from the floppy drive.

DO NOT REBOOT USING BUTTON!!

Please enter:

<a> - Reboot the system.

<m> - Return to the Main menu.

Enter Choice > a

<CR>-->

553-7752

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  ——  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —

----------------------------------------------

----------------------------------------------
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Tools Menu
To load the Software Installation Tool which contains the Tools Menu, insert 
the Install diskette which is compatible with your Call Processor card. Press 
the MAN RST button on the CP card to load the tool.

The first screen that appears after loading the NT5D61 Software Installation 
Tool is the Nortel Networks Logo Screen shown below. 

Nortel Meridian - 1   Software/Database/PEROM CDROM INSTALL Tool  (x11)

                                             * *
                                          * * * 

* * * *              * *              * * * *
* * * *         * * * * *         * * * * * * * * * *
* * * *      * * * * * * *     * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * *
* * * *            * * * *          * * * *
* * * *            * * * *          * * * *
* * * *            * * * *          * * * *
* * * *            * * * *          * * * * 
* * * *            * * * * * * * * * * * * * * * * *
* * * *              * * * * * *          * * * * * *
* * * *                 * * *                 * * *

Nortel — Meridian 1
Install Tool (x11)

Copyright 1992 - 1997 Nortel, Inc.

Please press <CR> when ready . . . 553-7728

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  
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This screen is displayed after the user presses <CR> from the Nortel 
Networks Logo Screen. From this screen, selecting option <t> brings the user 
to the Tools Menu.

Note: Insertion of the Keycode diskette is not required for accessing the 
Tools Menu.

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

M A I N   M E N U

The Software Installation Tool will install or upgrade Meridian-1
System Software, Database and the PE-ROM (both CP and IOP ROM). 
You will be prompted throughout the installation and given the 
opportunity to quit at any time.

Please enter:

<u> - To Install menu.

<t> - To Tools menu.

<q> - Quit.

Enter choice > t

<CR>-->

553-7797

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  ——  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —
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The Tools Menu has new options for finding the CD-ROM status (option 
<g>), printing the Keycode (option <h>), printing information about the 
Security Device (option <i>), checking the customer-specific CD-ROM data 
(<j>), manually creating a Keycode diskette (<k>), and archiving the 
database (<s>).

The Tools Menu is displayed below.

Each option from the Tools Menu is described in the following pages.

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)
—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —
—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —

T O O L S   M E N U

This is the Tools Menu for Install. You can select the tool that
is appropriate. Please select one of the options below.

Please enter:

<a> - To set the system date and time.

<b> - To partition the hard disk.

<c> - To display the partition size of hard disk.

<d> - To regenerate PDT Password.

<g> - To print CDROM content.

<h> - To print Keycode content.

<i> - To print Security Device content.

<j> - To Check the customer specific part of CDROM.

<k> - To manually create Keycode floppy diskette.

<r> - To install Keycode only.

<s> - To archive existing database.

<z> - To check MDU connection.

<m> - To return to the Main Menu

Enter choice > 

<CR>-->

553-7796
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Setting the system date and time
This option is used to change the system date and time for the system’s 
internal clock. The correct date and time will ensure that files are 
time-stamped accurately.

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

You have selected the option to set the system date and time.
This will change the internal clock of your system to a new data
and time.

The system date and time are also used by Install to time-stamp the new files 
created.

Pressing the carriage return at the prompt below will leave the
system date or time unchanged.

Please enter the new date or time.

Current date is: Tuesday 04-29-1997
Enter new date (dd mm yyyy) ? 30 4 1997
Date is set to: Wednesday 04-30-1997

Current time is: 15:52:00
Enter new time (hh mm ss) ? 15 05 45
Time is set to: 15 05 45

System Date and Time now is:
Wednesday 04-30-1997, 15:05:46 553-7743

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  — 
—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  — 
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Partitioning the hard disk

Note: Option <b> requires a password, and should only be performed by 
Nortel Networks support personnel. 

Displaying the hard disk partition size
Option <c> displays the partition sizes of the hard disk. The manufacturer and 
model number of the hard disk are also displayed.

Regenerate the PDT password

Note: Option <d> requires a password, and should only be performed by 
Nortel Networks support personnel.

To print the CD-ROM content
Option <g> is used to find whether a CD-ROM exists on each IODU/C, and 
whether its sectors are readable. After selecting <g>, three options are 
available:

• Fast readability test, which takes about 17 seconds for each CD-ROM 
and reads 1/30th of the CD-ROM sectors.

• Extensive readability test, which takes about 3 minutes for each 
CD-ROM and reads 1/4th of the CD-ROM sectors.

• Total readability test, which takes about 6 minutes for each CD-ROM 
and reads all sectors of the CD-ROMs.

CAUTION
Loss of Data

Partitioning a disk erases all files from it.

IODU 0
Hard Disk from: MAXTOR:7120SCS, Size:124MB,Sectors:248502
Unprotected       Part Size:30MB,  Sectors: 60000
Spare                 Part Size:30MB,  Sectors: 60000
CardId                Part Size:1MB,  Sectors: 2000
Protected           Part Size:60MB,  Sectors: 120000

553-7742
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Note: The failure of a CD-ROM drive to read a known good CD-ROM 
may indicate a problem with the CD-ROM drive.
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To print the Keycode content
Option <h> is used when you wish to display the information contained in the 
current Keycode. The information displayed includes machine type, software 
version, ISM limits, and which feature packages are enabled.

System Serial Number
Software Version           
System Type
Call Processor
Release
Issue
NTI Order Number
NT SDID - 1
NT SDID - 2
Date and Time of Manufacture       

Note:   (  ) indicates that information is not available

ISM Limits:
   Loop Limit          
   Sys TNs Limit         
   ACD Agt Limit 
   ACD DNs Limit        
   AST Limit            
   DSL Limit             
   LTID Limit               
   DCH Limit              
   AML Limit        
   MPH DSL Limit
   RAN CON Limit         
   RAN RTE Limit      
   MUS CON Limit
   Brand Index
      
Options Packages:
    0-2 4-5 7-25 28-29 232-55 57-65
    67 70-77 79-81 84 86 88-93
    95 98-105 107-109 111 113-121 125
   127 129 132-134 136 139-140 145-151
   153-155 157-160 162 164 170 172-175
   178-181 186 191-192 196 202-212 214-216
    218-219 222-225 227-229 231 233-235 240
    242-243 245-248 250-251 253-256 258-259 262-263
    286 290-293 296-297 301-303 305-310 313-316
    321 323-324 327-335

553-7745

:    46379
:    1811
:    Option 61C
:    CP68030
:    23
:    30G
:    000000000000
:    00000000
:    00000000
:    06/03/1998 - 14:53:38

:    32
:    32767
:    32767
:    24000
:    32767
:    100
:    100
:    64
:    16
:    100
:    32767
:    512
:    1000
:    1
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To print the Security Device content
Option <i> shows specific information about the Security Device, such as 
Serial Number. This enables the user to find information about the Security 
Device without removing the NT5D61 IODU/C card.

To check the customer-specific part of the CD-ROM
Option <j> is used to check the readability of the Keycode-specified system 
software on the CD-ROM drive. Once all files have been checked 
successfully, the message “Checking directory /cdx/xxxx_DMR.Nxx ended 
successfully” is displayed to indicate completion.

To manually create a Keycode diskette
Option <k> is used to manually type in a keycode and save it to a 2MB 
diskette. Upon selecting this option, you may enter the characters into 21 
Keycode entry lines of 16 characters each, which will compose the Keycode 
file to be saved on a 2MB diskette in the floppy drive.

Characters may be entered on the Keycode entry lines in one of two ways:

• manually entering each 16-character line followed by a <CR> or

• “pasting” each individual 16-character line, then pressing <CR> 
(available on a PC running Windows 95 , using the Copy command 
(Control-C) to copy a line of characters from a keycode file, positioning 
the cursor on the current Keycode entry line, and using the Paste 
command (Control-V) to paste the line).

If a line is entered which does not have 16 characters, a message will be 
displayed informing the user to reenter the line correctly.

To install Keycode only
Option <r> is used when you wish to replace an existing Keycode.

553-7746

Engineering Code (Side x)
Card Serial Number
NT SDID
Security Device Type
System Serial Number

:NT5D61AA
:06NNTM1831RRC3 IOP
:20000080
:NT_TCH
:46379
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To archive the existing database
Option <s> is one of the methods (the ABKO and BKO commands from 
overlay 143 are other methods) that is available to backup the customer 
database to 2MB diskettes. The size of the backup files and the estimated 
number of 2MB diskettes required to store the database will be displayed. 

To check MDU connection
Option <z> tests the connection between a connected MDU and IODU/C.

To return to the Main Menu
Option <m> is selected to return the user from the Tools Menu to the Main 
Menu, where the user may select to quit (<q>) or go to the Install Menu (<u>). 
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150
cPCI® MMDU software conversion

Contents
The following are the topics in this section:

Perform a parallel reload. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Back up current data. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Check the status of the hardware. . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Check that Core 0 is active. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Split the Cores. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Install the software on Core/Net 1. . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Transfer call processing from Core/Net 0 to Core/Net 1. .  . . . . . . . 114
Test Core/Net 1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
Install software on Core/Net 0. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
Enable system redundancy. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
Test Core/Net 1 and Core/Net 0. .  . . . . . . . . . . . . . . . . . . . . . . . . . . 121
Perform a data dump. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122

Back out of a system software upgrade. . . . . . . . . . . . . . . . . . . . . . . . . 123
Split the Cores. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
Install the software on Core/Net 1. . . . . . . . . . . . . . . . . . . . . . . . . . . 123
Transfer call processing from Core/Net 0 to Core/Net 1. .  . . . . . . . 128
Test Core/Net 1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
Install software on Core/Net 0. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . 129
Enable system redundancy. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135
Test Core/Net 1 and Core/Net 0. .  . . . . . . . . . . . . . . . . . . . . . . . . . . 135
Perform a data dump. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136
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The NT4N43AA cPCI Multi-Media Disk Unit (cPCI MMDU) is located in 
the extreme right hand slot next to the CP PII card. The cPCI MMDU contains 
the Hard drive, floppy drive and CD-ROM drive

Perform a parallel reload
You must install software on both Core hard drives. Follow the tasks below 
in order to complete the installation.

Note: To complete these procedures, the system must be working and 
connected to a terminal. 

Back up current data

1 Load the Equipment Data Dump Program (LD 43). At the prompt, enter

2 When “EDD000” appears on the terminal, enter

3 When “DATABASE BACKUP COMPLETE” or “DATADUMP 
COMPLETE” appears on the terminal, enter

LD 43 Load the program.

EDD Begin the data dump.

CAUTION
Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support organization. Correct 
any data dump problem before you continue.

**** Exit the program.
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Check the status of the hardware

1 Load LD 137 to check the status of the hard disks.

2 Load LD 135 and check the status of the CPs, CNIs and memories.

Check that Core 0 is active

Check that Core 0 is active. 
If Core 1 is active, make Core 0 active:

Split the Cores

From the active side, split the cores:

The system is now in split mode.

Install the software on Core/Net 1

1 Install the CD-ROM into the CD-ROM drive in the cPCI MMDU:

a. Press the button on the CD-ROM drive to open the CD-ROM disk
holder.

b. Place the CD-ROM disk into the holder with the disk label facing
up. Use the four tabs to secure the CD-ROM drive.

c. Press the button to close the CD-ROM disk holder.
Do not push the holder in by hand.

LD 137
STAT Get the status of the hard disks.

TEST CMDU Perform hard and floppy disk test.

LD 135
STAT CPU Get the status of both CPs and memory.

STAT CNI Get the status of all configured CNIs.

LD 135
STAT CPU Get the status of the CPUs.

SCPU Switch to Core 0 (if necessary).

LD 135
SPLIT Enter Split on the active core.

**** Exit program.
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Note: If the CD-ROM is not in the CD-ROM drive, the installation will 
not continue. Insert the CD-ROM to continue.

2 Place the CP PII Install floppy disk into the cPCI MMDU floppy drive.

Note: If a problem is detected during the system verification. Install 
stops, prints an error message, and aborts the installation. 
If the verification is not successful, do not continue; contact your 
technical support organization.

3 Press the RESET button on CP PII. Before the install menu runs, the 
system validates hard disk partitioning which takes about five minutes. 

The screen displays:

4 From the terminal, press <cr> to start the software installation.

5 When prompted, remove the CP PII Install Program diskette and insert 
the Keycode diskette.

Testing partition 0

0 percent done...1 percent done......99 percent done....100 
percent done

Testing partition 1

0 percent done...1 percent done......99 percent done....100 
percent done

Testing partition 2

0 percent done...1 percent done......99 percent done....100 
percent done completed!

Disk physical checking is completed!

There are 3 partitions in disk 0:
The size of partition 0 of disk 0 is XX MB
The size of partition 0 of disk 0 is XX MB
The size of partition 0 of disk 0 is XX MB

Disk partitions and sectors checking is competed!

<a> Continue with keycode validation.

<y> Confirm that the keycode matches the CD-ROM release.
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6 When the screen displays the Install Menu, select the following options 

in sequence when you are prompted to do so:

Pre-release 3 language groups

7 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 
sets. 

The languages contained in each selection are outlined as follows: 

• 1 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Brazilian Portuguese, Finnish, Japanese 
Katakana. 

• 2 - English, French, German, Spanish, Swedish, Norwegian, 
Danish, Finnish, Italian, Brazilian Portuguese. 

• 3 - English, French, German, Dutch, Polish, Czech, Hungarian, 
Russian, Latvian, Turkish. 

• 4 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

• 5 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Portuguese, Finnish, Japanese Katakana. 

• 6 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

<a> Install software.

<a> Verify that the CD-ROM is now in drive.

The Installation Status Summary screen appears that lists the 
options to be installed.

<y> Start Installation.

<a> Continue with Upgrade.

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)
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Release 3 language groups

8 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 
sets.

The languages contained in each selection are outlined as follows:

• 1 – Global 10 Languages (Release 3) English, French, 
German, Spanish, Swedish, Italian, Norwegian, Brazilian 
Portuguese, Finnish, Japanese Katakana.

• 2 – Western Europe 10 Languages (Release 3) English, 
French, German, Spanish, Swedish, Italian, Norwegian, 
Brazilian Portuguese, Finnish, Danish.

• 3 – Eastern Europe 10 Languages (Release 3) English, 
French, German, Dutch, Polish, Czech, Hungarian, Russian, 
Latvian, Turkish.

• 4 – North Americia six Languages (Release 3) English, French, 
German, Spanish, Brazilian Portuguese, Japanese Katakana.

• 5 – Spare Group A.

• 6 – Spare Group B.

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)
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9 Continue with ROM upgrade when prompted.
Select a database to install.

10 The system automatically performs a sysload: several message 
appear on the system terminal. Wait for “DONE” and then “INI” 
message to display before you continue.

While the sysload is being performed, database conversion occurs.

Verify that the following message appears on the system terminal:

11 Confirm that Release 25 software is installed and is working on 
Core/Net 1:

<cr> Enter carriage return to continue.

<a> Continue with CP BOOTROM installation.

<a> Install the CP BOOTROM from hard disk.

<a> Start installation.

<a> Continue with ROM upgrade.

The Installation Status Summary screen appears. Verify that CD to 
disk, disk to ROM, and CP-BOOTROM were installed. 

<cr> Continue.

<q> Quit. 
Remove any diskettes and the CD-ROM from the cPCI 
MMDU drives.

<y> Confirm quit.

<a> Reboot the system.

DATA CONVERSION
 RELEASE 25.XX TO RELEASE 25.XX

LD 135 Load the program.

STAT CPU Display the CPU status.

STAT CNI Display the cCNI status.
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Check for peripheral software download

Use LD 22 and print the Target peripheral software version. (You 
printed the Source peripheral software version during the 
pre-conversion procedure.)

If there is a difference between the Source and Target peripheral 
software version, a forced download occurs during initialization when 
coming out of parallel reload. System initialization will take longer and 
established calls on IPE will be dropped.

Transfer call processing from Core/Net 0 to Core/Net 1

1 From Core/Net 0, the active side, transfer call processing to Core/Net 
1:

Call processing is now switched from Core/Net 0 to Core/Net 1.

LD 22
REQ Print.

TYPE PSWV.

ISSP Print issue and release.

TID Print Tape ID.

SLLP Print System and patch information.

Print auxiliary ID.

**** Exit program.

CAUTION

Service Interruption

The following procedure to transfer call processing 
can cause service interruptions.
Time your procedure to minimize the effect of any 
breaks in service.

LD 135 Load the program.

CUTOVR The inactive CP become active.
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Test Core/Net 1

Test Call Processing. This includes, but is not limited to the following:

1 Check for dial tone.

2 Make internal, external, and network calls.

3 Check attendant console activity.

4 Check DID trunks.

5 Check any auxiliary processors.

Note: From this point forward you are upgrading Core/Net 0 with new 
software.

Install software on Core/Net 0

1 Install the CD-ROM into the CD-ROM drive in the cPCI MMDU:

a. Press the button on the CD-ROM drive to open the CD-ROM disk
holder.

b. Place the CD-ROM disk into the holder with the disk label facing
up.

c. Press the button again to close the CD-ROM disk holder.
Do not push the holder in by hand.

Note: If the CD-ROM is not in the CD-ROM drive, the installation will 
not continue. Insert the CD-ROM to continue.

2 Place the CP PII Install floppy disk into the cPCI MMDU floppy drive.

Note: If a problem is detected during the system verification, Install 
stops, prints an error message, and aborts the installation. If the 
verification is not successful, do not continue; contact your technical 
support organization.

3 Press the manual RESET button on the CP PII card faceplate.
Before the install menu runs, the system validates hard disk 

partitioning which takes about five minutes. The screen displays:

Testing partition 0

0 percent done...1 percent done ...99 percent done....100 
percent done

Testing partition 1
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4 At the terminal, press <cr> to start the software installation.

5 When prompted, remove the CP PII Install Program diskette and insert 
the Keycode diskette.

6 When the screen displays the Install Menu, select the following options 

in sequence when you are prompted to do so:

0 percent done...1 percent done...99 percent done...100 
percent done

Testing partition 2

0 percent done...1 percent done......99 percent done....100 
percent completed!

Disk physical checking is completed!

There are 3 partitions in disk 0:
The size of partition 0 of disk 0 is XX MB
The size of partition 0 of disk 0 is XX MB
The size of partition 0 of disk 0 is XX MB

Disk partitions and sectors checking is competed!

<a> Continue with keycode validation

<y> Confirm that the keycode matches the CD-ROM release

<a> Install software.

<a> Verify that the CD-ROM is now in drive.

The Installation Status Summary screen appears that lists the 
options to be installed.

<y> Start Installation.

<a> Continue with Upgrade.
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Pre-release 3 language groups

7 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 
sets. 

The languages contained in each selection are outlined as follows: 

• 1 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Brazilian Portuguese, Finnish, Japanese 
Katakana. 

• 2 - English, French, German, Spanish, Swedish, Norwegian, 
Danish, Finnish, Italian, Brazilian Portuguese. 

• 3 - English, French, German, Dutch, Polish, Czech, Hungarian, 
Russian, Latvian, Turkish. 

• 4 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

• 5 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Portuguese, Finnish, Japanese Katakana. 

• 6 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)
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Release 3 language groups

8 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 
sets.

The languages contained in each selection are outlined as follows:

• 1 – Global 10 Languages (Release 3) English, French, 
German, Spanish, Swedish, Italian, Norwegian, Brazilian 
Portuguese, Finnish, Japanese Katakana.

• 2 – Western Europe 10 Languages (Release 3) English, 
French, German, Spanish, Swedish, Italian, Norwegian, 
Brazilian Portuguese, Finnish, Danish.

• 3 – Eastern Europe 10 Languages (Release 3) English, 
French, German, Dutch, Polish, Czech, Hungarian, Russian, 
Latvian, Turkish.

• 4 – North Americia six Languages (Release 3) English, French, 
German, Spanish, Brazilian Portuguese, Japanese Katakana.

• 5 – Spare Group A.

• 6 – Spare Group B.

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)
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9 Continue with ROM upgrade when prompted.
Select a database to install.

10 The system automatically performs a sysload: several message 
appear on the system terminal. Wait for “DONE” and then “INI” 
message to display before you continue.

While the sysload is being performed, database conversion occurs.

Verify that the following message appears on the system terminal:

11 Confirm that Release 25 software is installed and is working on 
Core/Net 1:

<cr> Enter carriage return to continue.

<a> Continue with CP BOOTROM installation.

<a> Install the CP BOOTROM from hard disk.

<a> Start installation.

<a> Continue with ROM upgrade.

The Installation Status Summary screen appears. Verify that CD to 
disk, disk to ROM, and CP-BOOTROM were installed. 

<cr> Continue.

<q> Quit (remove any diskettes and the CD-ROM from the 
cPCI MMDU drives).

<y> Confirm quit.

<a> Reboot the system.

DATA CONVERSION
 RELEASE 25.XX TO RELEASE 25.XX

LD 135 Load the program.

STAT CPU Display the CPU status.

STAT CNI Display the cCNI status.
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Check for peripheral software download

Use LD 22 to print the Target peripheral software version. (You printed 
the Source peripheral software version during the pre-conversion 
procedure.)

If there is a difference between the Source and Target peripheral 
software version, a forced download occurs during initialization when 
coming out of parallel reload. System initialization will take longer and 

established calls on IPE will be dropped.

LD 22
REQ PRT

TYPE PSWV

ISSP Print issue and release.

TID Print Tape ID.

SLLP Print System and patch information.

Print auxiliary ID.

**** Exit program.
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Enable system redundancy

1 From the active CPU, Core/Net 1, enable redundancy:

Test Core/Net 1 and Core/Net 0

From the active CPU, Core/Net 1, perform these tests:

1 Perform a redundancy sanity test using the following sequence:

2 Test system redundancy:

LD 135
JOIN Synchronize the memory and drives.

LD 135
STAT CNI c s Get status of cCNI cards.

STAT CPU Get status of CPU and memory.

TEST CPU Test the CP PII card in both Core/Nets.

TEST CNI c s Test each cCNI card (core, slot).

STAT SUTL Get status of System Utility (main and 
Transition) cards.

TEST SUTL Test the System Utility (main and Transition) 
cards.

TEST IPB Test the Inter Processor Bus

TEST LCD Test the LCDs.

TEST LED Test the LEDs.

LD 137
TEST RDUN Test redundancy.

DATA RDUN
TEST CMDU Test the cPCI MMDU card.
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3 Switch Cores and test the other side (Core/Net 0)

4 Clear the display and minor alarms on both Cores.

5 Get the status of the Cores, CNIs, and memory.

Perform a data dump

1 Load the LD 43. At the prompt, enter

2 Insert a floppy disk into the cPCI MMDU to capture the backup.

3 When “EDD000” appears on the terminal, enter

LD 135
SCPU Switch cores.

TEST CPU Test the inactive Core/Net.

STAT CNI c s Get status of cCNI (both main and Transition) 
cards.

TEST CNI c s Test cCNI (both main and Transition) cards.

STAT SUTL Get status of System Utility card.

TEST SUTL Test System Util card.

TEST IPB Test Inter Processor Bus.

TEST LCD Test LCDs.

TEST LED Test LEDs

CDSP Clear the displays on the Cores.

CMAJ Clear major alarms.

CMIN ALL Clear minor alarms.

STAT CPU Get the status of both Cores and redundancy

STAT CNI c s Get the status of all configured cCNIs (both main 
and Transition) cards.

**** Exit program.

LD 43 Load the program

EDD Begin the data dump
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4 When “DATABASE BACKUP COMPLETE” or “DATADUMP 
COMPLETE” appears on the terminal, enter

The parallel reload procedure is complete.

Back out of a system software upgrade
To back out of a system software upgrade once it is in the redundant mode 
running CP PII, split the cores and install the old release of software. Perform 
the following procedures in order.

Split the Cores

From the active side, split the cores:

The system is now in split mode.

Install the software on Core/Net 1

Install the old release of software: 

1 Install the CD-ROM into the CD-ROM drive in the cPCI MMDU:

a. Press the button on the CD-ROM drive to open the CD-ROM disk
holder.

b. Place the CD-ROM disk into the holder with the disk label facing
up. Use the four tabs to secure the CD-ROM drive.

c. Press the button again to close the CD-ROM disk holder.
Do not push the holder in by hand.

CAUTION

Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support organization. Correct 
any data dump problem before you continue.

****

LD 135 Load the program.
SPLIT Enter Split on the active core.

Allow the former active side to INIT before continuing.
**** Exit the program.
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Note: If the CD-ROM is not in the CD-ROM drive, the installation will 
not continue. Insert the CD-ROM to continue.

2 Place the Install floppy disk with the old software release into the cPCI 
MMDU floppy drive.

Note: If a problem is detected during the system verification, install 
stops, prints an error message, and aborts the installation. 
If the verification is not successful, do not continue; contact your 
technical support organization.

3 Press the manual RESET button on the CP PII card faceplate.
Before the install menu runs, the system validates hard disk 

partitioning which takes about five minutes. The screen displays:

4 At the terminal, press <cr> to start the software installation.

5 When prompted, remove the Install Program diskette and insert the 
Keycode diskette.

Testing partition 0

0 percent done ...1 percent done ...99 percent done....100 
percent done

Testing partition 1

0 percent done ...1 percent done ...99 percent done....100 
percent done

Testing partition 2

0 percent done ...1 percent done ...99 percent done....100 
percent completed!

Disk physical checking is completed!

There are 3 partitions in disk 0:
The size of partition 0 of disk 0 is XX MB
The size of partition 0 of disk 0 is XX MB
The size of partition 0 of disk 0 is XX MB

Disk partitions and sectors checking is competed!

<a> Continue with keycode validation.

<y> Confirm that the keycode matches the CD-ROM release.
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6 When the screen displays the Install Menu, select the following options 

in sequence when you are prompted to do so:

Pre-release 3 language groups

7 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 
sets. 

The languages contained in each selection are outlined as follows: 

• 1 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Brazilian Portuguese, Finnish, Japanese 
Katakana. 

• 2 - English, French, German, Spanish, Swedish, Norwegian, 
Danish, Finnish, Italian, Brazilian Portuguese. 

• 3 - English, French, German, Dutch, Polish, Czech, Hungarian, 
Russian, Latvian, Turkish. 

• 4 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

• 5 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Portuguese, Finnish, Japanese Katakana. 

• 6 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

<a> Install software.

<a> Verify that the CD-ROM is now in drive.

The Installation Status Summary screen appears that lists the 
options to be installed.

<y> Start Installation.

<a> Continue with Upgrade.

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)
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Release 3 language groups

8 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 
sets.

The languages contained in each selection are outlined as follows:

• 1 – Global 10 Languages (Release 3) English, French, 
German, Spanish, Swedish, Italian, Norwegian, Brazilian 
Portuguese, Finnish, Japanese Katakana.

• 2 – Western Europe 10 Languages (Release 3) English, 
French, German, Spanish, Swedish, Italian, Norwegian, 
Brazilian Portuguese, Finnish, Danish.

• 3 – Eastern Europe 10 Languages (Release 3) English, 
French, German, Dutch, Polish, Czech, Hungarian, Russian, 
Latvian, Turkish.

• 4 – North Americia six Languages (Release 3) English, French, 
German, Spanish, Brazilian Portuguese, Japanese Katakana.

• 5 – Spare Group A.

• 6 – Spare Group B.

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)
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9 Continue with ROM upgrade when prompted.
Select a database to install.

10 The system automatically performs a sysload: several message 
appear on the system terminal. Wait for “DONE” and then “INI” 
message to display before you continue.

While the sysload is being performed, database conversion occurs.

Verify that the following message appears on the system terminal:

11 Confirm that Release XX software is installed and working on 
Core/Net 1:

<cr> Enter carriage return to continue.

<a> Continue with CP BOOTROM installation.

<a> Install the CP BOOTROM from hard disk.

<a> Start installation.

<a> Continue with ROM upgrade.

The Installation Status Summary screen appears. Verify that CD to 
disk, disk to ROM, and CP-BOOTROM were installed. 

<cr> Continue.

<q> Quit. 
Remove any diskettes and the CD-ROM from the cPCI 
MMDU drives.

<y> Confirm quit.

<a> Reboot the system.

DATA CONVERSION
 RELEASE 25.XX TO RELEASE 25.XX

LD 135 Load the program.

STAT CPU Display the CPU status.

STAT CNI Display the cCNI status.
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Check for peripheral software download

Use LD 22 to print the Target peripheral software version. (You printed 
the Source peripheral software version during the pre-conversion 
procedure.)

If there is a difference between the Source and Target peripheral 
software version, a forced download occurs during initialization when 
coming out of parallel reload. System initialization will take longer and 
established calls on IPE will be dropped.

Transfer call processing from Core/Net 0 to Core/Net 1

From Core/Net 0, the active side, transfer call processing to Core/Net 1:

Call processing is now switched from Core/Net 0 to Core/Net 1.

Test Core/Net 1

Test Call Processing. This includes, but is not limited to the following:

1 Check for dial tone.

2 Make internal, external, and network calls.

LD 22
REQ Print.

TYPE PSWV.

ISSP Print issue and release.

TID Print Tape ID.

SLLP Print System and patch information.

Print auxiliary ID.

**** Exit program.

CAUTION
Service Interruption
The following procedure to transfer call processing 
can cause service interruptions.
Time your procedure to minimize the effect of any 
breaks in service.

LD 135 Load the program.

CUTOVR The inactive CP become active.
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3 Check attendant console activity.

4 Check DID trunks.

5 Check any auxiliary processors.

Note: From this point forward you are upgrading Core/Net 0 with new 
software.

Install software on Core/Net 0

1 Install the CD-ROM into the CD-ROM drive in the cPCI MMDU:

a. Press the button on the CD-ROM drive to open the CD-ROM disk
holder.

b. Place the CD-ROM disk into the holder with the disk label
showing.

c. Press the button again to close the CD-ROM disk holder.
Do not push the holder in by hand.

Note: If the CD-ROM is not in the CD-ROM drive, the installation will 
not continue. Insert the CD-ROM to continue.

2 Place the Install floppy disk for the old release of software into the cPCI 
MMDU floppy drive.

Note: If a problem is detected during the system verification, install 
stops, prints an error message, and aborts the installation. If the 
verification is not successful, do not continue; contact your technical 
support organization.

3 Press the manual RESET button on the CP PII card faceplate.
Before the Install menu runs, the system validates hard disk 

partitioning which takes about five minutes. The screen displays:

Testing partition 0

0 percent done...1 percent done...99 percent done....100 
percent done

Testing partition 1

0 percent done...1 percent done...99 percent done....100 
percent done

Testing partition 2

0 percent done...1 percent done...99 percent done....100 
percent completed!
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4 At the terminal, press <cr> to start the software installation.

5 When prompted, remove the Install Program diskette and insert the 
Keycode diskette.

6 When the screen displays the Install Menu, select the following options 

in sequence when you are prompted to do so:

Disk physical checking is completed!

There are 3 partitions in disk 0:
The size of partition 0 of disk 0 is XX MB
The size of partition 0 of disk 0 is XX MB
The size of partition 0 of disk 0 is XX MB

Disk partitions and sectors checking is competed!

<a> Continue with keycode validation

<y> Confirm that the keycode matches the CD-ROM release

<a> Install software.

<a> Verify that the CD-ROM is now in drive.

The Installation Status Summary screen appears that lists the 
options to be installed.

<y> Start Installation.

<a> Continue with Upgrade.
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Pre-release 3 language groups

7 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 
sets. 

The languages contained in each selection are outlined as follows: 

• 1 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Brazilian Portuguese, Finnish, Japanese 
Katakana. 

• 2 - English, French, German, Spanish, Swedish, Norwegian, 
Danish, Finnish, Italian, Brazilian Portuguese. 

• 3 - English, French, German, Dutch, Polish, Czech, Hungarian, 
Russian, Latvian, Turkish. 

• 4 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

• 5 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Portuguese, Finnish, Japanese Katakana. 

• 6 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)
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Release 3 language groups

8 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 
sets.

The languages contained in each selection are outlined as follows:

• 1 – Global 10 Languages (Release 3) English, French, 
German, Spanish, Swedish, Italian, Norwegian, Brazilian 
Portuguese, Finnish, Japanese Katakana.

• 2 – Western Europe 10 Languages (Release 3) English, 
French, German, Spanish, Swedish, Italian, Norwegian, 
Brazilian Portuguese, Finnish, Danish.

• 3 – Eastern Europe 10 Languages (Release 3) English, 
French, German, Dutch, Polish, Czech, Hungarian, Russian, 
Latvian, Turkish.

• 4 – North Americia six Languages (Release 3) English, French, 
German, Spanish, Brazilian Portuguese, Japanese Katakana.

• 5 – Spare Group A.

• 6 – Spare Group B.

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)
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9 Continue with ROM upgrade when prompted.
Select a database to install.

10 The system automatically performs a sysload: several message 
appear on the system terminal. Wait for “DONE” and then “INI” 
message to display before you continue.

While the sysload is being performed, database conversion occurs.

Verify that the following message appears on the system terminal:

11 Confirm that Release 25.XX software is installed and working on 
Core/Net 1:

<cr> Enter carriage return to continue.

<a> Continue with CP BOOTROM installation.

<a> Install the CP BOOTROM from hard disk.

<a> Start installation.

<a> Continue with ROM upgrade.

The Installation Status Summary screen appears. Verify that CD to 
disk, disk to ROM, and CP-BOOTROM were installed. 

<cr> Continue.

<q> Quit (remove any diskettes and the CD-ROM from the 
cPCI MMDU drives).

<y> Confirm quit.

<a> Reboot the system.

DATA CONVERSION
 RELEASE 25.XX TO RELEASE 25.XX

LD 135 Load the program.

STAT CPU Display the CPU status.

STAT CNI Display the cCNI status.
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Check for peripheral software download

Use LD 22 to print the Target peripheral software version. (You printed 
the Source peripheral software version during the pre-conversion 
procedure.)

If there is a difference between the Source and Target peripheral 
software version, a forced download occurs during initialization when 
coming out of parallel reload. System initialization will take longer and 

established calls on IPE will be dropped.

LD 22
REQ PRT

TYPE PSWV

ISSP Print issue and release.

TID Print Tape ID.

SLLP Print System and patch information.

Print auxiliary ID.

**** Exit program.
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Enable system redundancy

1 From the active CPU, Core/Net 1, enable redundancy:

Test Core/Net 1 and Core/Net 0

From the active CPU, Core/Net 1, perform these tests:

1 Perform a redundancy sanity test using the following sequence:

2 Test system redundancy:

3 Switch Cores and test the other side (Core/Net 0)

LD 135
JOIN Synchronize the memory and drives.

LD 135
STAT CNI c s Get status of cCNI cards.

STAT CPU Get status of CPU and memory.

TEST CPU Test the CP PII card in both Core/Nets.

TEST CNI c s Test each cCNI card (core, slot).

STAT SUTL Get status of System Utility (main and 
Transition) cards.

TEST SUTL Test the System Utility (main and Transition) 
cards.

TEST IPB Test the Inter Processor Bus

TEST LCD Test the LCDs.

TEST LED Test the LEDs.

LD 137
TEST RDUN Test redundancy.

DATA RDUN
TEST CMDU Test the MMDU card.

LD 135
SCPU Switch cores.

TEST CPU Test the inactive Core/Net.

STAT CNI c s Get status of cCNI (both main and Transition) 
cards.

TEST CNI c s Test cCNI (both main and Transition) cards.

STAT SUTL Get status of System Utility card.
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4 Clear the display and minor alarms on both Cores.

5 Get the status of the Cores, CNIs, and memory.

Perform a data dump

1 Load the LD 43. At the prompt, enter

2 When “EDD000” appears on the terminal, enter

3 When “DATABASE BACKUP COMPLETE” or “DATADUMP 
COMPLETE” appears on the terminal, enter

The software backup procedure is complete.

TEST SUTL Test System Util card.

TEST IPB Test Inter Processor Bus.

TEST LCD Test LCDs.

TEST LED Test LEDs

CDSP Clear the displays on the Cores.

CMAJ Clear major alarms.

CMIN ALL Clear minor alarms.

STAT CPU Get the status of both Cores and redundancy

STAT CNI c s Get the status of all configured cCNIs (both main 
and Transition) cards.

**** Exit program.

LD 43 Load the program

EDD Begin the data dump

CAUTION

Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support organization. Correct 
any data dump problem before you continue.

****
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Adding features and ISM limits to a CP PII system
Adding new features and/or modifying Incremental Software Management 
(ISM) limits requires the installation of a new keycode. Keycodes are 
delivered via diskette or electronic file transfer and installed using the 
keycode management commands in LD 143 or the Meridian 1 Software 
Installation Tool (see  Procedure 8: CD-ROM Software Installation Tool  on 
page 255).

The procedures below outline the steps to install a new keycode that can be 
activated "instantly" or that requires a sysload (Cold Restart).  More 
information on the "Instant ISM" feature can be found in the X11 Features 
and Services guide.

This section describes how to install a keycode to activate features and/or 
modify ISM limits using the commands listed below:

Feature operation
Feature operation is further broken down into four options:

• Feature and ISM parameter upgrade using a keycode diskette

• Feature and ISM parameter upgrade using HyperTerminal

• Feature and ISM parameter upgrade entered manually

• Reverting to the previous keycode with the KRVR command

LD 143 commands

Keycode delivery Keycode Installation command

Diskette Use the KNEW F0 command in LD 143

Electronic file on a PC Use the KUPL command in LD 143, for 
keycode file in ASCII format followed by 
the KNEW HD command

Faxed to the customer site 
(paper-based keycode)

Use the KMAN command in LD 143, to 
enter keycode manually followed by the 
KNEW HD command
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For the following procedures, Core 0 is initially active and Core 1 is initially 
inactive.

Feature and ISM parameter upgrade using a keycode diskette
Leave the system in full redundant mode (hard-disk and CPU redundancy).

1 Log in on a system terminal and load overlay 143.

>LD 143
CCBR000
.

2 Insert the new keycode diskette into the floppy drive on the active 
MMDU. 
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3 Enter the KDIF command and select keycode comparison options.

Note: Ensure that the new keycode does not lower ISM limits or 
reduce features compared with the existing keycode. If you have 
determined that the keycode lowers ISM limits or reduces features, do 
not continue with the KNEW command, but contact your Nortel 
Networks order management representative.

. KDIF
Please use: KDIF <param1> <param2>
with the following parameters:

Enter the keycode comparison option. The new keycode option is 
shown in bold.

Note: In the following example, the (REC) currently used keycode will 
be compared with the new keycode disk in floppy drive F0. The limits 
shown are for example purposes only.

.KDIF REC F0
Validating Keycode File /p/install/keycode.rec ... OK

Validating Keycode File /f0/keycode.kcd ... OK

NEW accepted new keycode

REC currently used keycode

OLD previously used keycode

F0 candidate keycode on diskette in /f0 floppy drive

HD candidate keycode which was uploaded to hard disk

System parameters 1st keycode: 2nd keycode:

System Serial Number : 46XX 46XX

Software Version : 3311 3311

System Type : Option 81C Option 81C

Call Processor : CP PII CP PII

Release : 25 25

Issue : XX XX

NTI Order Number : 

NT SDID - 1 : 
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Note: ( ) indicates that information is not available

......

Common packages for both keycodes:
0-2 4-5 7-25 28-29 32-55 58-65
......

Additional packages in the 2nd keycode:
<    30-31 
.

4 Select the new keycode for activation using the KNEW command.

. KNEW F0

The uploaded keycode is validated against the security device. 

If the following system message is given:

CCBR020 New Keycode accepted and activated successfully. 
Sysload is NOT needed!

This implies that the new keycode is eligible for instant activation and 
no further user action is required, proceed to step 5 and 6.

Otherwise, if the keycode is not eligible for instant activation, a Sysload 
is needed to activate the new keycode and the following system 
message is given:

CCBR009 New Keycode accepted. New ISM limits and feature 
packages will be activated during the next sysload (Cold Restart).

Skip to step 7.

NT SDID - 2 : 

Date and Time of Manufacture : 

ISM Limits 1st keycode: 2nd keycode:

Loop Limit : 32 32

Sys TNs Limit : 0 200

ACD Agt Limit : 10 10

ACD DNs Limit : 10 10

AST Limit : 10 10
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5 Load Overlay 22 and confirm that the new ISM parameters have been 
updated.

>LD 22
REQ SLT
....

If ISM limits are correct then the keycode installation is complete.

See "Reverting to the previous keycode with the KRVR command" on 
page...(NTP group to fill in) if ISM limits are not increased or problems 
exist.

6 Once you have confirmed that the keycode changes taken affect as 
expected, perform a data dump in LD 43.

7 For keycodes that are not eligible for Instant ISM. 

In the active core (e.g. Core 0) access LD 135 and type the "SPLIT" 
command. This puts a redundant (shadowed) system into single 
(non-shadowed) mode.

>LD 135
.SPLIT
.....

8 In the inactive core (Core 1), load Overlay 22 and confirm that the new 
ISM parameters have been updated.

>LD 22
REQ SLT
....

9 In the active core, access LD 135 and type the "CUTOVR" command. 
This transfers call processing from the active core (e.g. Core 0) to the 
inactive core (Core 1).

>LD 135
.CUTOVR
.....

The previously inactive core (Core 1) with the new keycode now 
becomes active.

10 In order to activate the new keycode on the new inactive core, a 
sysload (Cold Restart) is required.

Press the RESET button on Core 0.
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11 In Core 0, load Overlay 22 and confirm that the new ISM parameters 
have been updated.

>LD 22
REQ SLT
....

12 In the active core, access LD 135 and type the "JOIN" command.  This 
puts the system back to redundant mode, synchronizing the memory 
and hard drive of the inactive core with the active core.

>LD 135
.JOIN
....

13 Perform a data dump in LD 43.

Feature and ISM parameter upgrade using HyperTerminal®
Leave the system in full redundant mode (hard-disk and CPU redundancy).

1 On a PC, access the Meridian 1 system (via a modem) with 
HyperTerminal®:

• Click the Start button | Programs | Accessories | 
HyperTerminal.

2 Double-click the HyperTerminal client to the Meridian 1 system.

3 Log into the Meridian 1 system.

4 Load the Keycode Management Program (LD 143).

5 Click the Transfer menu in HyperTerminal and select Send Text File.

6 From the Files of type pull-down menu, select All Files (*.*).

7 Locate and select the keycode file on the PC. Use the Look in 
pull-down menu to select the drive on which the keycode is located.

LD 143 to load program

KUPL to upload keycodes to the hard disk on the target 
system
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8 Click Open.

The keycode will be displayed after the KUPL prompt.

Example:

KUPL 0001PBX 0101 
9FPAMSRHNN17KRUQAFFSPREQEVMTHIDHRKDJHRKEJR56

9 Press the Enter key.

The Keycode is checked for CRC errors and is uploaded to the hard 
disk.

Enter the following command: 

Ensure that the new keycode does not lower ISM limits or reduce 
features compared with the existing keycode. If you have determined 
that the keycode lowers ISM limits or reduces features, do not continue 
with the KNEW command, but contact your Nortel Networks order 
management representative.

10 Select the new keycode for activation using the KNEW command.

KNEW HD

The uploaded keycode is validated against the security device. 

If the following system message is given:

CCBR020 New Keycode accepted and activated successfully. 
Sysload is NOT needed!

This implies that the new keycode is eligible for instant activation and 
no further user action is required, proceed to step 11 and 12.

Otherwise, if the keycode is not eligible for instant activation, a Sysload 
is needed to activate the new keycode and the following system 
message is given:

CCBR009 New Keycode accepted. New ISM limits and feature 
packages will be activated during the next sysload (Cold Restart).

Skip to step 13.

KDIF REC HD to compare the existing keycode with the new 
keycode on the hard disk
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11 Load Overlay 22 and confirm that the new ISM parameters have been 
updated.

>LD 22
REQ SLT
....

If ISM limits are correct then the keycode installation is complete.

See "Reverting to the previous keycode with the KRVR command" on 
page...(NTP group to fill in) if ISM limits are not increased or problems 
exist.

12 Once you have confirmed that the keycode changes taken affect as 
expected, perform a data dump in LD 43.

13 For keycodes that are not eligible for Instant ISM.

In the active core (e.g. Core 0) access LD 135 and type the "SPLIT" 
command. This puts a redundant (shadowed) system into single 
(non-shadowed) mode. 

>LD 135
.SPLIT
.....

14 In the inactive core (Core 1), load Overlay 22 and confirm that the new 
ISM parameters have been updated.

>LD 22
REQ SLT
....

15 In the active core, access LD 135 and type the "CUTOVR" command. 
This transfers call processing from the active core (e.g. Core 0) to the 
inactive core (Core 1).

>LD 135
.CUTOVR
.....

The previously inactive core (Core 1) with the new keycode now 
becomes active.

16 In order to activate the new keycode on the new inactive core, a 
sysload (Cold Restart) is required.

Press the RESET button on Core 0.
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17 In Core 0, load Overlay 22 and confirm that the new ISM parameters 
have been updated.

>LD 22
REQ SLT
....

18 In the active core, access LD 135 and type the "JOIN" command. This 
puts the system back to redundant mode, synchronizing the memory 
and hard drive of the inactive core with the active core.

>LD 135
.JOIN
....

19 Perform a data dump in LD 43.

Feature and ISM parameter upgrade entered manually

Before beginning this procedure, you must have a copy of the keycode. The 
keycode can reside on paper or as an electronic file. To enter the keycode 
manually, you will type the keycode in LD 143 as 21 lines, 16 characters per 
line. 

1 Log into the system. 

2 Load the Keycode Management Program (LD 143). 

3 Type keycode file, 21 lines of 16 characters each. Press return to go 
to the next line. 

Note: When entering the keycode, do not enter the header 
information that proceeds the keycode. 

4 Type "end" at line 22 to end the process. 

LD 143 to load program

KMAN manually enter the keycode to the target system
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5 Press enter. The new keycode file will be saved on the hard disk. 

Enter the following command: 

Ensure that the new keycode does not lower ISM limits or reduce 
features compared with the existing keycode. If you have determined 
that the keycode lowers ISM limits or reduces features, do not continue 
with the KNEW command, but contact your Nortel Networks order 
management representative.

6 Select the new keycode for activation using the KNEW command.

KNEW HD

The uploaded keycode is validated against the security device. 

If the following system message is given:

CCBR020 New Keycode accepted and activated successfully. 
Sysload is NOT needed!

This implies that the new keycode is eligible for instant activation and 
no further user action is required, proceed to step 7 and 8.

Otherwise, if the keycode is not eligible for instant activation, a Sysload 
is needed to activate the new keycode and the following system 
message is given:

CCBR009 New Keycode accepted. New ISM limits and feature 
packages will be activated during the next sysload (Cold Restart).

Skip to step 9.

7 Load Overlay 22 and confirm that the new ISM parameters have been 
updated.

>LD 22
REQ SLT
....

If ISM limits are correct then the keycode installation is complete.

See "Reverting to the previous keycode with the KRVR command" on 
page...(NTP group to fill in) if ISM limits are not increased or problems 
exist.

8 Once you have confirmed that the keycode changes taken affect as 
expected, perform a data dump in LD 43.

KDIF REC HD to compare the existing keycode with the new 
keycode on the hard disk
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9 For keycodes that are not eligible for Instant ISM.

In the active core (e.g. Core 0) access LD 135 and type the "SPLIT" 
command. This puts a redundant (shadowed) system into single 
(non-shadowed) mode. 

>LD 135
.SPLIT
.....

10 In the inactive core (Core 1), load Overlay 22 and confirm that the new 
ISM parameters have been updated.

>LD 22
REQ SLT
....

11 In the active core, access LD 135 and type the "CUTOVR" command. 
This transfers call processing from the active core (e.g. Core 0) to the 
inactive core (Core 1).

>LD 135
.CUTOVR
.....

The previously inactive core (Core 1) with the new keycode now 
becomes active.

12 In order to activate the new keycode on the new inactive core, a 
sysload (Cold Restart) is required.

Press the RESET button on Core 0.

13 In Core 0, load Overlay 22 and confirm that the new ISM parameters 
have been updated.

>LD 22
REQ SLT
....

14 In the active core (Core 1), access LD 135 and type the "JOIN" 
command. This puts the system back to redundant mode, 
synchronizing the memory and hard drive of the inactive core with the 
active core.

>LD 135
.JOIN
.....

15 Perform a data dump in LD 43.
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Reverting to the previous keycode with the KRVR command
Note: The terms “old” and “new” keycode as discussed here refer to 
the most recent previous KNEW command. The “old” keycode is the 
former keycode, prior to the KNEW command. The “new” keycode is 
the keycode that was activated by the KNEW command.

To revert to the old keycode:

• In overlay 143, enter the KRVR command.

The old keycode is eligible for instant activation with the KRVR command if the 
only difference between the old keycode and the new keycode is that some or 
all of the ISM parameters in the old keycode are higher.

If the keycode is eligible for instant activation, it will be activated without further 
user action, and the following system message is given:

CCBR020 New Keycode accepted and activated successfully. Sysload is 
NOT needed!

Otherwise, if the keycode is not eligible for instant activation, a Sysload is 
needed to activate the new keycode and the following system message is 
given:

CCBR009 New Keycode accepted. New ISM limits and feature packages will 
be activated during the next sysload (Cold Restart).

Follow below procedures to sysload the system if the keycodes are not eligible 
for Instant ISM and CCR009 message is displayed:

1 In the active core (e.g. Core 0) access LD 135 and type the "SPLIT" 
command. This puts a redundant (shadowed) system into single 
(non-shadowed) mode. 

>LD 135
.SPLIT
.....

2 In the inactive core (Core 1), load Overlay 22 and confirm that the new 
ISM parameters have been updated.

>LD 22
REQ SLT
....
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3 In the active core, access LD 135 and type the "CUTOVR" command. 
This transfers call processing from the active core (Core 0) to the 
inactive core (Core 1).

>LD 135
.CUTOVR
.....

The previously inactive core (Core 1) with the new keycode now becomes 
active.

4 In order to activate the new keycode on the new inactive core, a 
sysload (Cold Restart) is required.

Press the RESET button on Core 0..

5 In Core 0, load Overlay 22 and confirm that the new ISM parameters 
have been updated.

>LD 22
REQ SLT
....

6 In the active core (Core 1), access LD 135 and type the "JOIN" 
command. This puts the system back to redundant mode, 
synchronizing the memory and hard drive of the inactive core with the 
active core.

>LD 135
.JOIN
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168
Increasing NT9D19, NT5D10 CP and NT5D03
CP memory

Contents
The following are the topics in this section:

Software Release 25 . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151

Increasing memory on NT9D19, NT5D10 CP and
NT5D03 CP cards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153

Determine your Call Processor memory configuration . . . . . . . . . . 154

NT5D03, NT5D10, NT9D19 CP cards . . . . . . . . . . . . . . . . . . . . . . . . . 155
Install the DRAM SIMMs . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159
Install the Flash memory . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162
Installing new NT9D19, NT5D10 or NT5D03 
CP cards on systems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163

Reference list
The following are the references in this section:

• Hardware Upgrade Procedures (553-3001-258)

Software Release 25
To install Release 25, your system must be operating with the required CP 
Flash and DRAM memory. If your system is not operating with the minimum 
memory requirement, the CP card(s) memory must be upgraded before 
installing Release 25 software.
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Release 25 supports a078611, NT9D19 (68040), NT5D10 (68060), and 
NT5D03 (68060E) Call Processor cards. The minimum memory requirement 
for each system option is listed in Table 6 on page 152.

Note: Memory upgrades are not supported on A078611 CP PII Call 
Processor cards. 

Table 6
Release 25.0x memory requirements 

Minimum memory requirement

System type
Flash 
memory 
requirement

DRAM 
memory 
requirement

Total memory 
requirement

Options 51C,61C 32 MB 48 MB 80 MB

Options 81,81C

• Options 81/81C systems 
operating on Call Processor 
68060 or 68060E with 5 or fewer 
network groups (including Fiber 
Network Fabric systems)

• any Option 81/81C system 
operating on Call Processor 
68040

32 MB 64 MB 96 MB

Options 81,81C

• Options 81/81C systems 
operating on Call Processor 
68060 or 68060E with 6 or more 
network groups

32 MB 80 MB 112 MB
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Increasing memory on NT9D19, NT5D10 CP and
NT5D03 CP cards

DRAM SIMM memory upgrades are supported on NT5D03, NT5D10, and 
NT9D19 CP cards. Flash Memory upgrades are supported on NT5D03 and 
NT5D10 CP cards.

Memory upgrades consist of installing memory SIMMs on your existing 
NT9D19 or NT5D10 or NT5D03 CP card, or installing new, complete CP 
card(s) depending on memory requirements. Flash memory upgrades consist 
of installation new Flash modules on your existing NT5D10 or NT5D03 CP 
card.

Several system upgrades to Option 51C, 61C, 81, and 81C include procedures 
to upgrade CP card memory. If you are upgrading to one of these systems, do 
not use the procedures in this document; instead, locate the upgrade 
procedure that applies to your system (see Hardware Upgrade Procedures 
(553-3001-258) and use the memory upgrade procedure contained therein. 

CAUTION
Damage to Equipment

Nortel Networks recommends that only properly 
trained distributor personnel perform this memory 
SIMM upgrade. Upgrade memory on NT9D19, 
NT5D10, or NT5D03 CP cards involves some risk of 
damage to SIMMs and CP cards; personnel 
performing this upgrade do so at their own risk. 

CAUTION
Service Interruption

Personnel should have spare CP cards on hand or 
risk installation delay or system down time. Nortel 
Networks assumes no responsibility for any damage 
incurred, installation delays due to board damage, or 
loss due to damage or system down time.
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Determine your Call Processor memory configuration
Before upgrading the Call Processor memory, determine the existing flash 
and DRAM SIMM configuration. This is accomplished through visual 
inspection (product labeling) or through Overlay 22.

Use the following procedure to determine your Call Processor memory 
configuration.

1 Log into your Meridian 1 system.

2 Load Overlay 22:

LD 22
PRT
CEQU

3 The example below shows the output for a 128 MB configuration:.

where:

• MCFN represents the call processor memory configuration

• S1 Slot 1 is the DRAM SIMM connector at position X5

• S2 Slot 2 is the DRAM SIMM connector at position X6

• S3 Slot 3is the DRAM SIMM connector at position X7

• S4 Slot 4 is the DRAM SIMM connector at position X8

• B0 Bank 0 represents the DRAM memory at logical
Bank 0

• B1 Bank 1 represents the DRAM memory at logical
Bank 1

• FLSHis the total amount of Flash memory populated on the
Call Processor board

• TOTL is the total Flash and DRAM memory populated on
the Call Processor board

To determine the amount of DRAM memory in a particular slot, add the
Bank 0 and Bank 1 values for that slot number.

MCF
N

S1B0 S1B1 S2B0 S2B1 S2B0 S3B1 S3B0 S3B1 FLSH TOT
L

016 000 016 000 016 016 000 000 64 128
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In the example in Procedure 3 on page 154, the DRAM and Flash
configuration is:

• X5 (DRAM memory) = 16 MB - the value 16 in S1Bo plus the
value in 0 S1B1

• X6 (DRAM memory) = 16 MB - the value 16 in S2B0 plus the
value 0 in S2B1

• X7 (DRAM memory) = 32 MB - the value 16 in S3B0 plus the
value 16 in S3B1

• X8 (DRAM memory) = (empty slot) - the value 0 in S4B0 plus
the value 0 in S4B1

• Flash Memory is 64 MB - the value 64 in FLSH

• Total Memory on the Call Processor card is 128 MB - the
addition of all Flash and DRAM memory

When you determine the Call Processor memory configuration, proceed with 
the memory upgrade.

NT5D03, NT5D10, NT9D19 CP cards
Use the procedures in this section to complete the upgrade, or refer to “Install 
the DRAM SIMMs” on page 159 and  “Install the Flash memory” on 
page 162 for detailed upgrade instructions. 

Table 7 on page 156 defines the memory upgrade paths for the following 
Motorola-based Call Processor cards:

• 68060E

• 68040

• 68030

To perform a DRAM and/or Flash upgrade:

• Locate your existing processor vintage in Table 7 on page 156.

• Locate the target processor vintage in Table 7 on page 156.

• Compare the existing SIMM configuration with the target configuration.

• Determine what SIMMs must be added or deleted from the existing 
location.
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• Add or delete DRAM SIMMs as required to achieve the target memory 
configuration (see Figure 1 on page 158 for the DRAM and Flash SIMM 
slot locations).

• Install the Flash memory modules in an available Flash connector.

• Install the label and label inserts. Discard all unused labels.

The upgrade is complete. 

Table 7
Supported memory upgrade configurations

Total 
Memory

Total 
FLASH

Total 
DRAM

Call Processor
Slot 

0
Slot 

1
Slot 

2
Slot 

3

68040** 68060 68060E X5 X6 X7 X8

48 32 16 NT9D19AA
NT9D19AB

NT5D10AA NT5D03AA 16 0 0 0

64 32 32 NT9D19CA
NT9D19CB

NT5D10CA NT5D03BA 16 16 0 0

32 0 0 0

80 32 48 NT9D19EA
NT9D19EB

NT5D10EA NT5D03CA 16 16 16 0

16 32 0 0

96 32 64 NT9D19TA
NT9D19TB

NT5D10TA NT5D03TA 16 16 16 16

16 16 32 0

32 32 0 0

112* 32 80 NT9D19UA
NT9D19UB

NT5D10UA NT5D03UA 16 16 16 32

16 32 32 0

128* 32 96 NT9D19VA
NT9D19VB

NT5D10VA NT5D03VA 16 16 32 32

* This configuration requires Release 24 or later.

** The 68040 CP card is available in A and B vintages. When labeling the CP card, use the appropriate 
vintage suffix. 
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32 32 32 0

96 64 32 NT9D19HA
NT9D19HB

N/A N/A 16 16 0 0

32 0 0 0

112 64 48 NT9D19JA
NT9D19JB

NT5D10JA NT5D03EA 16 16 16 0

16 32 0 0

128 64 64 N/A N/A NT5D03FA 16 16 16 16

128 64 64 NT9D19FA
NT9D19FB

NT5D10FB NT5D03FB 16 16 16 16

16 16 32 0

32 32 0 0

144* 64 80 NT9D19NA
NT9D19NB

NT5D10NA NT5D03NA 16 16 16 32

16 32 32 0

160* 64 96 NT9D19PA
NT9D19PB

NT5D10PB NT5D03PB 16 16 32 32

32 32 32 0

Table 7
Supported memory upgrade configurations

Total 
Memory

Total 
FLASH

Total 
DRAM

Call Processor
Slot 

0
Slot 

1
Slot 

2
Slot 

3

68040** 68060 68060E X5 X6 X7 X8

* This configuration requires Release 24 or later.

** The 68040 CP card is available in A and B vintages. When labeling the CP card, use the appropriate 
vintage suffix. 
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Figure 1
NT9D19, NT5D10 or NT5D03 DRAM and Flash location

553-7622
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FLASH SIMMs

DRAM SIMMs

Notch location

X7 X8
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Install the DRAM SIMMs

1 Place the CP card SIMM-side up on the antistatic mat.

2 Locate the DRAM SIMM connectors (see Figure 1 on page 158).

3 Determine if your memory upgrade requires you to remove an existing
DRAM SIMM (see.) If removal is required, remove the SIMM from the
highest numbered slot available first (X8, X7, X6, etc.) To remove the
DRAM SIMM:

a. Use a nonconducting screw driver to carefully move each latch
away first from one end of the SIMM, and then the other end. The
SIMM pivots away from the others until it is at approximately a 50-
to 70-degree angle to the board (see Figure 1 on page 158).

b. If the SIMM does not release from the latches, use your
thumbnails, one on each latch, to release the latches. If the board
has plastic latches, the latches are located on the side facing the
card faceplate. If the board has metal latches, the levers protrude
from each latch. Carefully move the latches outward
simultaneously until the SIMM pivots away from the others and is
at approximately a 50- to 70-degree angle to the board (see
Figure 1 on page 158).

4 Working from left to right, install the 32 MB SIMM(s) in the SIMM
location designated X5, X6, X7 or X8 where appropriate:

a. Orient the new SIMM so that the notch at one end of the SIMM
aligns with the key at one end of the SIMM socket. Hold the SIMM
at approximately a 50- to 70-degree angle and gently insert the
SIMM into the socket. See Figure 2 on page 161.

CAUTION
System Failure

Do not mix-up the 32 MB DRAM SIMM with the 16
MB DRAM SIMM. The 16 MB DRAM SIMM is
labeled A0662646 or A0614334; the 32 MB DRAM
SIMM is labeled A0634230. Older 16 MB DRAM
SIMMs may not be labeled.
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5 Using your thumbs and index fingers only (at the upper corners of the
SIMM), carefully lean the SIMM toward the others until it is upright and
the latch at each end of the SIMM snaps into place. If necessary, use
a nonconducting screwdriver to help open each latch while you move
the SIMM into the upright position.Apply the generic label over the
existing label.

6 Select the correct labels for your CP card from the sheet provided.

7 Place the CP/memory configuration label at the top of the faceplate.

8 Place the engineering code/release level label on the bottom of the
faceplate.

9 Discard unused labels.
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Figure 2
NT9D19, NT5D10, NT5D03 card DRAM SIMM installation

553-8492
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Install the Flash memory

1 Place the CP card SIMM-side up on the antistatic mat.

2 Determine the location of the new Flash SIMM connectors.

3 Install the new 32 MB Flash SIMM module in the appropriate slot:

a. Orient the new SIMM so that the notches on the bottom of the
SIMM align with the notches on the connector.

b. Gently guide the Flash SIMM toward the connector socket.

c. When the Flash SIMM makes contact with the connector, apply
pressure to one end of the Flash SIMM and close the latch
connector.

d. Apply pressure to the other end of the Flash SIMM and close the
latch connector.

4 Apply the generic label over the existing label.

5 Select the correct labels for your CP card from the sheet provided.

6 Place the CP/memory configuration label at the top of the faceplate.

7 Place the engineering code/release level label on the bottom of the
faceplate.

8 Discard unused labels.

9 Update the Flash ROM using the Software Install Tool:

Note: For dual CPU systems, verify that the system is operating in
split mode before activating the Software Install Tool.

a. To activate the Software Install Tool, insert the Install disk into the
inactive the IODU/C (or IOP/CMDU). Press the MAN RST button
on the Call Processor card in the inactive Core.

b. From the Main Menu, select <G>, to update the Flash ROMs from
the hard disk.

CAUTION
System Failure

Do not remove the existing Flash SIMMS from the
Call Processor board.
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c. Select <Y> to confirm installation.

d. Press <CR> to return to the Install Menu.

e. Upon successful installation of software on the Flash ROMs,
select <E> to update the CP-BOOT ROM.

f. Repeat this procedure for the second Core.

The Flash memory upgrade is complete.

Installing new NT9D19, NT5D10 or NT5D03 
CP cards on systems

The following procedures describe how to increase the CP card memory by 
installing a new CP card with higher memory capacity. It can be used to 
replace and upgrade the following CP cards:

• 80 MB NT9D19EA card with a new 96 MB NT9D19CA card

• 80 MB NT5D10CA card with a new 112 MB NT5D10DA card

• 80 MB NT5D03DA card with a new 128 MB NT5D03EA card

Before starting the procedure, make a backup copy of the customer database 
using the data dump routine:

1 Log into the system.

2 Load the Equipment Data Dump Program (LD 43). At the prompt, enter

3 When “EDD000” appears on the terminal, enter

LD 43 to load the program

EDD to begin the data dump
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4 When “DATABASE BACKUP COMPLETE” or “DATADUMP 
COMPLETE” appears on the terminal, enter

5 Check total memory allocation before the upgrade.

When the header for overlay 10 is displayed, note the value associated 
with Total Memory. After the upgrade, compare Total Memory before 
and after the upgrade. Total Memory should be greater after the 
upgrade.

Exit the program:

Split the cores

1 To access the Core during the replacement procedure, connect a 
terminal to the system. The CP card you are replacing must be in the 
inactive Core. Check the status of the NT5D10 or NT5D03 Call 
Processor card:

2 Set the NORM/MAINT switch on the NT5D10 or NT5D03 Call 
Processor card to MAINT on the active Core.

3 Set the ENB/DIS switch on all CNI cards on the inactive Core to DIS.

CAUTION
Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support organization. A data 
dump problem must be corrected before proceeding.

**** to exit the program

LD 10 to load the program

**** to exit the program

LD 135
STAT CPU determine which CP card is active

If necessary, switch Cores:

SCPU switch Cores

**** exit LD 135
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4 Perform the following three steps on the inactive Core in an 
uninterrupted sequence:

• Press and hold down the MAN RST button on the CP card on 
the inactive Core.

• Set the NORM/MAINT switch to MAINT.

• Release the MAN RST button.

The system is now in split mode where each Core is functioning independently 
and the automatic switchover has been disabled.

Installing equipment

1 Set the NORM/MAINT switch to MAINT on the replacement card.

2 Insert the CP Install Program diskette which corresponds with the 
NT5D10 or NT5D03 Call Processor (68060 or 68060E).

3 Remove the current CP card and put it in a static bag and box.

4 Insert the CP replacement card into its vacated slot and hook the 
locking devices.

5 Press the MAN RST button on the replacement CP card.

6 When the NT Logo Screen appears on the terminal, press <CR>.

7 Press <CR> to continue.

8 Log into the system and enter the time and date, when prompted.

9 Initiate the database installation by selecting the following command 
from the menu:

10 Remove the CP Install Program diskette and insert the Keycode 
diskette, when prompted.

11 When the Install Menu appears, select the following options in 

sequence:

<u> to Install menu

<a> to continue with keycode validation

<y> to confirm that the keycode matches the CD-ROM release

<g> to reinstall CP software

<y> to start installation
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12 When the Install Menu appears, select the following options in 
sequence

13 A Status Summary is displayed indicating what was installed. Press 
<CR> to return to the Install Menu.

14 Remove the diskette from the IODU/C.

15 Select the following options to quit the Install Tool:

Note: The system will reboot. Wait for the “INI” and “DONE” 
messages to display before continuing. It will take at least 70 seconds 
between the “DONE” and “INI” messages.

After the system initialization has finished (INI messages are no longer 
displayed on the system terminal), check for dial tone on a telephone set.

16 Following a successful dial tone test, perform the following basic sanity 
tests:

• Make sure calls can be placed

• Check for error messages, line noise, chatter, or other 
problems. Track sources and resolve problems as necessary.

To place the system back in the redundant (normal) mode with automatic 
switchover capability. Perform the following five steps in uninterrupted 
sequence on the inactive Core (the Core with the replaced CP card):

17 Press and hold down the MAN RST button on the CP card of the 
inactive Core.

18 While holding down the MAN RST button, set the NORM/MAINT 
switch on the same CP card to NORM.

19 Enable all CNI switches in the inactive Core.

<a> to continue ROM upgrade

<cr> to return to the Install Menu

<e> to install CP-BOOTROM

<y> to start installation

<a> to continue with the upgrade

<q> to quit

<y> to confirm quit

<a> to reboot the system.
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20 Release the MAN RST button.

21 Set the CP card in the active Core to NORM.

After several minutes, an “HWI533” message is issued by the active Core 
indicating that the inactive Core memory is being synchronized with the active 
Core memory.

22 Log into the system through the terminal, then check the status of the 
replacement CP card from the active side:

23 If there are CCED messages generated by the STAT CPU command 
on the replacement CP card, set the NORM/MAINT switch to MAINT, 
press the reload (MAN RST) button and set the NORM/MAINT switch 
back to NORM. (It may take 2 to 4 minutes for memory synchronization 
to take place.)

After the HWI0533 message is displayed, test the replacement CP 
card from the active CPU:

24 Set the NORM/MAINT switch to NORM on the active CP card (if not 
already set).

25 Check the status of the CPUs: 

STAT CPU

26 Test the CPU.

TEST CPU

27 Check the status of the CNIs:

STAT CNI

LD 135 load LD 135

STAT CPU obtain the CPU status

TEST CPU the test causes a cold start on the inactive CPU

If the test results in:

CCED014 “Test failed because unable to enter SPLIT 
mode”

On the active CP card set the NORM/MAINT switch to NORM, and 
from the active side enter:

TEST CPU to test the CP card
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28 Switch Cores and exit the program:

Note: If, using the non-conductive screw driver, the SIMM does not 
release from the latches, use your thumbnails, one on each latch, to 
release the latches: for plastic latches, the latches are located on the 
ends of each SIMM; for metal latches, levers protrude from each latch. 
Carefully move the latches outward simultaneously until the SIMM 
pivots away from the others and it is at approximately a 50- to 
70-degree angle to the board.

SCPU
**** exit LD 135
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188
Using the Distributor Keycode 
Application 
Contents

The following are the topics in this section:

Hardware and Software Requirements . . . . . . . . . . . . . . . . . . . . . . . . . 170

Installing DKA . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
Creating a Shortcut . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174

Adding the KDS network client in Dial-up Networking . .. . . . . . . . . . 175
Configure the Type of Dial-Up Server . . . . . . . . . . . . . . . . . . . . . . . 177

Downloading from KDS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
Establish the PPP connection to the KDS server via 
Dial-up Networking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179

Reading from a File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185

Manually entering a keycode . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186

The Distributor Keycode Application (DKA) is a Windows 95  based utility 
program which enables distributors to download keycodes from a remote 
server (known as Keycode Delivery Server (KDS). DKA makes use of a 
standard Wizard Windows 95 interface to guide the user’s operation.

Note: Electronic retrieval of keycodes via DKA is not supported in 
European markets. If you are downloading keycodes from Europe, 
please refer to “Using the Keycode Retrieval Utility” on page 189.

This section contains the following procedures:

• “Installing DKA” on page 170
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• “Adding the KDS network client in Dial-up Networking” on page 175

• “Downloading from KDS” on page 178

• “Reading from a File” on page 185

• “Manually entering a keycode” on page 186

Note: The “Installing DKA” and “Adding the KDS connection in 
Dial-Up Networking ” procedures must be completed before the 
"Downloading from KDS" procedure can be performed.

Hardware and Software Requirements
To install and use the DKA program, certain requirements must be met:

• You must have an PC or compatible computer with a Pentium or 
compatible Intel processor running the Windows 95 or Windows 95B 
operating system.

• A modem that supports 14.4kbps or less must be installed and configured 
on your PC. To ensure that a modem is configured correctly under 
Windows 95, you must configure a modem through the Control Panel 
(using 8 data bits, Parity None, Stop Bits 1). Additionally, the modem 
must be configured with the correct Dial Prefix (Access Code) used by 
your telephone system to access an outside line. This modem must access 
a standard analog telephone line.

• Approximately 5 MB free hard drive space for installation of the DKA 
program and, if desired, storage of keycodes.

• Microsoft Dial-up Networking software must be installed on the PC 
(provided with Windows 95)

• The following procedures must be performed before downloading 
keycodes: “Installing DKA.” and “Adding the KDS connection in 
Dial-Up Networking .”

Installing DKA
Once you have checked that your PC and modem meet the system 
requirements listed above, you are ready to install the DKA program onto 
your PC. Once the program is installed, you will make a Shortcut to the 
program. This Shortcut will appear on your Windows 95 desktop. 
Double-clicking this Shortcut will give you easy access to the program.
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The DKA program is installed as follows:

1 Locate the DKA Installation diskette.

2 Insert the diskette, label facing upwards, into the floppy drive on your 
PC.

3 Run the Windows Explorer  application by clicking and dragging the 
Start button on the lower left corner of the screen. Drag the Start 
button to Program Files then Windows Explorer.

4 In the Windows Explorer application, click the 3.5” Floppy drive (A:) 
from the left side of the window.

5 In the right side of the window, double-click the Setup.exe file (which 
has a computer icon to the left of it).

Wait for the Setup program to prepare for installation.

The Identification Screen is displayed.

6 Enter the requested information in the Name and Company fields.
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7 Click Next or press return.

The Software License screen is displayed. This screen contains a 
scrollable text box that contains the legal agreement governing the use 
of the DKA software.

8 If you accept the terms of the license agreement, click the Next button. 
If you do not accept, click Cancel and the program installation will be 
stopped.

The Destination Directory screen appears. This screen indicates that 
the DKA program will be installed on the hard drive in a folder called 
DKA.

9 Click Next or press return.

The Read Note screen appears. This screen is used to read any Read 
me files for the DKA program. 
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10 Read the contents of the Read Me files: Select file, then click 
Open.Click Next or press return.
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The Install Completed screen appears. This screen indicates that the 
Distributor Keycode Application has been successfully installed on 
your PC.

11 Click the Finish button to close the setup program. 

Creating a Shortcut
To make the Distributor Keycode Application easier to access, create a 
Shortcut by doing the following:

1 Select the dka.exe file located in the DKA folder on the (C:) drive.

2 Click on the File menu and drag down to Create Shortcut.

A file called Shortcut to dka.exe appears in the DKA folder.

3 Click and drag the Shortcut to dka.exe file to a convenient location on 
your desktop and release.

Now the Distributor Keycode Application may be accessed easily by 
double-clicking on the Shortcut to dka.exe file on the desktop.
553-2001-320 Standard 23.00 January 2002



 Using the Distributor Keycode Application Page 175 of 304
Adding the KDS network client in Dial-up Networking
Before you can download keycodes, you must configure the Dial-up 
Networking KDS client, as described below. Dial-up Networking stores and 
manages all communication parameters (phone number, dial prefixes, user 
name, password, etc.) necessary for connecting to the Keycode Download 
Server.

1 Click the Start button on the lower left corner of the PC desktop and 
drag to Programs|Accessories|Dial-up Networking.

2 Double-click the Make a New Connection icon in the Dial-Up 
Networking window and enter the following:

Type a name for the computer you are dialing: 
Richardson KCD Server 1 (example)

Select a modem:
The modem must support 14.4kbps or less with the following 
configuration: Data Bits 8, Parity None, Stop Bits 1 
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3 Click Next and enter the following for regions where the 888 Area 
Code is available:

Enter the Area Code as follows: 888 

Telephone Number: 685-3923

Country code: United States of America

Note 1: The information entered in the Make New Connection window 
must match this information. If you using DKA in a market other than 
the United States of America, ensure that the Area Code, Telephone 
Number, Dial Prefix, and Country code are configured correctly.

Note 2: In regions where the 888 Area Code is not applicable, the 
number which must be substituted is: (972) 685-1764. This number 
must be configured in Dial-Up Networking.

4 Click Next.

You will receive a message that you have successfully created a new 
Dial-Up Networking connection. Click Finish or press return to 
complete the procedure.
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Configure the Type of Dial-Up Server

1 Click the Start button on the lower left corner of the PC desktop and 
drag to Programs|Accessories|Dial-up Networking.

2 Click on Richardson KCD Server 1.

3 Select the File menu and choose Properties.

4 Click Server Type... to continue.

5 Configure the Server Type window with the following information:

Type of Dial-Up Server: PPP Windows 95 Windows NT 3.5 Internet

Advanced’s: Enable software compression

Advanced network protocols: TCP/IP 

TCP/IP Settings....: use the default settings

6 Click OK or press return.

7 Click OK again to return to the Dial-Up Networking window.
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Downloading from KDS
The following procedure is used to request and receive keycodes from a 
remote server, known as KDS (Keycode Delivery Server). This procedure 
assumes that you have already installed the DKA program as described in 
“Installing DKA” on page 170, and have added and configured the Dial-up 
Networking client as described in “Adding the KDS network client in Dial-up 
Networking” on page 175.
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Establish the PPP connection to the KDS server via 
Dial-up Networking

1 Double click on the Richardson KCD Server 1 Dial-Up Networking 
client. Enter user name “nortel-keycode” and password “97enable.” 
Click the Connect button and verify that the modem dials a call and the 
Dial-Up Networking client successfully connects to the Richardson 
KCD Server 1.

Once the Dial-up Networking PPP connection has been established, 
continue with the download by starting the DKA application:

2 Double-click on the Shortcut to DKA icon on the PC desktop.

A gray screen appears that includes four menus and a Toolbar with 
buttons for essential commands.

 
 

ManualPrint Help About
Entry DKA

Download
Keycodes

Open
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3 Click on the Tools menu and select Download Keycodes.

The KDS Welcome screen appears.

4 Click Next or return to download a keycode from KDS.

The Build a Request List screen is displayed. This screen has four 
information fields which must be completed for each keycode request 
that is submitted.
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5 Enter the information into the four fields as described in Table 8 on 
page 181.

6 Click Add to continue. The request will appear in the Request List 
scroll box.

When a request is added to the list, another request may be added by 
filling out the fields with information for another keycode, and again 
clicking the Add button.

To remove a request from the list, select the request in the Request 
List scroll box and click the Delete button.

7 Click the Next or press return.

The KDS Billing Notice screen is displayed

Table 8
“Build a Request List” fields

Name of field How the information is entered in the field

Product Name Select the product family of the system for which you are requesting a 
keycode.

System ID Enter the System ID for the system for which you are requesting a 
keycode.

NTI Number Click in the field and type in the NTI Number for the system for which 
you are requesting a keycode (the NTI Number is the same as the NT 
order number).

File Name Enter a file name for the keycode you will be downloading.

If the keycode will be downloaded to the hard drive ((C:) drive), use 
the following file naming convention: c:\DKA\<System ID>\NTI 
Number>. When you click Add, a.kcd file extension is added to the file 
name.

If the keycode will be downloaded to a floppy diskette in the 3.5" 
Floppy drive (A:), the file name must be named “keycode” so the 
Meridian 1 can recognize the file. When you click Add, a.kcd file 
extension is added to the file name.
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8 Enter the information in Table 8 on page 181 into the KDS Billing 
Notice screen.

9 Click the Next button or press return.

10 Click Next or press return.

The KDS Download screen is displayed.

Note: The Dial-up Networking connection must have been 
established, as described in “Establish the PPP connection to the KDS 
server via Dial-up Networking” on page 179.

Table 9
Fields on the KDS Billing Notice screen

Name of field How the information is entered in the field

Distributor Name Enter the name of the Distributor who is requesting the keycode(s).

User Name Enter the name of the person requesting the keycode(s).

Telephone Number Enter the telephone number that can be used to contact the individual 
who is requesting the keycode(s). For example: (408) 555-1212.
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11 Click Start to begin downloading the keycode(s).

Note: This starts the keycode download process. A socket connection 
is established over the existing PPP connection. Next, the provided 
login information is sent to the Keycode Delivery Server and verified. 
Then the requested keycodes are downloaded to your PC in the 
location you specified in the Build a Request List window. Status is 
displayed in the Download Status box.
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12 Click Next to receive the “KDS Download Results” screen, 
summarizing the results of the download.

13 Double-click the network icon in the lower right corner of the screen.

14 The Dial-up Networking status window appears. Click the Disconnect 
button to end the connection to the network.

The “Download from KDS” procedure is complete. Refer to “Keycode 
Management, LD 143” in this document for keycode installation 
instructions.

If there was a problem downloading keycodes, the problem keycodes 
are listed in the “Unsuccessfully downloaded keycodes” scroll box. 

Note: If the download was unsuccessful, verify that the correct 
telephone number and Dial Prefix are configured in Dial-up 
Networking.
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When the requested keycode is downloaded from the Keycode Delivery 
System to your PC, refer to “Adding features and ISM limits” on page 53 for 
keycode installation procedures.

Reading from a File
The following procedure is used to learn information about the properties of an 
existing keycode, or a keycode that was just downloaded from KDS. In this 
procedure you will specify a keycode file in a location on your hard drive or on 
a floppy diskette that is inserted in your floppy disk drive.

You will also specify a “Product type” to examine within the keycode file, in 
case there are multiple keycodes within the keycode file being examined.

This procedure assumes that you have already installed the DKA program as 
described in “Installing DKA” on page 170.

1 Double-click on the Shortcut to DKA icon on the PC desktop. 

2 Select Open from the File menu.

A navigation dialog box appears. In the navigation dialog box, locate 
the keycode. For a keycode residing on a floppy drive, this is the 3.5" 
Floppy drive (A:); for a keycode residing on the hard drive, this is most 
likely the C: drive.

3 Click OK.
Software Conversion Procedures



Page 186 of 304  Using the Distributor Keycode Application
The Keycode file is displayed in a format similar to the hardcopy Keycode 
Acknowledgment sent to a customer. The Keycode itself is displayed at the 
bottom of the file, in 21 rows of 16 characters each.

The “Reading from a File” procedure is complete.

Manually entering a keycode
The following procedure is used to manually enter a keycode for the purpose 
of creating and storing a keycode file. 

This procedure assumes that you have already installed the DKA program as 
described in “Installing DKA” on page 170.

1 Double-click on the Shortcut to DKA icon on the PC desktop.

2 Select Manual Entry from the Tools menu.
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The Keycode Entry screen is displayed. This screen consists of rows and four 
columns (A-D) into which the keycode is entered four characters at a time. 
When 16 characters (four cells) are entered in a row, the program tries to 
validate that row. If the row does not validate, a red X appears to the left of that 
row to indicate invalidity.

The Clear All... button is used to erase all characters in the cells that have 
been entered on the Keycode Entry screen. A dialog box will prompt “Are you 
sure you want to clear the Keycode characters?” when this button is selected. 
Confirming the dialog erases all characters in all cells.
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3 When the entire keycode has been entered, click the Save... button.

If the keycode is valid, the Save As screen is displayed. This screen 
allows you to specify the file name your keycode will be saved as and 
the directory where it will be saved. 

4 From the Save in pull-down menu, select the drive location where you 
want to save the keycode.

5 In the File Name field, type the name you want your keycode file to be 
saved as. Note that the.kcd extension will be appended to that 
filename.

To save the keycode file nested within folders, double-click on the 
folder in which the keycode file will ultimately be saved. When you 
have navigated to the folder where you would like to save the keycode 
file, click the Save button.

6 Click Save or press return.

The keycode file has been saved as specified. The “Manually Entering 
a Keycode” procedure is complete.
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198
Using the Keycode Retrieval Utility
Contents

The following are the topics in this section:

Applying for access . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189

Accessing Keycode Retrieval System application . .  . . . . . . . . . . . . . . 190
Meridian 1 Keycode Retrieval System . . . . . . . . . . . . . . . . . . . . . . . 195

The Keycode Retrieval Utility is a Nortel Networks Customer Support 
service feature available to registered customers. The Keycode Retrieval 
Utility provides a full suite of online tools, services, resources and interactive 
capabilities.

The Keycode Retrieval Utility provides a tool for distributors to browse and 
retrieve keycodes. A distributor is considered to "own" a keycode once it has 
been manufactured and its associated order invoiced.

If you do not have access to the Keycode Retrieval System (KRS) web site, 
you must apply (register) for access, and wait one to two business days for 
your account to be activated, before the "Downloading keycodes" procedure.

Applying for access
If you do not have access to the KRS web site, use the following procedure to 
register.

1 Start your web browser software.

2 Enter the URL "http://www.nortelnetworks.com" in the Address or 
Net Site bar and press Return or Enter.

3 Click on the Customer Support menu, then choose Register.
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4 Under the Products and Services banner, click on the “Register for 
Customer Support Products” bar.

5 Follow the Registration instructions provided.

Accessing Keycode Retrieval System application
Use the following procedure only after you have completed the Registration 
procedure and your User Name and Password are activated.

1 Start your web browser software.

2 Enter the URL "http://www.nortelnetworks.com" in the Address or 
Net Site bar and press Return or Enter.

3 Select Customer Support on the left side of the Nortel Networks home 
page.

Figure 3
Nortel Networks home page

4 Select Keycode Retrieval System.
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Figure 4
Customer Support
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5 In Step 1 on the Banner Page you can:

a. register for access to the KRS

b. if you have an account, select the login type

Note: See Figure 6 for a Step1 example.

6 Proceed to Step 2 and select the product family for the keycode 
access.

Note: See Figure 7 for a Step 2 example.

Figure 5
Banner page
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Figure 6
Step 1 pull-down menu
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Figure 7
Step 2 pull-down menu
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Meridian 1 Keycode Retrieval System

7 Use this link to access the keycode application for the Meridian product 
line.

Note: A registered user will have access to all keycode applications 
for the various product lines displayed.

Figure 8
Keycode Retrieval System
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Figure 9
View or Download Keycode
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The following is an explanation of the Quick Links on left of screen:

• Retrieve by Site. Allows the user to specify a site ID and retrieve all 
keycodes for products associated with the entered site ID.

• Retrieve by Product. Allows the user to view Site I.D.’s sorted by 
product type.

• Retrieve by Date. Allows the user to retrieve all historic (previously 
produced) keycodes for a particular site ID.

• Retrieve by Custom Set. Allows the user to retrieve previously 
"grouped" keycodes by a custome label created by the user.

• Edit Custom Set. Allows the user to edit (add or delete) the contents of a 
custom set of keycodes.

• Compare. Allows the user to compare two keycodes of the same product 
type.

• Terms and Conditions. Legal disclaimers

• Download KMT. Takes the user to a site where the latest version of the 
KMT can be downloaded to the users desktop to manage keycodes. This 
client side application is only necessary for viewing downloaded 
keycodes when not connected to the website.

• Support. Provides the phone numbers or email address for support.

• Related Links. Takes the user to additional Nortel Networks keycode 
related sites.

• Feedback. Pops up an email reply that will allow the user to provide 
comments and suggestions back to the business owners of the KRS web 
site.

• FAQ and What’s New.
Software Conversion Procedures



Page 198 of 304  Using the Keycode Retrieval Utility
Figure 10
Keycode Management Tool

The Keycode Management Tool (KMT) application is used to view and 
compare keycode files that you have downloaded from the KRS web site.
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200
Creating keycode diskettes
In addition to receiving a keycode diskette from Nortel Networks, a keycode 
diskette can be created onsite using the following methods:

• downloading a keycode from the Nortel Networks Keycode Distributor 
Server to a PC and creating a diskette (see “Using the Distributor 
Keycode Application” in this document for more information)

• entering a keycode manually using the commands in LD 143. Using this 
method, the keycode is entered as 21 lines of 16 characters. The keycode 
file is then saved to a 2 MB diskette in the floppy drive.

• entering a keycode manually in the Meridian 1 Software Installation 
Tool. Using this method, the keycode is entered as 21 lines of 16 
characters. The keycode file is then saved to a 2 MB diskette in the floppy 
drive.

• All keycode files must be named keycode with no extension.

When the keycode diskette is created, the keycode is entered into the system: 

• using the KNEW command in LD 143 or, 

• using the Software Installation Tool 

The keycode is activated on the next system sysload.
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250
Increasing A0810496, and NT4N64 
CP PII memory 
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Reference list
The following are references for this section:

• Hardware Replacement (553-3001-520)

Description
The latest release of system software is shipped with new Meridian 1 systems. 
Introduced with Release 25.40 is a Call Processor Pentium (CP PII) card with 
256 MB memory and a 256 MB Memory Upgrade Kit (NT4N19AA) for 
existing CP PII cards with 128 MB memory. Refer to Table 10 on page 202 
for Call Processor cards. 

Operating parameters
Option 81C CP PII systems with 6 or more network groups should upgrade 
their DRAM to 256 MB memory at the same time they upgrade to 
Release 25.40. Memory upgrades for existing systems consists of replacing 
the DIMM on the existing CP PII cards, or installing Release 02 CP PII cards 
with 256MB on board.

Mixed memory configurations are not supported.

Table 10
Call Processor cards

Call Processor Description

A0810496 Call Processor with 128MB

NT4N64AA Rel 01 Call Processor (A0810496) upgraded from 128MB to 256MB with the 
CP PII Memory Upgrade Kit (NT4N19AA) and faceplate label.

NT4N64AA Rel 02
(A0844698)

Call Processor with 256MB 
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Option 81C systems configured with the NT4N64AA Rel 01 or NT4N64AA 
Rel 02 call processor cards require a minimum of Release 25.40 software.

Upgrading for Release 25.40 or later software
System upgrades fall into one of the following categories:

• An Option 51C/61C/81/81C CP2/CP3/CP4 upgrade to an Option 81C 
CP PII system. This is a major hardware upgrade/replacement. With 
Release 25.40 software, the 256 MB memory Call Processor card 
(NT4N64AA Rel 02) is used. Refer to Hardware Replacement 
(553-3001-520)

• An Option 81C CP PII with 128 MB memory upgrade to Release 25.40 
software using the existing Call Processor card. This upgrade is not 
recommended for systems with six or more network groups.

• An Option 81C with 128 MB memory running Release 25.40 software 
upgrading to six or more network groups requires the NT4N64AA Rel 
02 Call Processor card or the NT4N19AA Memory Upgrade Kits.

• An Option 81C CP PII with six or more network groups upgrading to 
Release 25.40 or later software using the NT4N64AA Rel 02 Call 
Processor card or the NT4N19AA Memory Upgrade Kits.

Use the tasks in this section to complete a software and memory upgrade.

Perform simultaneous software and memory upgrade
Install software on both Core hard drives. Follow the tasks below in order to 
complete the installation.

Note: To complete these procedures, the system must be working in 
redundant mode and connected to a terminal. 

Back up current data
Before starting the upgrade check that:

• The system is operating in redundant mode. When the system is SPLIT, 
enter LD 135 and synchronize the memory and drives using the JOIN 
command.
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• A backup copy of the customer database made with the data dump 
routine exists on 2 MB diskettes. 

Procedure 1
Backup current data

1 Load the Equipment Data Dump Program (LD 43). At the prompt, enter

2 When “EDD000” appears on the terminal, enter

3 When “DATABASE BACKUP COMPLETE” appears on the terminal, 
enter

—————————— End of Procedure ——————————

CAUTION
Loss of Data

Keep a backup copy of the database external to the 
switch when completing software/hardware 
upgrades.

LD 43 Load the program.

EDD Begin the data dump.

CAUTION
Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support group. Correct any 
data dump problem before you continue.

**** Exit the program.
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Test system redundancy
Procedure 2
Test system redundancy

1 Test system redundancy. At the prompt enter:

2 Load LD 135 and check the status of the CPs, CNIs, and memory.

—————————— End of Procedure ——————————

Make Core 0 active

Either Core can be upgraded first. The decision to upgrade Core 1 first 
is for this example only.

Procedure 3
Make Core 0 active

1 If Core 1 is active, make Core 0 active. At the prompt enter:

—————————— End of Procedure ——————————

LD 137
STAT Get the status of the hard disks.

TEST RDUN Test redundancy

DATA RDUN Perform sector level checking on both hard disks

TEST CMDU Perform hard and floppy disk test.

LD 135
STAT CPU Get the status of both CPs and memory.

STAT CNI Get the status of all configured CNIs.

LD 135
STAT CPU Get the status of the CPUs.

SCPU Switch to Core 0.
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Split the Cores
Procedure 4
Split the cores

1 From the active side, split the cores. At the prompt enter:

The system is now in SPLIT mode.

—————————— End of Procedure ——————————

Upgrade Core 1
Procedure 5
Upgrade Core 1

1 Determine which of the following upgrades the system requires:

a Upgrade the software to Release 25.40 using the existing 
hardware. Continue with the “Install the software on Core/Net” on 
page 214.

b Upgrade the system with the 256 MB memory Call Processor card 
and Release 25.40 software. Go to step 2.

c Upgrade the software to Release 25.40 and replace the DIMM on 
the existing CP PII card. Go to step 3.

2 Remove the call processor card from Core 1 and replace with the 
NT4N64AA Rel 02 call processor card. Refer to Hardware Replacement 
(553-3001-520) for card replacement. Continue with the “Install the 
software on Core/Net” on page 214.

LD 135
SPLIT Enter Split on the active core.

**** Exit program.

CAUTION
Damage to Equipment

Nortel Networks recommends that only properly 
trained distributor personnel perform this memory 
DIMM upgrade. Upgrading memory on CP cards 
involves some risk of damage to DIMM and the CP 
card. Personnel performing this upgrade do so at 
their own risk.
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3 Remove the Call Processor card from Core 1 and replace the memory 
module with the NT4N19AA Memory Upgrade Kit. Follow the steps 
provided in “Memory upgrade” on page 207.

—————————— End of Procedure ——————————

Memory upgrade
Procedure 6
Upgrade memory

1 Remove all cables connected to the faceplate of the standby Call 
Processor card on Core 1.

2 Hot unplug the card and place with the DIMM side-up on a flat, clean 
surface.

3 Hold the latches of the DIMM socket. See Figure 11 on page 208.

CAUTION
Service Interruption

Personnel should have spare CP cards on hand or 
risk installation delay or system down time. Nortel 
Networks assumes no responsibility for any damage 
incurred, installation delays due to board damage, or 
loss due to damage or system down time.
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Figure 11
Latches

4 Press and rotate the latches from inside to outside carefully. See 
Figure 12 on page 209. 
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Figure 12
Rotate latches

5 Remove the 128 MB memory module.

6 Keep the latches open and insert the 256MB module into the DIMM 
socket. Align the two notches on the module with the two keys in the 
DIMM socket. See Figure 13 on page 210.
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Figure 13
Insert 256MB module

7 Hold the memory module as in Figure 14 on page 211.
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Figure 14
Hold memory module

8 Push the module into the DIMM socket until it is locked by the latches. 
See Figure 15 on page 212.
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Figure 15
Lock latches

9 Put the faceplate label on the faceplate of the card. See Figure 16 on 
page 213.
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Figure 16
Faceplate label

10 Return the card to its slot and reconnect all original cables.

Continue with the “Install the software on Core/Net” on page 214.

—————————— End of Procedure ——————————
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HDD PWR

CCOM 2

LLAN 2
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CP PII

553-A0093
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RLS 01
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Software Conversion Procedures



Page 214 of 304 Increasing A0810496, and NT4N64 CP PII memory
Install the software on Core/Net
Procedure 1
Install software on Core/Net 1

1 Install the CD-ROM into the CD-ROM drive in the cPCI MMDU:

a. Press the button on the CD-ROM drive to open the CD-ROM disk
holder.

b. Place the CD-ROM disk into the holder with the disk label facing
up. Use the four tabs to secure the CD-ROM disk.

c. Press the button to close the CD-ROM disk holder.
Do not push the holder in by hand.

Note: If the CD-ROM is not in the CD-ROM drive, the installation will 
not continue. Insert the CD-ROM to continue.

2 Place the CP PII Install floppy disk into the cPCI MMDU floppy drive.

3 Press the RESET button on the CP PII. Press <CR> when prompted. 
Before the install menu runs, the system validates hard disk 
partitioning. 

Note: If a problem is detected during the system verification, the 
installation stops, prints an error message, and aborts. If the 
verification is not successful, do not continue; contact your technical 
support organization.
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The screen displays:

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version 28)

===============================================================

**

****     **      ****

        ****   *****    **********

************************* Nortel Networks - Meridian 1

        ****     ****    **** Install Tool (Version 28)

****     ****    ****

        ****     *****************

        ****      ******  ******

Copyright 1992 - 2001 Nortel Networks

        Please press <CR> when ready ...

>OBTAIN and CHECK SYSTEM CONFIGURATION
>Validate hard disk partitions
Do physical checking for hard drive, it will take five to six 
minutes.
Testing partition 0
100 percent completed!
Testing partition 1
100 percent completed!
Testing partition 2
100 percent completed!
Disk physical checking is completed!
Validate hard drive partition number and size ...

There are 3 partitions in disk 0:
The size of partition 0 of disk 0 is xx MB
The size of partition 1 of disk 0 is xx MB
The size of partition 2 of disk 0 is xx MB
Disk partitions and sectors checking is completed!
dosFsCheck for PART_C OK!
dosFsCheck for PART_D OK!
dosFsCheck for PART_E OK!
DosFsCheck is completed!
>Copy /f0/disk3311.sys to /u/disk3311.sys - 

System Date and Time now is:

Friday 01-05-2001, 15:49:16
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4 Press <CR> on the terminal to start the software installation from the 

following menu.

5 Insert keycode diskette.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version 28)

====================================================================

M A I N    M E N U

The Software Installation Tool will install or upgrade 
Meridian-1 System Software, Database and the CP-BOOTROM.

You will be prompted throughout the installation and given the 
opportunity to quit at any time.

Please enter:

<CR> -> <u> - To Install menu
<t> - To Tools menu.
<q> - Quit

Enter Choice>

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version 28)
===============================================================

Please insert the diskette with the keycode file into the floppy 

drive.

Please enter:

<CR> -> <a> - Continue with the keycode validation
(the keycode diskette is in the floppy drive on 
Core 1).

<q> - Quit.

Enter Choice> 
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6 Confirm that the keycode matches the CD ROM release.

The provided keycode authorizes the install of Release 25xx 
software (all subissues) for machine type 3311 (CPP processor on 
Option 81C). 

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version 28)

=====================================================================

Please confirm that this keycode matches the CDROM Release 

Please enter:

<CR> -> <y> - Yes, the keycode matches. Go on to Install Menu. 
<n> - No, the keycode does not match. Try another 
keycode diskette.

Enter Choice>
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7 If the Keycode matches the CD ROM release, you are prompted to 

select an option from the following install menu.

Note: Press <CR> to select option <a>. The default database is not 
installed; instead, the existing customer database is left on disk, and 
then converted at the next sysload.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version 28)

=====================================================================

I N S T A L L M E N U

The Software Installation Tool will install or upgrade 
Meridian-1 System Software, Database and the CP-BOOTROM.
You will be prompted throughout  the installation and given the 
opportunity to quit at any time.

Please Enter:

<a> To install Software, CP-BOOTROM.

<b> To install Software, Database, CP-BOOTROM

<c> To install Database only.

<d> To install CP-BOOTROM only.

<t> To go to the Tools menu.

<k> To install Keycode only.
For feature Expansion, use OVL143.

<p> To install 3900 set Languages.

<q> Quit.

Enter Choice>
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8 Insert the CDROM is in the CDROM drive.

9 Confirm the software version.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version 28)

======================================================================

Please insert the installation CDROM into the drive on Core 1.

The labeled side of the CDROM should be side up in the CDROM 
tray.

Please enter:

<CR> -> <a> - CDROM is now in the drive. Continue with s/w 
checking.
<q> - Quit.

Enter Choice>

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version 28)
=============================================================== 

        The installation CDROM contains version Release 25xx__.

        Please enter:

<CR> -> <y> - Yes, this is the correct version. Continue.

        <n> - No, this is not the correct version. Try another 
CDROM or keycode disk.

        Enter Choice> 
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10 Review the Installation Status Summary

11 Confirm the Upgrade.

Pre-release 3 language groups

12 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version 28)

======================================================================

You selected to upgrade the system from release: 25xx to release: 
25xx.

This will erase all old system files.
Database files will NOT be erased. You may continue installing
the software or quit now and leave your system unchanged.

Please enter:

<CR> -> <y> - Continue with Upgrade.

<q> - Quit.

Enter Choice>

Please enter:
<CR> -> <Y> - Yes, start Installation.

<n> - No, stop Installation. Return to the Main Menu.

Enter Choice>

--------------------------------------------------------------
                 INSTALLATION STATUS SUMMARY
--------------------------------------------------------------
+=================+========+========+========================+
|    Option       | Choice | Status |     Comment            |
+=================+========+========+========================+
| SW: CD to disk  | yes    |        | Install for rel 25xx   |
+-----------------+--------+--------+------------------------+
| Database        | no     |        |                        |
+-----------------+--------+--------+------------------------+
| CP-BOOTROM      | yes    |        |                        |
+-----------------+--------+--------+------------------------+
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sets. 

The languages contained in each selection are outlined as follows: 

• 1 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Brazilian Portuguese, Finnish, Japanese 
Katakana. 

• * 2 - English, French, German, Spanish, Swedish, Norwegian, 
Danish, Finnish, Italian, Brazilian Portuguese. 

• * 3 - English, French, German, Dutch, Polish, Czech, 
Hungarian, Russian, Latvian, Turkish. 

• * 4 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

• * 5 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Portuguese, Finnish, Japanese Katakana. 

• * 6 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

Release 3 language groups

13 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)
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sets.

The languages contained in each selection are outlined as follows:

• 1 – Global 10 Languages (Release 3) English, French, 
German, Spanish, Swedish, Italian, Norwegian, Brazilian 
Portuguese, Finnish, Japanese Katakana.

• 2 – Western Europe 10 Languages (Release 3) English, 
French, German, Spanish, Swedish, Italian, Norwegian, 
Brazilian Portuguese, Finnish, Danish.

• 3 – Eastern Europe 10 Languages (Release 3) English, 
French, German, Dutch, Polish, Czech, Hungarian, Russian, 
Latvian, Turkish.

• 4 – North Americia six Languages (Release 3) English, French, 
German, Spanish, Brazilian Portuguese, Japanese Katakana.

• 5 – Spare Group A.

• 6 – Spare Group B.

14 Continue with the installation.

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version 28)

===============================================================

Software release 25xx was installed sucessfully on Core 1.

All files were copied from CDROM to the hard disk.

Please press <CR> when ready ...
553-2001-320 Standard 23.00 January 2002



Increasing A0810496, and NT4N64 CP PII memory Page 223 of 304
15 Perform the CP-BOOTROM installation.

16 Review the Status Summary.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version 28)

===============================================================

You will now perform the CP-BOOTROM installation.

Note: You will be overriding existing CP-BOOTROM on hard 
disk. If you quit, Bootrom will be left unchanged

Please enter:

<CR> -> <a> - Continue with CP-BOOTROM install.

<q> - Quit.

Enter Choice>

Please press <CR> when ready ...

--------------------------------------------------------------
                 INSTALLATION STATUS SUMMARY
--------------------------------------------------------------
+=================+========+========+========================+
|    Option       | Choice | Status |     Comment            |
+=================+========+========+========================+
| SW: CD to disk  | yes    | ok     | from 2530_ to 2540   |
+-----------------+--------+--------+------------------------+
| Database        | no     |        |                        |
+-----------------+--------+--------+------------------------+
| CP-BOOTROM      | yes    | ok     |                        |
+-----------------+--------+--------+------------------------+
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17 Enter “q” to leave the installation program.  

18 Enter “y” to confirm Quit.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version 28)
=====================================================================

I N S T A L L M E N U
The Software Installation Tool will install or upgrade 
Meridian-1 System Software, Database and the CP-BOOTROM.

You will be prompted throughout the installation and given the 
opportunity to quit at any time.
Please enter:
<a> To install Software, CP-BOOTROM.
<b> To install Software, Database, CP-BOOTROM
<c> To install Database only.
<d> To install CP-BOOTROM only.
<t> To go to the Tools menu.
<k> To install Keycode only.

For feature Expansion, use OVL143.
<p> To install 3900 set Languages.
<q> Quit.

Enter Choice>

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version 28)

=====================================================================

You selected to Quit. Please confirm.

Please enter:

<CR> -> <y> - Yes, Quit.

<n> - No, DO NOT Quit.

Enter Choice>
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19 Choose either Reboot or Return to the Main Menu

Note: Remove the Install diskette from the floppy drive(s) before 

rebooting.

20 The system automatically performs a sysload and several messages 
appear on the system terminal. Wait for “DONE” and then the “INI” 
message to display before you continue.

Database conversion occurs during sysload.

Verify that the following message appears on the system terminal:

21 Confirm that Release 25.xx software is installed and is working on 
Core/Net 1:

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version 28)

=====================================================================

You selected to Quit the Software Installation Tool.
You may reboot the system or return to the Main Menu.
Before rebooting the system, remove Install diskette from the 
floppy drive(s).

---------------------------------------------------------------

DO NOT REBOOT USING BUTTON!!

---------------------------------------------------------------

Please enter:

<CR> -> <a> - Reboot the system.

<m> - Return to the Main menu.

Enter Choice>

DATA CONVERSION

RELEASE 25.XX TO RELEASE 25.XX

LD 135 Load the program.

STAT CPU Display the CPU status.

STAT CNI Display the cCNI status.

STAT MEM Display memory status on CPUs.
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22 Check the software version.

Use LD 22 to print the software issue and release. At the prompt enter: 

—————————— End of Procedure ——————————

Transfer call processing from Core/Net 0 to Core/Net 1

Procedure 2
Transfer call processing

1 From Core/Net 0, the active side, transfer call processing to the 

upgraded Core/Net 1. At the prompt enter:

Call processing is now switched from Core/Net 0 to Core/Net 1.

2 Test Call Processing. This includes the following:

a Check for dial tone.

b Make internal, external, and network calls.

c Check attendant console activity.

d Check DID trunks.

e Check any auxiliary processors.

—————————— End of Procedure ——————————

LD 22
REQ ISS

**** Exit the program.

CAUTION
Service Interruption
The following procedure to transfer call processing 
causes service interruptions.
Time your procedure to minimize the effect of any 
breaks in service.

LD 135
CUTOVR Transfer call processing from active core to 

standby core. This will cause a service 
interruption.
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Upgrade Core/Net 0
Start at “Upgrade Core 1” on page 206 and repeat the procedures for 
Core/Net 0.

Continue with the following procedures after completing “Check the 
software version.” on page 226.

Enable system redundancy

Procedure 3
Transfer call processing

1 Transfer call processing from the active core 1 to the standby core 0. 

At the prompt enter:

Note: The CUTOVR command is necessary to ensure that the 
second upgraded core is capable of call processing.

2 Test Call Processing. This includes, but is not limited to the following:

a Check for dial tone.

b Make internal, external, and network calls.

c Check attendant console activity.

d Check DID trunks.

e Check any auxiliary processors.

CAUTION
Service Interruption
The following procedure to transfer call processing 
causes service interruptions.
Time your procedure to minimize the effect of any 
breaks in service.

LD 135
CUTOVR Transfer call processing from active core to 

standby core. This will cause a service 
interruption.
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Procedure 4
Enable system redundancy

1 From the active CPU, Core/Net 0, enable redundancy. At the prompt 

enter:

—————————— End of Procedure ——————————

Test Core/Net 1 and Core/Net 0
Procedure 5
Test both cores

From the active CPU, Core/Net 0, perform these tests:

1 Perform a redundancy sanity test using the following sequence. At the 
prompt enter:

2 Test system redundancy. At the prompt enter:

3 Switch to the inactive CPU. At the prompt enter:

LD 135
JOIN Synchronize the memory and drives.

LD 135
STAT CNI Get the status of the cCNI cards.

STAT CPU Get the status of the CPU and memory.

TEST CNI Test each cCNI card (core, slot).

STAT SUTL Get the status of the System Utility (main and 
transition) cards.

TEST SUTL Test the System Utility (main and transition) cards.

TEST IPB Test the Interprocessor Bus

TEST LCD Test the LCDs.

TEST LED Test the LEDs.

LD 137
STAT Get the status of the hard disks.

TEST RDUN Test redundancy

DATA RDUN Perform sector level checking on both hard disks

TEST CMDU Perform hard and floppy disk test.

LD 135
SCPU Switch to the inactive CPU, Core/Net 1
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4 Test Core/Net 1. At the prompt enter:

5 Clear the display and minor alarms on both Cores. At the prompt enter: 

6 If desired, switch back to Core/Net 0. At the prompt enter:

—————————— End of Procedure ——————————

LD 135
STAT CNI Get the status of cCNI (both main and transition) 

cards.

STAT CPU Get the status of both Cores and redundancy.

TEST CNI Test the cCNI (both main and transition) cards.

STAT SUTL Get the status of the System Utility card.

TEST SUTL Test System Utility card.

TEST IPB Test Interprocessor Bus.

TEST LCD Test LCDs.

TEST LED Test LEDs

CDSP Clear the displays on the Cores.

CMAJ Clear all major alarms.

CMIN ALL Clear all minor alarms.

**** Exit the program.

LD 135
SCPU Switch to the inactive CPU, Core/Net 0
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Perform a data dump
Procedure 6
Perform a data dump

1 At the prompt, enter

2 Insert a floppy disk into the cPCI MMDU to capture the backup.

3 When “EDD000” appears on the terminal, enter

4 When “DATABASE BACKUP COMPLETE” appears on the terminal, 
enter

The parallel reload procedure is complete.

—————————— End of Procedure ——————————

LD 43 Load the program

EDD Begin the data dump

CAUTION
Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support group. Correct any 
data dump problems before you continue.

**** Exit the program
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Back out of a system software and hardware upgrade
To back out of a CP PII system software and hardware upgrade the following 
tasks must be completed.

• Determine which core is active.

• Split the cores.

• Revert to the old memory configuration, if required.

• Install the original release of software. 

Perform the following procedures in order.

Make Core 0 active

Either Core can be downgraded first. The decision to downgrade Core 
1 first is for this example only.

Procedure 7
Make Core 0 active

1 If Core 1 is active, make Core 0 active. At the prompt enter:

Split the Cores
Procedure 8
Split the cores

1 From the active Core 0, split the cores. At the prompt enter:

The system is now in split mode.

—————————— End of Procedure ——————————

LD 135
STAT CPU Get the status of the CPUs.

SCPU Switch to Core 0.

LD 135 Load the program.
SPLIT Enter Split on the active core.
**** Exit the program.
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Install the software on Core/Net 1
Procedure 9
Install the original release of software

1 Install the CD-ROM into the CD-ROM drive in the cPCI MMDU:

a. Press the button on the CD-ROM drive to open the CD-ROM disk
holder.

b. Place the CD-ROM disk into the holder with the disk label facing
up. Use the four tabs to secure the CD-ROM drive.

c. Press the button again to close the CD-ROM disk holder.
Do not push the holder in by hand.

Note: If the CD-ROM is not in the CD-ROM drive, the installation will 
not continue. Insert the CD-ROM to continue.

2 Place the Install diskette with the original software release into the 
cPCI MMDU floppy drive.

3 Press the manual RESET button on the CP PII card faceplate. Before 
the install menu runs, the system validates hard disk partitioning which 
takes about five minutes. 

Note: If a problem is detected during the system verification, the 
installation stops, prints an error message, and aborts. 
If the verification is not successful, do not continue; contact your 
technical support group.

The screen displays:
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Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version xx)

===============================================================

**
***

****     **      ****
****   *****    **********
****  *******  ***********
************************** Nortel Networks - Meridian 1
***     ****    **** Install Tool (Version xx)
****     ****    ****
****     ****    ****
****     ****    ****
****     *****************
****      ******  ******
****       ***     ***

Copyright 1992 - 1999 Nortel Networks, Inc.
Please press <CR> when ready ...

>OBTAIN and CHECK SYSTEM CONFIGURATION
>Validate hard disk partitions
Do physical checking for hard drive, it will take five to six minutes.
Please wait ...
Testing partition 0
100 percent completed!
Testing partition 1
100 percent completed!
Testing partition 2
100 percent completed!
Disk physical checking is completed!
Validate hard drive partition number and size ...
There are 3 partitions in disk 0:
The size of partition 0 of disk 0 is xx MB
The size of partition 1 of disk 0 is xx MB
The size of partition 2 of disk 0 is xx MB
Disk partitions and sectors checking is completed!
dosFsCheck for PART_C OK!
dosFsCheck for PART_D OK!
dosFsCheck for PART_E OK!
DosFsCheck is completed!
>Copy /f0/disk3311.sys to /u/disk3311.sys - 

System Date and Time now is:

Friday 01-05-2001, 15:49:16
Software Conversion Procedures



Page 234 of 304 Increasing A0810496, and NT4N64 CP PII memory
4 Press <CR> on the terminal to start the software installation from the 

following menu. 

5 Insert keycode diskette.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version xx)

====================================================================

M A I N    M E N U

The Software Installation Tool will install or upgrade 
Meridian-1 System Software, Database and the CP-BOOTROM.

You will be prompted throughout the installation and given the 
opportunity to quit at any time.

Please enter:

<CR> -> <u> - To Install menu
<t> - To Tools menu.
<q> - Quit

Enter Choice>

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version xx)
=============================================================== 

Please insert the diskette with the keycode file into the floppy 
drive.

Please enter: 
<CR> -> <a> - Continue with the keycode validation

(the keycode diskette is in the floppy drive on Core 1). 
<q> - Quit.

Enter Choice
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6 Confirm that the keycode matches the CD ROM release.

The provided keycode authorizes the install of Release 25xx__ 
software for generic 3311 (CPP processor on Option 81C). 

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version xx)

=====================================================================

Please confirm that this keycode matches the CDROM Release

Please enter:

<CR> -> <y> - Yes, the keycode matches. Go on to Install Menu. 
<n> - No, the keycode does no match. Try another 
keycode diskette.

Enter Choice>
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7 When the screen displays the Install Menu, enter choice “b” to install 
the database.

Note: The database has to be reinstalled. A database cannot be 
converted down.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version xx)

=====================================================================

I N S T A L L M E N U

The Software Installation Tool will install or upgrade 
Meridian-1 System Software, Database and the CP-BOOTROM.
You will be prompted throughout the installation and given the 
opportunity to quit at any time.

Please enter:

<a> To install Software, CP-BOOTROM.

<b> To install Software, Database, CP-BOOTROM

<c> To install Database only.

<d> To install CP-BOOTROM only.

<t> To go to the Tools menu.

<k> To install Keycode only.
For feature Expansion, use OVL143.

<p> To install 3900 set Languages.

<q> Quit.

Enter Choice>
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8 Insert the CDROM into the CDROM drive.

9 Review the Installation Status Summary.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version xx)

======================================================================

Install utility will install Release 25xx s/w for software 
generic 3311 (CPP processor on Option 81C) on your system.
Please insert the installation CDROM into the drive on Core 1.

The labeled side of the CDROM should be side up in the CDROM 
tray.

Please enter:

<CR> -> <a> - CDROM is now in the drive.
Continue with installation.

<q> - Quit.

Enter Choice>

Please enter:
<CR> -> <Y> - Yes, start Installation.

<n> - No, stop Installation. Return to the Main Menu.

Enter Choice>

--------------------------------------------------------------
                 INSTALLATION STATUS SUMMARY
--------------------------------------------------------------
+=================+========+========+========================+
|    Option       | Choice | Status |     Comment            |
+=================+========+========+========================+
| SW: CD to disk  | yes    |        | Install for rel 25xx   |
+-----------------+--------+--------+------------------------+
| Database        | yes    |        |                        |
+-----------------+--------+--------+------------------------+
| CP-BOOTROM      | yes    |        |                        |
+-----------------+--------+--------+------------------------+
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10 Confirm the Upgrade.

Pre-release 3 language groups

11 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 
sets. 

The languages contained in each selection are outlined as follows: 

• 1 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Brazilian Portuguese, Finnish, Japanese 
Katakana. 

• * 2 - English, French, German, Spanish, Swedish, Norwegian, 
Danish, Finnish, Italian, Brazilian Portuguese. 

• * 3 - English, French, German, Dutch, Polish, Czech, 

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version xx)

======================================================================

You selected to upgrade the system from release: 25xx to release 
25xx.

This will erase all old system files.

Database files will not be erased. You may continue installing 
the software or quit now and leave your system unchanged.

Please enter:

<CR> -> <a> - Continue with Upgrade
<q> - Quit.

Enter Choice>

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)
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Hungarian, Russian, Latvian, Turkish. 

• * 4 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

• * 5 - English, French, German, Spanish, Swedish, Italian, 
Norwegian, Portuguese, Finnish, Japanese Katakana. 

• * 6 - English, Spanish, French, Brazilian Portuguese, Japanese 
Katakana, German. 

Release 3 language groups

12 Select a PSDL file to install. The PSDL file contains the loadware for 
all downloadable cards in the system and loadware for M3900 series 
sets.

The languages contained in each selection are outlined as follows:

• 1 – Global 10 Languages (Release 3) English, French, 
German, Spanish, Swedish, Italian, Norwegian, Brazilian 
Portuguese, Finnish, Japanese Katakana.

• 2 – Western Europe 10 Languages (Release 3) English, 
French, German, Spanish, Swedish, Italian, Norwegian, 
Brazilian Portuguese, Finnish, Danish.

• 3 – Eastern Europe 10 Languages (Release 3) English, 
French, German, Dutch, Polish, Czech, Hungarian, Russian, 
Latvian, Turkish.

• 4 – North Americia six Languages (Release 3) English, French, 
German, Spanish, Brazilian Portuguese, Japanese Katakana.

• 5 – Spare Group A.

• 6 – Spare Group B.

Select one of the six PSDL files
<1> Global 10 Languages

<2> Western Europe 10 Languages

<3> Eastern Europe 10 Languages

<4> North America 6 Languages

<5> Spare Group A

<6> North America 6 Languages (Duplicate of <4>)
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13 Continue with the installation.

14 Install the archived database from the backup diskette.

Note: Insert the archived database diskette into the floppy drive.

Select option “a” from the following menu.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version xx)

===============================================================

Software release 25xx was installed successfully on Core 1.

All files were copied from CDROM to the hard disk.

Please press <CR> when ready ...

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version xx)

===============================================================

You will now perform the database installation.

Note: If you are installing the Database from a floppy disk, 
please insert the correct disk now.

Please enter:

<CR> -> <a> Install CUSTOMER Database
(the customer database diskette must be in the 
core 1 disk drive)

<b> Install DEFAULT Database.

<c> Transfer the previous system Database.

<e> Check the Database that exists on the hard disk.

<q> Quit.

Enter Choice>
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15 Perform the CP-BOOTROM installation. 

16 Review the Installation Status Summary

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version xx)

===============================================================

You will now perform the CP-BOOTROM Installation.

Note: You will be overriding existing CP-BOOTROM on hard disk.

If you quit, BOOTROM will be left unchanged

Please enter:

<CR> -> <a> Continue with CP-BOOTROM install.

<q> Quit.

Enter Choice>

Please press <CR> when ready ...

--------------------------------------------------------------
                 INSTALLATION STATUS SUMMARY
--------------------------------------------------------------
+=================+========+========+========================+
|    Option       | Choice | Status |     Comment            |
+=================+========+========+========================+
| SW: CD to disk  | yes    | ok     | from 25xx to 25xx      |
+-----------------+--------+--------+------------------------+
| Database        | yes    | ok     | from 25xx to 25xx      |
+-----------------+--------+--------+------------------------+
| CP-BOOTROM      | yes    | ok     |                        |
+-----------------+--------+--------+------------------------+
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17 Enter “q” to leave the installation program.

18 Enter “y” to confirm Quit.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version xx)
=====================================================================

I N S T A L L M E N U
The Software Installation Tool will install or upgrade 
Meridian-1 System Software, Database and the CP-BOOTROM.

You will be prompted throughout the installation and given the 
opportunity to quit at any time.
Please enter:
<a> To install Software, CP-BOOTROM.
<b> To install Software, Database, CP-BOOTROM
<c> To install Database only.
<d> To install CP-BOOTROM only.
<t> To go to the Tools menu.
<k> To install Keycode only.

For feature Expansion, use OVL143.
<p> To install 3900 set Languages.
<q> Quit.

Enter Choice>

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version xx)

=====================================================================

You selected to Quit. Please confirm.

Please enter:

<CR> -> <y> - Yes, Quit.

<n> - No, DO NOT Quit.

Enter Choice>
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19 Choose either Reboot or Return to the Main Menu.

Note: Remove the database diskette from the disk drive before 

rebooting.

20 The system automatically performs a sysload and several messages 
appear on the system terminal. Wait for “DONE” and then the “INI” 
message to display before you continue.

Verify that the following message appears on the system terminal:

21 Confirm that Release 25.xx software is installed and working on 
Core/Net 1:

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool 
(Version xx)

=====================================================================

You selected to Quit the Software Installation Tool.
You may reboot the system or return to the Main Menu.
Before rebooting the system, remove Install diskette from the 
floppy drive(s).

---------------------------------------------------------------

DO NOT REBOOT USING BUTTON!!

---------------------------------------------------------------

Please enter:

<CR> -> <a> - Reboot the system.

<m> - Return to the Main menu.

Enter Choice>

DATA CONVERSION

RELEASE 25.xx TO RELEASE 25.xx

LD 135 Load the program.

STAT CPU Display the CPU status.

STAT CNI Display the cCNI status.
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22 Check the software version.

Use LD 22 to print the software issue and release. At the prompt enter: 

—————————— End of Procedure ——————————

Transfer call processing from Core/Net 0 to Core/Net 1

Procedure 10
Transfer call processing

1 From Core/Net 0, the active side, transfer call processing to 
Core/Net 1. At the prompt enter:

Call processing is now switched from Core/Net 0 to Core/Net 1.

—————————— End of Procedure ——————————

LD 22
REQ ISS

**** Exit the program.

CAUTION
Service Interruption
The following procedure to transfer call processing 
causes service interruptions.
Time your procedure to minimize the effect of any 
breaks in service.

LD 135 Load the program.

CUTOVR The inactive CP become active.
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Test Core/Net 1

Test Call Processing. This includes, but is not limited to the following:

1 Check for dial tone.

2 Make internal, external, and network calls.

3 Check attendant console activity.

4 Check DID trunks.

5 Check any auxiliary processors.

Install the software on Core/Net 0
Start at “Install the software on Core/Net 1” on page 232 and repeat the 
procedures for Core/Net 0.

Continue with the following after completing “Check the software version.” 
on page 244.

Enable system redundancy

Procedure 11
Transfer call processing

1 Transfer call processing from the active core 1 to the standby core 0. 

At the prompt enter:

Note: The CUTOVR command is necessary to ensure that the 
second upgraded core is capable of call processing.

CAUTION
Service Interruption
The following procedure to transfer call processing 
causes service interruptions.
Time your procedure to minimize the effect of any 
breaks in service.

LD 135
CUTOVR Transfer call processing from active core to 

standby core. This will cause a service 
interruption.
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2 Test Call Processing. This includes, but is not limited to the following:

a Check for dial tone.

b Make internal, external, and network calls.

c Check attendant console activity.

d Check DID trunks.

e Check any auxiliary processors.

Procedure 12
Enable system redundancy

1 From the active CPU, Core/Net 0, enable redundancy. At the prompt 

enter:

—————————— End of Procedure ——————————

LD 135
JOIN Synchronize the memory and drives.
553-2001-320 Standard 23.00 January 2002



Increasing A0810496, and NT4N64 CP PII memory Page 247 of 304
Test Core/Net 1 and Core/Net 0
Procedure 13
Test both cores

From the active CPU, Core/Net 0, perform these tests:

1 Perform a redundancy sanity test using the following sequence. At the 
prompt enter:

2 Test system redundancy. At the prompt enter:

3 Switch to the inactive CPU. At the prompt enter:

4 Test Core/Net 1. At the prompt enter:

LD 135
STAT CNI Get the status of the cCNI cards.

STAT CPU Get the status of the CPU and memory.

TEST CNI Test each cCNI card (core, slot).

STAT SUTL Get the status of the System Utility (main and 
transition) cards.

TEST SUTL Test the System Utility (main and transition) cards.

TEST IPB Test the Interprocessor Bus

TEST LCD Test the LCDs.

TEST LED Test the LEDs.

LD 137
STAT Get the status of the hard disks.

TEST RDUN Test redundancy

DATA RDUN Perform sector level checking on both hard disks

TEST CMDU Perform hard and floppy disk test.

LD 135
SCPU Switch to the inactive CPU, Core/Net 1

LD 135
STAT CNI Get the status of cCNI (both main and transition) 

cards.

STAT CPU Get the status of both Cores and redundancy.

TEST CNI Test the cCNI (both main and transition) cards.

STAT SUTL Get the status of the System Utility card.

TEST SUTL Test System Utility card.
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5 Clear the display and minor alarms on both Cores. At the prompt enter: 

6 If desired, switch back to Core/Net 0. At the prompt enter:

—————————— End of Procedure ——————————

TEST IPB Test Interprocessor Bus.

TEST LCD Test LCDs.

TEST LED Test LEDs

CDSP Clear the displays on the Cores.

CMAJ Clear all major alarms.

CMIN ALL Clear all minor alarms.

**** Exit the program.

LD 135
SCPU Switch to the inactive CPU, Core/Net 0
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Perform a data dump
Procedure 14
Perform a data dump

1 At the prompt, enter

2 Insert a floppy disk into the cPCI MMDU to capture the backup.

3 When “EDD000” appears on the terminal, enter

4 When “DATABASE BACKUP COMPLETE” appears on the terminal, 
enter

The software backout procedure is complete.

—————————— End of Procedure ——————————

LD 43 Load the program

EDD Begin the data dump

CAUTION
Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support group. Correct any 
data dump problems before you continue.

**** Exit the program
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258
Postconversion procedure

Contents
The following are the topics in this section:

Postconversion steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 252

This procedure verifies that the conversion process was successful, and 
system data converted completely. This is the last part of the total conversion 
procedure. Perform these steps after you have completed all other procedures 
for your system. 

The site data should be printed before and after conversion (see Table 11 on 
page 255). If the data has changed, make the necessary updates on the Target 
release, and datadump to the new system media. You must print out the items 
marked with an asterisk (*) to be sure everything converted properly. All 
other items on Table 11 on page 255 are provided if you want to print them.

Check the General Release Bulletin (GRB), and the Conversion notes (earlier 
in this document) to verify any database updates that need to be made as a 
result of conversion. Be sure to verify all SYSxxx messages that may appear 
during the conversion process. These messages may indicate some database 
updates are required.

CAUTION
Service Interruption

Test call processing thoroughly. This can include 
more testing than is described in this procedure, 
depending on system configuration. This procedure 
is intended to show some of the basic tests 
performed to complete the conversion process.
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Note: When parallel reload is complete, the attendant consoles will be 
in Night mode. If you are performing these procedures during the day, 
contact the attendant. If these procedures are taking place during the 
evening, you may not want to perform these call processing steps.

Postconversion steps
1 Print system data listed in Table 11, “Print site data,” on page 255. 

Verify that all information matches the printouts created before 
conversions. Make changes if necessary.

2 From any unrestricted telephone, dial the access code for an outside 
line (usually 9), and dial the listed Directory Number (DN) for the 
customer. Verify that the correct Incoming Call Indicator (ICI) lights at 
the attendant console.

3 If the customer is equipped with more than one console, transfer the 
call to another console.

4 Extend the call to a telephone, and release the call from the console.

5 From the called telephone, transfer the call back to the attendant.

6 Answer and release the call.

7 From any telephone dial the DN for the attendant. Verify that the 
correct ICI lights at the console, then release the call.

8 Busy-out one trunk group using a Trunk Group Busy (TGB) key on the 
console.

9 From any telephone with TGAR 0-7, dial the access code of the 
busied-out trunk group, to verify that the call is intercepted to the 
console and receives either overflow tone or a recorded 
announcement.

10 Restore the trunk group to the in-service state using the Trunk Group 
Busy (TGB) key on the console.

11 During the conversion procedure the Central Office may have 
busied-out the DID trunks. If DID trunks are equipped, from any 
unrestricted telephone, dial the access code for an outside line, and 
dial a DID number into the system.

12 If a private network is used, from any unrestricted telephone, dial the 
network access code and place a CDP, ESN, BARS/NARS, or ISDN 
call as applicable to your system.
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13 If not done previously, set the time and date. Note that if Call Detail 
Recording (CDR) is used, system message ERR225 will appear. This 
is normal.

14 If you have auxiliary processors working with your system, be sure 
they are powered up. Be sure the Application Module Links (AML) are 
up. DCH and AML messages may indicate problems during the 
conversion. Investigate any of these messages.

15 Keep one copy of the Source software, as it was backed up in the 
pre-conversion procedure, in case it becomes necessary to reconvert. 
After the Target software has been running well for a few weeks, 
return your original software to Nortel Networks through your 
distribution channel.

16 Load LD 135 to test and switch CPUs. (Omit this step for Option 51C.)

17 Load LD 137 to get the status of the CMDUs and IOPs.

18 Load LD 43 to back up the other set of B1 disks. Insert the B1 disk in 
the active CMDU.

LD 02
STAD dd mm yyyy hh mm ss

dd = day (for example, 05 for the fifth)
mm = month (for example, 09 for September)
yyyy = year (last 2 or all four digits, for example, 92 or 1992)
hh = hour (in 24-hour time, for example, 13:00 for 1:00 pm)
mm = minute (for example, 25)
ss = seconds (for example, 00)

LD 135
TEST CPU Test CPU.
SCPU Switch CPUs.
**** To abort overlay.

LD 137
STAT Get the status of both CMDUs and IOPs.
**** To abort overlay.

LD 43
BKO Back up to the backup disks and the active CMDU.
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19 If not done previously, set the time and date. Note that if Call Detail 
Recording (CDR) is used, system message ERR225 will appear. This 
is normal.

20 If you have auxiliary processors working with your system, be sure 
they are powered up. Be sure the Application Module Links (AML) are 
up. DCH and AML messages may indicate problems during the 
conversion. Investigate any of these messages.

LD 02
STAD dd mm yyyy hh mm ss

dd = day (for example, 05 for the fifth)
mm = month (for example, 09 for September)
yyyy = year (last 2 or all four digits, for example, 92 or 1992)
hh = hour (in 24-hour time, for example, 13:00 for 1:00 pm)
mm = minute (for example, 25)
ss = seconds (for example, 00)
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21 Keep one copy of the Source software, as it was backed up in the 
pre-conversion procedure, in case it becomes necessary to reconvert. 
After the Target software has been running well for a few weeks, 
return your original software to Nortel Networks through your 
distribution channel.

Items marked with asterisks (*) are required printout for conversion. 
Other items are recommended for a total system status.

Table 11
Print site data (Part 1 of 3)

Site data Print command

Terminal blocks for all TNs LD 20

REQ PRT

TYPE TNB

CUST <cr>

Directory Numbers LD 20 (LD 22 prior to Release 16)

REQ PRT

TYPE DNB

CUST <cr>

Attendant Console data block for all customers LD 20

REQ PRT

TYPE ATT, 2250

CUST <cr>

*Customer data block for all customers LD 21

REQ PRT

TYPE CDB

CUST <cr>
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Route data block for all customers LD 21

REQ PRT

TYPE RDB

CUST Customer number

ROUT <cr>

ACOD <cr>

*Configuration Record LD 22

REQ PRT

TYPE CFN

*Software Packages LD 22

REQ PRT

TYPE PKG

* Software Issue, ROM and tape ID LD 22

REQ ISS

REQ ROM

REQ TID

* Peripheral software versions LD 22

REQ PRT

TYPE PSWV

Table 11
Print site data (Part 2 of 3)

Site data Print command
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ACD data block for all customers LD 23

REQ PRT

TYPE ACD

CUST Customer Number

ACDN ACD DN (or <CR>)

Superloop card IDs and software version

(peripheral controller, superloop network and controller 
cards)

LD 32

. IDC loop

Multi-purpose ISDN Signaling Processor (MISP) card LD 27

REQ PRT

TYPE MISP

LOOP loop number (0–158)

APPL <cr>

PH <cr>

DTI/PRI data block for all customers LD 73

REQ PRT

TYPE DDB

Note: Items marked with asterisks (*) are required printout for conversion. Other items are recommended 
for a total system status.

Table 11
Print site data (Part 3 of 3)

Site data Print command
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276
Upgrading to a new Call Processor card
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This section contains procedures for performing CP card upgrades on Options 
51C, 61C, 81, or 81C systems running Release 25 or later software.

Note: The procedures in the section can be used for NT9D19, NT5D10, 
and NT5D03 CP card memory configurations.

Note: There should be an SDI TTY connection at J30, which should 
remain connected at all times to monitor system status.

Upgrading to a new CP card in Options 61C, 81, or 81C
Use the following instructions if you are converting a system to release 24 and 
are installing NT9D19, NT5D10 or NT5D03 CP cards. 

Installing a new CP card in an Option 61C, 81, or 81C consists of:

• splitting the CPUs

• installing a new CP card in Core 1

• upgrading the system software and CP ROMs on Core 1

• swapping CPUs

• installing a new CP card in Core 0

• upgrading the system software and CP ROMs on Core 0

• synchronizing the hard disks

CAUTION
Damage to Equipment

Personnel performing this upgrade do so at their own 
risk. Personnel should have spare CP cards on hand 
or risk installation delay and/or system down time. 
Nortel Networks assumes no responsibility for any 
damage incurred, system down time, or loss due to 
damage or down time.
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Performing a data dump
Before starting the upgrade, make a backup copy of the customer database on 
2MB diskettes using the data dump routine:

1 Log into the system.

2 Load the Equipment Data Dump Program (LD 43). At the prompt, enter

3 When “EDD000” appears on the terminal, enter

4 When “DATADUMP COMPLETE” and “DATABASE BACKUP 
COMPLETE” appear on the terminal, enter

Splitting the cores

1 Verify that the disk drives are synchronized:

If the disks are synchronized, proceed with step 2. If they are not 
synchronized, execute the SYNC command:

LD 43 to load the program

EDD to begin the data dump

CAUTION
Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support organization. A data 
dump problem must be corrected before proceeding.

**** to exit the program

LD 137 to load the program

STAT to get the status of the disk drives

SYNC to synchronize the drives

**** to exit the program
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2 Verify that clock controller 0 is active. If it is not, switch to clock 

controller 0:

3 Verify that Core 0 is the active Core:

If Core 0 is active, proceed with step 5. If Core 0 is not the active CPU, 
swap Cores and verify again:

4 Verify that CMDU 0 is active. You may need to switch CMDUs.

5 Set the MAINT/NORM switch on the CP card in Core 0 to MAINT.

6 Set the ENB/DIS switch on all CNI cards in Core 1 to DIS.

7 Perform the following three steps in uninterrupted sequence:

• press and hold the MAN RST button on the CP card in Core 1

• set the MAINT/NORM switch on the CP card in Core 1 to 
MAINT

• release the MAN RST button

LD 60 to load the program

SSCK 0 to get the status of clock controller 0

SWCK to switch to clock controller 0 (if necessary)

**** to exit the program

LD 135 to load the program

STAT CPU to check CPU status

TEST CPU to test the CPU

SCPU to swap CPUs

STAT CPU to check CPU status

LD 137
STAT Get the status of IODU/C
SWAP Switch IODU/Cs (if necessary).
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Upgrading Core 1

At this time you will install the new CP card and system software on Core 1 if 
it is not already installed on the hard drive.

1 Connect a terminal to the CPSI port in Core 1 to J25 of the I/O panel at 
the back of the core. Be sure it is configured as follows. The 
recommended baud rate is 9600, to be the same as the CPSI port.

• 7 data bits 

• 1 stop bit

• Space parity

• Full duplex

•  XON protocol

2 Disengage the lock latches and remove the CP card from Core 1.

3 Insert the CP Install Program diskette which corresponds to the CP 
card to which you are upgrading into IODU/C 1 (68030, 68040, 68060 
or 68060E).

4 Install the CD-ROM disk into the CD-ROM drive on the IODU/C in Core 
1. To install the CD-ROM:

• press the button on the CD-ROM drive to open the CD-ROM 
disk holder

• place the CD-ROM disk into the holder with the disk label 
showing

• press the button again to close the CD-ROM disk holder (don’t 
push the holder in by hand)

5 Verify that the MAINT/NORM switch on the new NT9D19, NT5D10 or 
NT5D03 CP card is set to MAINT.

6 Insert the new CP card in the same slot in Core 1 and secure the lock 
latches.

A sysload will begin (cold start). Wait for the Main Menu to appear on 
the terminal before proceeding.

7 Press <CR> to continue.

8 Log into the system and enter the time and date, when prompted.
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9 Initiate the database installation by selecting the following command 
from the menu:

10 Remove the CP Install Program diskette and insert the Keycode 
diskette, when prompted.

<u> to Install menu

<a> to continue with keycode validation

<y> to confirm that the keycode matches the CD-ROM release
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11 When the Install Menu is displayed, select the following options in 
sequence when you are prompted to do so

Note: SYS4695 is not an error message. This message is cleared 
when you perform a data dump.

<a> to install software, CP-BOOTROM, and IOP-ROM

<a> to verify that the CD-ROM is now in drive

The Installation Status Summary screen appears that lists the 
options to be installed.

<y> Yes, start the installation

<a> continue with upgrade

When the ROM installation screen appears, select the following 
prompts in sequence:

<a> to install CP-ROM from hard disk

<a> to continue with ROM upgrade

When all files are copied from the CD-ROM to hard disk, press 
<CR> to continue.

<a> to install the IOP-ROM from hard disk

<y> Yes, start installation

<a> to continue with ROM upgrade

The Installation Status Summary screen appears. Verify that CD 
to disk, disk to ROM, CP-BOOTROM, and IOP-ROM were 
installed. 

<cr> press return to return to the Install Menu.

<q> to quit (remove any diskettes from the floppy drive)

<y> Yes, to confirm quit

<a> to reboot the system

The system will automatically perform a sysload during which 
several messages will appear on the system terminal. Wait for 
“DONE” and then “INI” messages to be displayed before 
continuing.
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12 Set the ENB/DIS switches on all CNI cards in Core 1 to ENB.

13 Perform the following three steps in uninterrupted sequence:

• set the DIS/ENB faceplate switch on the IODU/C card in 
Core 0 to DIS

• set the ENB/DIS switch on all CNI cards in Core 0 to DIS

• press and release the MAN INT button on the CP card in 
Core 1

After the system initialization has finished (INI messages are no longer 
displayed on the system terminal), check for dial tone on a telephone set. 

14 Following a successful dial tone test, perform the following basic sanity 
tests:

• Make sure calls can be placed. 

• Check for error messages, line noise, chatter, or other 
problems. Track sources and resolve problems as necessary.

CAUTION
Service Interruption

Disabling CNI cards in Core 0 will momentarily 
interrupt call processing. Calls established or in 
process will be dropped. Call processing will resume 
after the “SYSTEM INI” messages appear on the 
system terminal (approximately 1 minute).
553-2001-320 Standard 23.00 January 2002



 Upgrading to a new Call Processor card Page 267 of 304
Upgrading Core 0

Once the CP card in Core 1 is upgraded, upgrade the CP card in Core 0 and 
install system software:

1 Connect a terminal to the CPSI port in Core 0 to J25 of the I/O panel 
at the back of the core. Be sure it is configured as follows. The 
recommended baud rate is 9600, to be the same as the CPSI port.

• 7 data bits 

• 1 stop bit

• Space parity

• Full duplex

•  XON protocol

2 Verify that the MAINT/NORM switch on the CP card in Core 0 is set to 
MAINT.

3 Verify that the ENB/DIS switches on all CNI cards in Core 0 are set to 
DIS.

4 Disengage the lock latches and remove the CP card from Core 0.

5 Insert the Install diskette that corresponds with the CP card you will be 
installing into IODU/C 0.

6 Verify that the MAINT/NORM switch on the new NT9D19, NT5D10 or 
NT5D03 CP card is set to MAINT.

7 Insert the new CP card in the same slot in Core 0 and secure the lock 
latches. 

The system will perform a sysload and load the IODU/C Software 
Installation Tool.

8 When the NT Logo Screen appears on the terminal, the Software 
Installation Tool has loaded. Press <CR> to go to the Install Main 
Menu.
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9 Set the system date and time. When prompted to enter the time and 
date, enter it in the following format. A space or dash can be used to 
separate the items.

dd mm yyyy
hh mm ss
or
dd-mm-yyyy
hh-mm-ss

10 At the Main menu select <u> to go to the Install menu.

11 Insert the Keycode diskette when prompted and select <a> to continue 
with the keycode validation.

Once the keycode is validated against the Security Device, the Install 
menu is displayed.

12 When the Install menu appears, select the following options in 
sequence when you are prompted to do so:

13 At the Install menu, select the following options to install 
CP-BOOTROM:

14 At the Install menu, select the following options to install IOP-ROM:

15 Remove the diskette from IODU/C 0.

<o> to copy system software from Core 1 to Core 0.

<y> to start installation

<a> to continue with upgrade

<e> to install CP-BOOTROM

<y> to start the upgrade

<a> to upgrade CP-BOOTROM from the hard disk drive

<f> to install IOP-ROM

<y> to start the upgrade

<a> to upgrade IOP-ROM from the hard disk drive
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16 Select the following options to quit and reload the system:

The system will automatically perform a sysload and system 
initialization during which several messages will appear on the system 
terminal. Wait until initialization has finished (INI messages are no 
longer displayed on the system terminal) before continuing.

17 In Core 0, enable the NT6D65 CNI cards by setting the ENB/DIS 
faceplate switches to ENB.

18 Connect a terminal to the CPSI port in Core 1 to J25 of the I/O panel 
in the back of the core.

19 In Core 0, perform the following steps in uninterrupted sequence:

• press and release the MAN RST button

• when SYS700 messages appear on CP 0 LCD display, set the 
MAINT/NORM switch to NORM. 

Within 60 seconds, the LCD will display the following messages, 
confirming the process.

RUNNING ROM OS
ENTERING CP VOTE 

An “HWI534” message from the CPSI or SDI port indicates the start of 
memory synchronization. Within 10 minutes, an HWI533 message on 
Core 1 CPSI or SDI TTY indicates the memory synchronization is 
taking place. Wait until the memory synchronization is complete before 
continuing.

20 Set the MAINT/NORM switch on the CP card in Core 1 to NORM.

21 Synchronize the disk drives:

<q> to quit

<y> to confirm quit

<a> to reboot the system

LD 137 to load the overlay

STAT to get the status of both CMDUs, IOPs and 
redundancy

SYNC to synchronize the disk drives

TEST CMDU Performs hard and floppy disk test.

**** to exit the program
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Completing the upgrade

To complete the upgrade, verify CPU and CNI status and perform a data 
dump.

1 Verify CPU redundancy and CNI function:

Backup the customer database on 2MB diskettes.

2 Load the Equipment Data Dump Program (LD 43). At the prompt, enter

3 When “EDD000” appears on the terminal, enter

4 When “DATADUMP COMPLETE” and “DATABASE BACKUP 
COMPLETE” appear on the terminal, enter

LD 135 to load the overlay

STAT CPU to check the status of the CPU

STAT CNI to verify function of the CNIs 

TEST CPU to test the CPU 

SCPU switch CPUs

STAT CPU to check the status of the CPU

STAT CNI to verify function of the CNIs

TEST CPU to test the CPU

SCPU switch to CPUs

**** to exit the program

LD 43 to load the program

EDD to begin the data dump

CAUTION
Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support organization. A data 
dump problem must be corrected before proceeding.

**** to exit the program
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5 Evaluate the number of call registers and telephone buffers that are 
configured for the system. Refer to Capacity Engineering 
(553-3001-149).

The CP card upgrade is complete.

Upgrading to a new CP card in an Option 51C

Power to the entire column must be shut off to perform this upgrade. This will 
cause loss of service to the whole telephone system. Plan the upgrade for a 
time when the impact to the telephone users will be minimal.

Installing an NT9D19, NT5D10 or NT5D03 CP card in an Option 51C system 
consists of:

• installing a new CP card in the Core module

• upgrading the system software and CP ROMs

Performing a data dump
Before starting the upgrade procedure, make a backup copy of the customer 
database using the data dump routine:

1 Log into the system.

2 Load the Equipment Data Dump Program (LD 43). At the prompt, enter

3 When “EDD000” appears on the terminal, enter

CAUTION
Service Interruption

Installing the NT9D19, NT5D10 or NT5D03CP card 
in the Option 51C will require system downtime. 
Schedule for this when planning the system upgrade.

LD 43 to load the program

EDD to begin the data dump
Software Conversion Procedures



Page 272 of 304  Upgrading to a new Call Processor card
4 When “DATADUMP COMPLETE” and “DATABASE BACKUP 
COMPLETE” appear on the terminal, enter

Installing the new CP card and system software

At this time you will install the new CP card and system software if it is not 
already installed on the hard drive.

1 Connect a terminal to the CPSI port in the Core module to J25 of the 
I/O panel at the back of the core. Be sure it is configured as follows. 
The recommended baud rate is 9600, to be the same as the CPSI port.

• 7 data bits 

• 1 stop bit

• Space parity

• Full duplex

•  XON protocol

2 Set the NORM/MAINT switch to MAINT, disengage the lock latches 
and remove the CP card from the Core module.

3 Insert the Install diskette that corresponds to the CP card you will be 
installing into the IODU/C.

CAUTION
Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support organization. A data 
dump problem must be corrected before proceeding

**** to exit the program
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4 Install the CD-ROM disk into the CD-ROM drive. To install the 
CD-ROM:

• press the button on the CD-ROM drive to open the CD-ROM 
disk holder

• place the CD-ROM disk into the holder with the disk label 
showing

• press the button again to close the CD-ROM disk holder (don’t 
push the holder in by hand)

5 Verify that the MAINT/NORM switch on the new NT9D19, NT5D10 or 
NT5D03 CP card is set to NORM.

6 Verify that the ENB/DIS switch on the CNI card is set to ENB.

7 Insert the new CP card in the same slot in the Core module and secure 
the lock latches. 

The system will automatically load the software install program.

8 When the NT Logo Screen appears on the terminal, the Software 
Installation Tool has loaded. Press <CR> to go to the Install Main 
Menu.

9 Set the system date and time. When prompted to enter the time and 
date, enter it in the following format. A space or dash can be used to 
separate the items.

dd mm yyyy
hh mm ss
or
dd-mm-yyyy
hh-mm-ss

10 At the Main menu select <u> to go to the Install menu.

11 Insert the Keycode diskette when prompted and select <a> to continue 
with the keycode validation.

Once the keycode is validated against the Security Device, the Install 
menu is displayed.

12 When the Install menu appears, select the following options in 
sequence when you are prompted to do so:

<a> to install software, CP-BOOT ROM and IOP-ROM
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13 Following the software installation, install the CP-BOOT and 

IOP-ROMs. From the menu select the following:

14 Remove the diskette from the IODU/C.

15 Select the following options to quit and reload the system:

The system will automatically perform a sysload and system initialization 
during which several messages will appear on the system terminal. Wait until 
initialization has finished (INI messages are no longer displayed on the system 
terminal) before continuing.

Note 1: SYS4695 is not an error message. This message is cleared 
when you perform a data dump.

Note 2: If you are converting from a software release prior to release 

24, the following message appears on the system terminal:

16 Verify that the “DONE” message appears on the system terminal. 

Note: The SYSTEM INI message may take 70 seconds or more to 
appear.

<y> to start installation

<a> to continue with the upgrade

<a> to continue with ROM upgrade

<a> to continue with ROM upgrade (CP-BOOT ROM) 

<y> to start installation

<a> to continue with ROM upgrade (IOP-ROM) 

<q> to quit

<yes> to confirm quit

<a> to reboot the system

DATA CONVERSION
RELEASE XX.xx TO RELEASE YY.yy
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Completing the upgrade

To complete the CP card upgrade, verify CPU and CNI status.

1 Verify CPU and CNI functionality:

Backup the customer database to 2MB diskettes:

2 Load the Equipment Data Dump Program (LD 43). At the prompt, enter

3 When “EDD000” appears on the terminal, enter

4 When “DATADUMP COMPLETE” and “DATABASE BACKUP 
COMPLETE” appear on the terminal, enter

5 Evaluate the number of call registers and telephone buffers that are 
configured for the system. Refer to Capacity Engineering 
(553-3001-149).

The CP card upgrade is complete.

LD 135 to load the overlay

STAT CPU to check the CPU status 

STAT CNI to verify CNI functionality

**** to exit the program

LD 43 to load the program

EDD to begin the data dump

CAUTION
Loss of Data

If the data dump is not successful, do not continue; 
contact your technical support organization. A data 
dump problem must be corrected before proceeding.

**** to exit the program
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300
CD-ROM Software Installation Tool
Contents

The following are the topics in this section:
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• Administration (553-3001-311)

• Hardware Replacement (553-3001-520)

This chapter details the screen displays and options of the CD-ROM Software 
Installation Tool (hereafter referred to as “Software Installation Tool”) that is 
compatible on Option 51C, 61C, 81, and 81C systems equipped with the 
NT5D61 Input/Output Disk Unit with CD-ROM (IODU/C).

 This tool is based on the existing Software Installation Tool, but has notable 
differences in menus as well as new functionality to support installation of 
software from CD-ROM, copying of system software from Core to Core, 
copying of database from Core to Core, and Keycode installation.

The IODU/C card no longer uses a Security Cartridge, but instead uses both 
a Security Device and an electronic keycode file. This keycode file is stored 
on a 2MB diskette and must be inserted into the IODU/C floppy drive and 
authenticated each time the Software Installation Tool is loaded and the 
Install Menu is accessed.

On systems equipped with an IODU/C, the database is stored on 2MB 
diskettes, not 4MB diskettes. A Database Transfer Utility diskette, specific to 
Call Processor type, is available to convert a 4MB database to a 2MB 
database. Refer to NT5D61 IODU/C Reference Guide or Hardware 
Replacement (553-3001-520) for procedures on replacing CMDU or 
IOP/CMDU cards with IODU/C.
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The Tools Menu has new options for finding the CD-ROM status (option 
<g>), printing the Keycode (option <h>), printing information about the 
Security Device (option <i>), checking the customer-specific CD-ROM data 
(<j>), manually creating a Keycode diskette (<k>), and archiving the 
database (<s>).

Do not turn off the system during the installation process. If you need to quit 
the installation process, do so from within the Software Installation Tool 
before powering off the system.

Read the entire procedure before attempting to perform an installation.

Before the Software Installation Tool is activated, verify that the system is in 
split mode (not applicable for Option 51C) and that a terminal is connected to 
CPSI port J25 on the I/O panel (in the inactive Core for dual CPU systems). 
Option 51C systems will be taken out of service.

To activate the Software Installation Tool, insert the Install diskette specific 
to your Call Processor type and the CD-ROM containing system software (if 
you will be installing that component). Press the MAN RST button on the CP 
card in the same Core.

The IODU/C Software Installation Tool requires the following items:

• 2MB diskettes (used to store, backup, and restore the database)

• an Install diskette specific to the system’s Call Processor card

• a Keycode diskette

• a CD-ROM containing system software
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Note: If you will be installing system software from CD-ROM (options 
<a>, <b>, or <c> from the Install Menu), then insert the CD into the 
CD-ROM drive before loading the Software Installation Tool.

Pay close attention to the menus when they appear; they display the options 
available at any given stage.

Status Summary Charts
Status Summary Charts are displayed for the purpose of informing the user 
about what items will be installed or have been installed. This example is 
shown when option <b> (all components) is chosen from the Install Menu.

Note: Your screen may differ from the below example. 

CAUTION
Loss of Data

The screens shown in this procedure are examples. 
They are not intended to exactly represent the 
displays that will appear for your system, nor do the 
choices entered represent those you should 
necessarily choose. Be sure to watch the terminal 
display, and follow the on-screen instructions.
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INSTALLATION STATUS SUMMARY

553-7731

Option Choice Status Comment

SW: CD to disk

SW: disk to ROM

Database

CP-BOOTROM

IOP-ROM

yes

yes

yes

yes

yes

from xxxx to xxxx

Please enter:
<y> - Yes, start Installation.
<n> - No, stop Installation. Return to the Main Menu.

Enter Choice> y

<CR> ->
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The possible values and meanings for each column are defined below.

— Choice

• yes indicates the item will be installed

• no indicates the item was not selected, and will not be updated.

— Status

• quit indicates the quit option was used, and the process was exited.

• ok indicates the choice was installed successfully.

• error indicates the installation was not successful. A system message is 
given when the Software Installation Tool encounters a problem. Follow 
the actions required by the message.

• ignore applies to the CP ROM and IOP-ROM upgrade only. This 
appears when the process was exited when asked to replace a release and 
issue with the same release and issue.

• blank indicates the status is not yet determined if Choice = Yes. If 
Choice = No, the field remains blank.

— Comment

• from rel <number> to rel <number> gives the Source and Target 
release and issue numbers.

Messages
When the Software Installation Tool encounters a problem, a system message 
appears on the terminal display. These messages fall into two categories: 
warning and non-warning.

Warning messages are not critical errors. The Software Installation Tool 
proceeds with the installation following the appearance of this message. 
Refer to Administration (553-3001-311) for details regarding these messages.

Non-warning messages appear when a critical problem is encountered. The 
Software Installation Tool stops the process, and an action is recommended. 
When the action is complete, the Software Installation Tool can be restarted. 
In some cases, the tool allows you to restart by pressing the carriage return 
<CR>.
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Installation messages (INST) are defined fully in Administration 
(553-3001-311). Refer to that document for more details.

Introductory Screen
The first screen that appears after loading the NT5D61 Software Installation 
Tool is the NT Logo Screen. 

This screen is displayed after the user presses <CR> from the NT Logo 
Screen. From this screen, the user may select option <u> to go to the Install 
Menu, or <t> to go to the Tools Menu. Alternately, option <q> to quit is 
available at this screen.

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

M A I N   M E N U

The Software Installation Tool will install or upgrade Meridian-1
System Software, Database and the PE-ROM (both CP and IOP ROM). 
You will be prompted throughout the installation and given the 
opportunity to quit at any time.

Please enter:

<u> - To Install menu.

<t> - To Tools menu.

<q> - Quit.

Enter choice > u

<CR>-->

553-7780

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  ——  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —
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Install Menu
Note: A Keycode diskette is required before accessing the Install Menu.

Before the Install Menu screen is displayed, an intermediary screen shown 
below prompts the user to insert their Keycode diskette for validation against 
the Security Device. 

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

Please insert the diskette with the keycode file into the floppy
drive.

Please enter:

<a> - Continue with the keycode validation

      (the keycode diskette is in the floppy drive).

<q> - Quit.

Enter Choice > a

<CR>-->

553-7729

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  — 
—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  
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Following successful Keycode validation, the Install Menu screen is 
displayed, as shown below.

Note: If the Software Installation Tool is loaded on a Core equipped 
with an NT5D61BA IODU/C (which lacks a CD-ROM drive), options 
<a>, <b>, and <c> will not appear.

Each option from the Install Menu is described in the following pages.

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

I N S T A L L   M E N U

The Software Installation Tool will install or upgrade Meridian-1
System Software, Database and the PE-ROM (both CP and IOP ROM). 
You will beprompted throughout the installation and given the 
opportunity to quit at any time.

Please enter:

<a> - To install Software, CP-BOOTROM, IOP-ROM.

<b> - To install Software, Database, CP-BOOTROM, IOP-ROM.

<c> - To install Software only.

<d> - To install Database only.

<e> - To install CP-BOOTROM only.

<f> - To install IOP-ROM only.

<g> - To reinstall CP-Software.

<o> - To copy System Software from the other Core.

<t> - To go to the Tools menu.

<k> - To install Keycode only.

           For Feature Expansion, use OVL143.

<q> - Quit.

Enter Choice > 

<CR>-->

553-7789

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  ——  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —
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Installing Software, CP-BOOTROM, and IOP-ROM

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

This option is selected for the sequential installation of software, 
CP-BOOTROM, and IOP-ROM. This option differs from option <b> in that 
the database is not installed. Use option <a> when going to a later software 
release or for a software upissue.

Installing Software, Database, CP-BOOTROM, and IOP-ROM 

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

This option is selected when you wish to sequentially install all components 
- software, database, CP-BOOTROM, and IOP-ROM.

Option <b> is used during the upgrade procedures from NT5D20 
IOP/CMDU, NT6D63 IOP and NT6D64 CMDU, NT9D33 SMDU, NTND16 
FDU, NT8D69 MDU, and NTND16 MDU cards to NT5D61 IODU/C cards.

Installing Software only

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

This option is selected when you wish to install system software from the 
CD-ROM to the hard drive. When selecting option <c>, IOP-ROM and 
CP-BOOTROM are not installed.
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Installing Database only

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

The Database Menu of the Software Installation Tool is accessed by the <d> 
option on the Install Menu. The following options are available for installing 
a database:

• Option <a> is to install the backup customer database from one or more 
2MB diskettes. 

• Option <b> allows installation from the CD-ROM containing the default 
database. This option is used on new systems which have no existing 
database.

• Option <d> copies the existing database from the redundant Core. This 
option is used when the database has already been installed on one Core. 
This option is used when upgrading from IOP/CMDU to IODU/C cards.

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

You will now perform the database installation.

Note: If you are installing the Database from a floppy disk,
         please insert the correct disk now.

Please enter:

<a> - Install CUSTOMER Database

    (the customer database diskette must be in the Core 1 disk drive).

<b> - Install DEFAULT Database

     (the installation CDROM must be in the Core 1 disk drive).

<d> - Copy Database from the redundant disk.

<e> - Check the Database that exists on the hard disk.

<q> - Quit.

Enter Choice > a

<CR>-->

553-7779

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  ——  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —
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• Option <e> displays the version and issue of the current database 
residing on the Core. If database files are missing, error messages will be 
printed.

Install CP-BOOTROM

Note: Installation of CP-BOOTROM is available on systems with 
NT9D19, NT5D10 or NT5D03 Call Processor cards only. For systems 
with the NT6D66 Call Processor card, CP-ROM is installed instead of 
CP-BOOTROM. See page 288 for installing CP-ROM on a system 
equipped with an NT6D66.

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

Option <e> is for installing new CP-BOOTROM. This option is used to 
install CP-BOOTROM while on Core 0 in a software upgrade, when software 
has already been installed using options <a> or <b> on Core 1, and software 
has already been copied onto Core 0 using option <o>. 

The next screen displayed after selecting option <e> will show the version of 
CP-BOOTROM being replaced and version being installed, and the card slot 
where the CP-BOOTROM is being installed. The user is prompted to select 
<a> to continue with the CP-BOOTROM upgrade.

 Install CP-ROM (NT6D66 CP cards only)

Note: Installation of CP-ROM is available on systems with NT6D66 
Call Processor cards only. For systems with the NT9D19, NT5D10 or 
NT5D03 Call Processor cards, CP-BOOTROM is installed instead of 
CP-ROM. See page 288 for installing CP-ROM on a system equipped 
with an NT6D66.

CAUTION
Loss of Data

Before upgrading the system database, be sure a 
backup of the previous (source) database is on hand. 
Should any problems arise, it may be necessary to 
return to the previous database.
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Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

Option <e> is for installing new CP-ROM. This option is used to install 
CP-ROM while on Core 0 in a software upgrade, when software has already 
been installed using options <a> or <b> on Core 1, and software has already 
been copied onto Core 0 using option <o>. 

The next screen displayed after selecting option <e> will prompt the user to 
choose whether to install the CP-ROM from the hard disk (option <a>), or 
from CD-ROM (option <b>). If software has just been installed successfully, 
then option <a> should be used. However, if software was not installed, select 
option <b> to install from CD-ROM.

Install IOP-ROM 

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

Option <f> is for installing new IOP-ROM. This option is used to install 
IOP-ROM while on Core 0 in a software upgrade, when software has already 
been installed using options <a> or <b> on Core 1, and software has already 
been copied onto Core 0 using option <o>, and CP-BOOTROM has been 
installed using option <e>. 

The next screen displayed after selecting option <f> will show the version of 
IOP-ROM being replaced and version being installed, and the card slot where 
the IOP-ROM is being installed. The user is prompted to select <a> to 
continue with the IOP-ROM upgrade.

Reinstalling CP-Software

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

This option is used if a flash programming error occurs during software 
installation through options <a>, <b>, or <c>. Option <g>, which assumes 
that software files have already been installed on the hard disk, copies these 
files from the hard disk to the Flash EEPROM.
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To copy system software from the other Core

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

Option <o> is used during a software upgrade when software has already 
been installed on Core 1, and the Software Installation Tool has been loaded 
on Core 0. 

Note: This option does not perform the installation of CP-BOOTROM 
(option <e>) or IOP-ROM (option <f>).

To go to the Tools Menu
Option <t> displays the Tools Menu and its options, which are described 
beginning on page 292.

To Install Keycode only
Option <k> is used when you wish to replace an existing Keycode.

To quit

Note: For dual-CPU systems, verify that the system is operating in split 
mode before activating the Software Installation Tool.

Throughout the installation process, the option to quit is always available. 
Quitting with the Software Installation Tool quit commands is preferable to 
pressing the MAN RST button on the CP card, since quitting from the tool 
will erase unneeded temporary files. 
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When you are done using the NT5D61 Software Install Tool remove the 
diskette from the IODU/C and select option <q> to quit from the Main Menu. 
The terminal displays a confirmation to quit. Pressing <y> confirms the quit. 

The final screen displayed before quitting reminds the user that the Install 
diskette should be removed from the IODU/C floppy drive before pressing 
<a> to reboot the system. 

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)
—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —

You selected to Quit. Please confirm.

Please enter:

<y> - Yes, Quit.

<n> - No, DO NOT Quit.

Enter choice > y

<CR>-->

553-7751

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

You have selected to Quit the Software Installation Tool
You may reboot the system or return to the Main Menu.
Before rebooting the system, remove Install diskette from the floppy drive.

DO NOT REBOOT USING BUTTON!!

Please enter:

<a> - Reboot the system.

<m> - Return to the Main menu.

Enter Choice > a

<CR>-->

553-7752

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  ——  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —

----------------------------------------------

----------------------------------------------
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Tools Menu
To load the Software Installation Tool which contains the Tools Menu, insert 
the Install diskette which is compatible with your Call Processor card. Press 
the MAN RST button on the CP card to load the tool.

The first screen that appears after loading the NT5D61 Software Installation 
Tool is the NT Logo Screen. 

This screen is displayed after the user presses <CR> from the NT Logo 
Screen. From this screen, selecting option <t> brings the user to the Tools 
Menu.

Note: Insertion of the Keycode diskette is not required for accessing the 
Tools Menu.

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

M A I N   M E N U

The Software Installation Tool will install or upgrade Meridian-1
System Software, Database and the PE-ROM (both CP and IOP ROM). 
You will be prompted throughout the installation and given the 
opportunity to quit at any time.

Please enter:

<u> - To Install menu.

<t> - To Tools menu.

<q> - Quit.

Enter choice > t

<CR>-->

553-7797

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  ——  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —
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The Tools Menu has new options for finding the CD-ROM status (option 
<g>), printing the Keycode (option <h>), printing information about the 
Security Device (option <i>), checking the customer-specific CD-ROM data 
(<j>), manually creating a Keycode diskette (<k>), and archiving the 
database (<s>).

The Tools Menu is displayed below.

Each option from the Tools Menu is described in the following pages.

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)
—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —
—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —

T O O L S   M E N U

This is the Tools Menu for Install. You can select the tool that
is appropriate. Please select one of the options below.

Please enter:

<a> - To set the system date and time.

<b> - To partition the hard disk.

<c> - To display the partition size of hard disk.

<d> - To regenerate PDT Password.

<g> - To print CDROM content.

<h> - To print Keycode content.

<i> - To print Security Device content.

<j> - To Check the customer specific part of CDROM.

<k> - To manually create Keycode floppy diskette.

<r> - To install Keycode only.

<s> - To archive existing database.

<z> - To check MDU connection.

<m> - To return to the Main Menu

Enter choice > 

<CR>-->

553-7796
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Setting the system date and time
This option is used to change the system date and time for the system’s 
internal clock. The correct date and time will ensure that files are 
time-stamped accurately.

Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

You have selected the option to set the system date and time.
This will change the internal clock of your system to a new data
and time.

The system date and time are also used by Install to time-stamp the new files 
created.

Pressing the carriage return at the prompt below will leave the
system date or time unchanged.

Please enter the new date or time.

Current date is: Tuesday 04-29-1997
Enter new date (dd mm yyyy) ? 30 4 1997
Date is set to: Wednesday 04-30-1997

Current time is: 15:52:00
Enter new time (hh mm ss) ? 15 05 45
Time is set to: 15 05 45

System Date and Time now is:
Wednesday 04-30-1997, 15:05:46 553-7743

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  — 
—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  — 
553-2001-320 Standard 23.00 January 2002



 CD-ROM Software Installation Tool Page 295 of 304
Partitioning the hard disk

Note: Option <b> requires a password, and should only be performed by 
Nortel Networks support personnel. 

Displaying the hard disk partition size
Option <c> displays the partition sizes of the hard disk. The manufacturer and 
model number of the hard disk are also displayed.

Regenerate the PDT password

Note: Option <d> requires a password, and should only be performed by 
Nortel Networks support personnel.

To install CP-software at a specified slot

Note: Option <e> requires a password, and should only be performed by 
Nortel Networks support personnel.

To print the CD-ROM content
Option <g> is used to find whether a CD-ROM exists on each IODU/C, and 
whether its sectors are readable. After selecting <g>, three options are 
available:

• Fast readability test, which takes about 17 seconds for each CD-ROM 
and reads 1/30th of the CD-ROM sectors.

CAUTION
Loss of Data

Partitioning a disk erases all files from it.

IODU 0
Hard Disk from: MAXTOR:7120SCS, Size:124MB,Sectors:248502
Unprotected       Part Size:30MB,  Sectors: 60000
Spare                 Part Size:30MB,  Sectors: 60000
CardId                Part Size:1MB,  Sectors: 2000
Protected           Part Size:60MB,  Sectors: 120000

553-7742
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• Extensive readability test, which takes about 3 minutes for each 
CD-ROM and reads 1/4th of the CD-ROM sectors.

• Total readability test, which takes about 6 minutes for each CD-ROM 
and reads all sectors of the CD-ROMs.

Note: The failure of a CD-ROM drive to read a known good CD-ROM 
may indicate a problem with the CD-ROM drive.
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To print the Keycode content
Option <h> is used when you wish to display the information contained in the 
current Keycode. The information displayed includes machine type, software 
version, ISM limits, and which feature packages are enabled.

System Serial Number
Software Version           
System Type
Call Processor
Release
Issue
NTI Order Number
NT SDID - 1
NT SDID - 2
Date and Time of Manufacture       

Note:   (  ) indicates that information is not available

ISM Limits:
   Loop Limit          
   Sys TNs Limit         
   ACD Agt Limit 
   ACD DNs Limit        
   AST Limit            
   DSL Limit             
   LTID Limit               
   DCH Limit              
   AML Limit        
   MPH DSL Limit
   RAN CON Limit         
   RAN RTE Limit      
   MUS CON Limit
   Brand Index
      
Options Packages:
    0-2 4-5 7-25 28-29 232-55 57-65
    67 70-77 79-81 84 86 88-93
    95 98-105 107-109 111 113-121 125
   127 129 132-134 136 139-140 145-151
   153-155 157-160 162 164 170 172-175
   178-181 186 191-192 196 202-212 214-216
    218-219 222-225 227-229 231 233-235 240
    242-243 245-248 250-251 253-256 258-259 262-263
    286 290-293 296-297 301-303 305-310 313-316
    321 323-324 327-335

553-7745

:    46379
:    1811
:    Option 61C
:    CP68030
:    23
:    30G
:    000000000000
:    00000000
:    00000000
:    06/03/1998 - 14:53:38

:    32
:    32767
:    32767
:    24000
:    32767
:    100
:    100
:    64
:    16
:    100
:    32767
:    512
:    1000
:    1
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To print the Security Device content
Option <i> shows specific information about the Security Device, such as 
Serial Number. This enables the user to find information about the Security 
Device without removing the NT5D61 IODU/C card.

To check the customer-specific part of the CD-ROM
Option <j> is used to check the readability of the Keycode-specified system 
software on the CD-ROM drive. Once all files have been checked 
successfully, the message “Checking directory /cdx/xxxx_DMR.Nxx ended 
successfully” is displayed to indicate completion.

To manually create a Keycode diskette
Option <k> is used to manually type in a keycode and save it to a 2MB 
diskette. Upon selecting this option, you may enter the characters into 21 
Keycode entry lines of 16 characters each, which will compose the Keycode 
file to be saved on a 2MB diskette in the floppy drive.

Characters may be entered on the Keycode entry lines in one of two ways:

• manually entering each 16-character line followed by a <CR> or

• “pasting” each individual 16-character line, then pressing <CR> 
(available on a PC running Windows 95 , using the Copy command 
(Control-C) to copy a line of characters from a keycode file, positioning 
the cursor on the current Keycode entry line, and using the Paste 
command (Control-V) to paste the line).

If a line is entered which does not have 16 characters, a message will be 
displayed informing the user to reenter the line correctly.

553-7746

Engineering Code (Side x)
Card Serial Number
NT SDID
Security Device Type
System Serial Number

:NT5D61AA
:06NNTM1831RRC3 IOP
:20000080
:NT_TCH
:46379
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To archive the existing database
This option is one of the methods (the ABKO and BKO commands from 
overlay 143 are other methods) that is available to backup the customer 
database to 2MB diskettes. The size of the backup files and the estimated 
number of 2MB diskettes required to store the database will be displayed. 

To go back to the Main Menu
Option <m> is selected to return the user from the Tools Menu to the Main 
Menu, where the user may select to quit (<q>) or go to the Install Menu (<u>). 
Software Conversion Procedures



Page 300 of 304  CD-ROM Software Installation Tool
553-2001-320 Standard 23.00 January 2002



Page 301 of 304
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Index

A
AST sets

Incremental Software Management, 18
Automatic Inline Conversion

X11 releases supporting, 12
Auxiliary Processors, post-conversion power up of, 

15

C
call processing, effect of software upgrades on, 10
CCED system messages

CP Card replacement, 167
CDR Expansion, 15
CD-ROM, upgrading disk drives to, 15
conversion media

defined, 10
converting software

Automatic Inline Conversion, 12
ISDN systems, 16
post-conversion procedure, 251
pre-conversion procedure, 25
systems supported in documentation, 14

country code, 176
CP (Call Processor) Cards

installing, 165
CP card upgrade, 260, 271
CPU (central processor unit), 14
creating keycode diskettes, 199
creating shortcuts, 174

D
data cartridges

installing new, 107

data dumps
between software versions, upissues, release, 

15
pre-conversion procedure, 27

data, preventing corruption of, 15, 26
databases

verifying required updates, 251
D-channel monitors, 18
D-channel parameters, 17
DCHI ports configured as TTY ports, 18
Dial-Up Networking®, 175
Dial-Up Server, 177
Distributor Keycode Application, 169, 189
DKA, 169, 189

Dial-Up Networking®, 175
hardware and software requirements, 170
installation, 170
Manual entry, 186
modem requirements, 170
Reading from a File, 185

DN Expansion, 15
downloding keycodes, 178

E
error messages, 86

F
file names, 181

H
hardware requirements

converting software, 25
HWI0533 messages in CP Card replacement, 167
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I
INI messages, truncated, 18
initialization, system, 14
installation of DKA, 170
installing

data cartridges, 107
ISDN (Integrated Services Digital Network) 

systems
converting, 16

ISM (Incremental Software Management), 18

K
Keycode Delivery System (KDS), 178
keycode download, 178
keycodes, 14

creating keycode diskettes, 199
downloading, 178
file name, 181
manual entry, 186
troubleshooting, 184

L
LD 135 program

CP Card replacement, 164
LD 17 program, 26
LD 43 program, 13
LD 66 conversion program, 13

M
machine types

X11 releases supported by, 22
manually entering a keycode, 186
memory

increasing
X11 release 18 and later, 153
X11 release 21, 153
X11 release 24 and earlier, 153

pre-conversion procedure, 26
required for conversions, 14

modem configuration, 175
modem requirements (DKA), 170

N
network protocols, 177
NT order number, 181
NT systems

parallel reloads
procedure, 32

X11 releases supported, 22
NT5D03 CP cards, 19
NT5D10 CP cards, 19, 20
NT5D61 IODU/C card, 13

CD-ROM, 13, 15
Database Transfer Utility, 14
Install diskette, 13
Keycode diskette, 13
security device, 13

NT6D11 International ISDN D-Channel cards, 16
NT8D04 Superloop Network cards, 14
NT9D10/03 Call Processor Cards

installing, 165
NT9D19, 260
NT9D19 CP cards, 19, 20
NTI number, 181

O
option 21E systems

X11 releases supported, 22
option 51 systems

X11 releases supported, 22
option 51C systems

X11 releases supported, 22
option 61 systems

parallel reloads
procedures, 32

X11 releases supported, 22
option 61C systems

ISDN site upgrades, 16
parallel reloads

backing out of, 46
option 71 systems

X11 releases
supported, 24
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option 81 systems
ISDN site upgrades, 16
parallel relaods

backing out of, 46
X11 releases

supported, 23
option 81C systems

parallel relaods
backing out of, 46

X11 releases
supported, 24

P
parallel reloads

backing out of
options 61C/81/81C, 46

IODU/C systems, 32
monitoring CPU during, 14
pre-conversion procedure and, 27
procedure

NT/RT/61 systems, 32
patches

pre-conversion procedure and, 26
removal prior to conversion, 18

post-conversion procedure
overview, 251
steps, 252

pre-conversion procedure
overview, 25
steps, 26

printouts
site data, 29, 255

PSDL (Peripheral Software Download), system 
initialization and, 14

Q
QPC742D FDI Cards, 15
QPC757 DCHI cards (vintage C), 16

R
read from a file, 185
release 23 memory requirements, 21, 152

RT systems
parallel reloads

procedure, 32
X11 releases supported, 22

S
SDI (Serial Data Interface) cards

monitoring CPUs during parallel reloads, 14
security device, 13
server type, 177
server types, 177
single CPU systems

call processing disruptions on, 10
site data printouts

post-conversion procedure, 255
pre-conversion procedure, 29

Software Installation Tool
description of menus, 81

software packaging, 14
source software

defined, 10
STE systems

X11 releases supported, 22
system ID, 181

T
target software, 10
TCP/IP, 177
template audits, 26
troubleshooting, 184
TTY ports, DCHI ports configured as, 18

U
Upgrading to a new Call Processor card, 259

V
verifying software conversion process, 251

X
X11 release

supporting Automatic Inline Conversion, 12
X11 release 15.55 (Incremental Software 

Management), 18
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X11 release 18 (and later)
increasing memory, 153
ISDN site upgrades, 16

X11 release 19
ISM tracking, 18

X11 release 21
increasing memory, 153

X11 release 23, 19
X11 release24 (and earlier), increasing memory in, 

153
X11 releases

supported by machine types, 22
XT systems

X11 releases
supported, 22
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